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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information.
» To send comments on articles in the WebSphere Application Server Information Center
1. Display the article in your Web browser and scroll to the end of the article.

2. Click on the Feedback link at the bottom of the article, and a separate window containing an e-mail
form appears.

3. Fill out the e-mail form as instructed, and click on Submit feedback .

* To send comments on PDF books, you can e-mail your comments to: wasdoc@us.ibm.com or fax
them to 919-254-0206.

Be sure to include the document name and number, the WebSphere Application Server version you are
using, and, if applicable, the specific page, table, or figure number on which you are commenting.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information
in any way it believes appropriate without incurring any obligation to you.

© Copyright IBM Corp. 2006 ix



X  Troubleshooting and support



Chapter 1. Overview and new features for troubleshooting

Use the links provided in this topic to learn about troubleshooting and problem determination capabilities.

[“What is new for troubleshooters” on page 2|

This topic provides an overview of new and changed features in troubleshooting tools and support.

[Chapter 6, “Diagnosing problems (using diagnosis tools),” on page 89

This topic provides a place to start your search for troubleshooting information.
Troubleshooting overview

Troubleshooting is the process of finding and eliminating the cause of a problem. Whenever you have a
problem with your IBM software, the troubleshooting process begins as soon as you ask yourself what
happened? A basic troubleshooting strategy at a high level involves:

1. Recording the symptoms.

2. Recreating the problem.

3. Eliminating possible causes.
4. Using diagnostic tools.

Recording the symptoms of the problem

Depending on the type of problem you have, whether it be with your application, your server, or your tools,
you might receive a message that indicates something is wrong. Always record the error message that you
see. As simple as this sounds, error messages sometimes contain codes that might make more sense as
you investigate your problem further. You might also receive multiple error messages that look similar but
have subtle differences. By recording the details of each one, you can learn more about where your
problem exists.

Recreating the problem

Think back to what steps you were doing that led you to this problem. Try those steps again to see if you
can easily recreate this problem. If you have a consistently repeatable test case, you will have an easier
time determining what solutions are necessary.

* How did you first notice the problem?
» Did you do anything different that made you notice the problem?
* |s the process that is causing the problem a new procedure, or has it worked successfully before?

 If this worked before what has changed? The change can refer to any type of change made to the
system, ranging from adding new hardware or software, to configuration changes to existing software.

* What was the first symptom of the problem you witnessed? Were there other symptoms occurring
around that point of time?

* Does the same problem occur elsewhere? Is only one machine experiencing the problem or are multiple
machines experiencing the same problem?

* What messages are being generated that could indicate what the problem is?

Eliminating possible causes

Narrow the scope of your problem by eliminating components that are not causing the problem. By using a
process of elimination, you can simplify your problem and avoid wasting time in areas that are not culprits.

Consult the information in this product and other available resources to help you with your elimination
process.

© Copyright IBM Corp. 2006 1



* Has anyone else experienced this problem? Read the information about searching knowledge bases in
the information center.

* |s there a fix you can download? Refer to the information center for information about obtaining fixes.

* You can use the WebSphere Application Server Troubleshooting Guide to help you work through the
cause of a problem.

Using diagnostic tools
As a more advanced task, there are various tools that you can use to analyze and diagnose problems with

your system. To learn how to use these tools see [Chapter 6, “Diagnosing problems (using diagnosis|
ftools),” on page 89|

What is new for troubleshooters

This version provides many new features for troubleshooting and servicing the product, with a focus on the
ability to automatically detect and recover from problems.

New in Version 6.1! indicates new features or changes implemented at the Version 6.1 level. Unmarked items are
Version 6.0 improvements that apply also to Version 6.1, which should interest anyone migrating to Version 6.1 from
Version 5.x.

For more detailed information about features that are being replaced or removed in this or future releases,
see the Deprecated and removed features section in the Migrating, coexisting, and interoperating PDF
book.

Tools and data capture

Improved ability to manage recovery from failure To prevent the assignment of new work to an application
server that is going through its transaction recovery
process, restart the application server in recovery mode.

For more details, see the topic, Restarting an application
server in recovery mode located in the Administering
applications and their environment PDF book.

Easier and faster problem determination with diagnostic New in Version 6.1! Diagnostic Providers expose

providers information about running components, enabling
administrators to more easily debug problems related to
the components. You can detect problems faster and
access more information for determining and solving
problems.

» Some logged messages contain diagnostic provider IDs
(DPIDs), enabling administrators or administrative
programs to target requests for information to the
components that logged a message.

* Using the administration console, administrators can
work with diagnostic providers to dump configuration
data, dump state information, or execute any self
diagnostic tests that the corresponding component
offers.

= Diagnostic provider management APIs are provided to

enable programmatic access to diagnostic provider
function.

See[‘Working with Diagnostic Providers” on page 131/
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[IBM Support Assistant

New troubleshooting technology on the Support site

More diagnostic data is captured when failures occur

Class Loader Viewer

The IBM Support Assistant (ISA) provides a natural,
look-here-first facility for issue resolution. It provides a
single point of access to problem determination tools and
externally available Support resources for the products
you choose. It guides you through exploring and resolving
your immediate issue. You can:

» Search multiple IBM and non-IBM locations for the most
pertinent support information

» Find and run serviceability tools easily.

» Obtain quick access to appropriate IBM resources such
as product pages, support pages and news groups

* Open a service request electronically if you end up
needing one.

See [‘Getting IBM Support Assistant” on page 124.

« |MustGather: Read first for all WebSphere Application|
Server products

« [Troubleshooting Guide for WebSphere Application|
Serve[|

The first failure data capture (FFDC) feature preserves the
information that is generated from a processing failure and
returns control to the affected engines. The captured data
is saved in a log file for analyzing the problem. FFDC is
intended primarily for use by IBM Service.

See [‘Configuring first failure data capture log file purges’]
lon page 124]

Class loaders find and load class files. For a deployed
application to run properly, the class loaders that affect the
application and its modules must be configured so that the
application can find the files and resources that it needs.
Diagnosing problems with class loaders can be
complicated and time-consuming. To help you diagnose
and fix problems more quickly, use the administrative
console Class Loader Viewer to examine class loaders
and the classes loaded by each class loader.

See [‘Troubleshooting class loaders” on page 89.|

The troubleshooting documentation includes extensive support information, including the ability to search
live, Web-based support resources by using the customized query fields in the "Web search” page.

Chapter 1. Overview and new features: Troubleshooting 3
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Messages

Improved message text, new message IDs

Events

Common Base Events describe system situations

Programming to Common Base Event infrastructure

4 Troubleshooting and support

Messages for key product components used during
installation, migration, and initial configuration have been
improved. Additional components have messages now.
Message IDs will be changing in a future release. In the
meantime, you can configure the application server to use
the new message IDs to help prepare any tooling you may
have that is reliant on message IDs. The Troubleshooter
reference: Messages reference section provides a
mapping of Version 5.1.x to Version 6.0.x message IDs.

The article FChanging the message IDs used in log files’]
lon page 31[explains how to make your application server
use the new message IDs. In addition, the article
“Converting log files to use IBM unigue Message IDs” on|
page 32 explains a command to create a log file with new
message IDs based on a log file with the older message
IDs. This command is provided to ease migration to the
new message IDs,

New in Version 6.1! Further work was performed to
ensure messages and their component message |IDs now
correspond to IBM software standards, enabling better
results when you use problem determination tools.
Message documentation is improved to ensure messages
are meaningful and explanatory.

Common Base Events are data structures used to
describe situations that occur in the system. Common
Base Events are used for various purposes, including
representing things such as business events, configuration
events, error events, and so on. The WebSphere
Application Server now uses Common Base Events as the
internal representation of logged messages.

Common Base Events are logged via JSR47 and as such
can be received and operated on from JSR47 Handlers.
Handlers which are not programmed to the Common Base
Event specification will also be able to consume these
events as CommonBaseEventLogRecords. Handlers
which are programmed to the Common Base Event
specification can take advantage of fields within the
Common Base Events.

See|The Common Base Event in WebSphere Application|
|[Server” on page 65|

New in Version 6.1! Developers can make use of the
Common Base Event infrastructure for logging and to
ensure that the events generated are consistent with
events generated by the WebSphere runtime, whether or
not the developer has chosen to use templates (event
factory template or event templates).

See|“The Common Base Event in WebSphere Application|
|Server” on page 65




Memory leak detection

More support for troubleshooting memory leak problems

Memory leak detection enhancements

To help you analyze memory leak problems when memory
leak detection occurs, some automated heap dump
generation support is available.

Refer to the Generating and analyzing heap dump chapter
in the Tuning performance PDF book.

WebSphere Application Server has implemented a
lightweight memory leak detection mechanism that runs
within the WebSphere Runtime Performance Advisor
framework. This mechanism is designed to provide early
detection of memory problems in test and production
environments. This framework is not designed to provide
analysis of the source of the problem, but rather to
provide notification and help generating the information
that is required to use analysis tools. The mechanism only
detects memory leaks in the Java heap and does not
detect native leaks.

For more information on detecting memory leaks, refer to
the chapter, Starting the lightweight memory leak detection
in the Tuning performance PDF book.

Recreating memory leaks in a test environment is often
difficult. To alleviate the problems associated with
reproducing memory leaks in test environments,
WebSphere Application Server uses light weight memory
leak detection that is designed to run in production
systems with minimal performance overhead. This
functionality provides early notification of memory leaks,
allowing time to diagnose the problem or arrange
contingencies before it becomes critical.

New in Version 6.1! Memory leak detection has been
improved with new features that provide better support for
memory leak diagnosis and troubleshooting.

The Diagnostic Provider Interface provides users with the
ability to perform a self diagnostic test that checks for any
suspicious memory leaks. This self diagnostic allows
problem determination tools to check the status of a
memory leak without constantly monitoring WebSphere
Application Server for notifications. In addition, new
memory leak detection logic has been added to support
detection with unbounded heaps. This feature provides
more robust early notification for all platforms, even while
the Java heap is still expanding.

For more information on detecting memory leaks, refer to
the chapter, Starting the lightweight memory leak detection
in the Tuning performance PDF book.
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Logging
JRAS is deprecated

Support for Jakarta Commons Logging is added

Thread names can be included in logs

Java logging framework from JSR47 is exploited

6  Troubleshooting and support

The JRAS API is deprecated. Users are directed to use
the JSR47 logging infrastructure instead.

For more detailed information about features that are
being replaced or removed in this or future releases, see
the Deprecated and removed features section in the
Migrating, coexisting, and interoperating PDF book.
Jakarta Commons Logging provides a simple logging
interface and thin wrappers for several logging systems.
WebSphere Application Server version 6.0.2 supports
|[Jakarta Commons Logging| by providing a logger, a thin
wrapper for the WebSphere Application Server logging
facility. The logger can handle both (JSR47)

and [Common Base Event] logging objects.

The WebSphere Application Server support for Jakarta
Commons Logging does not change interfaces defined by
Jakarta Commons Logging.

See[“Configuring applications to use Jakarta Commons|
[Logging” on page 36.|

Thread name has been added to the Advanced log format
and Log analyzer trace format. The Log analyzer trace
format preserves trace information in the same format as
produced by Showlog tool. The advanced log format is
available as an output format for the trace log and system
out log. The thread name is now included in this format to
enable easier correlation with other types of diagnostic
data. The log analyzer format is available as an output
format for the trace log. The thread name is now included
in this format to enable easier correlation with other types
of diagnostic data.

See[“Interpreting trace output” on page 116

In J2SE 1.4, the Java logging framework was introduced
via JSR47. In WebSphere Application Server, messages
and trace logged to both JRAS and JSR47 logging APIs
are passed into the JSR47 logging infrastructure. This
allows JSR47 Handlers connected to the root JSSR47
Logger to receive all WebSphere Application Server log
content. JSR47 and JRAS Logger levels can be controlled
via the admin console troubleshooting section.
WebSphere Application Server also builds its logs from
the JSR47 framework by connecting its Handlers to the
root Logger.

The JSR47 Logging infrastructure allows for flexible
pluggability of custom Handlers into the logging
infrastructure to enable custom logs. By appropriate
configuration, the Handlers can receive WebSphere
Application Server’s logged events, and events logged to
Loggers instantiated by your applications.

Seel‘Log and trace with Java logging” on page 19/



http://jakarta.apache.org/commons/
http://jcp.org/en/jsr/detail?id=47
http://www-128.ibm.com/developerworks/webservices/library/ws-cbe/

Troubleshooting by component

Use this page to help resolve a problem within a particular component.

1. Use WebSphere Application Server tracing and logging to help you identify and resolve problems.
2. Determine which component needs troubleshooting.

3. Select the appropriate link from this page and follow the troubleshooting steps.

A client program does not work
What kind of problem are you seeing?

ActiveX client fails to display ASP files, or WebSphere Application Server
resources (JSP files, servlet, or HTML pages) or both

A possible cause of this problem is that both 1S for serving Active Server Pages (ASP) files and an HTTP
server that supports WebSphere Application Server (such as IBM HTTP Server) are deployed on the same
host. This deployment leads to misdirected HTTP traffic if both servers are listening on the same port
(such as the default port 80).

To resolve this problem, either:

* Open the IIS administrative panel, and edit the properties of the default Web server to change the port
number to a value other than 80

* Install 1IS and the HTTP server on separate servers.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.
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Chapter 2. How do | troubleshoot?

Use this page as a reference of the tutorials included in the WebSphere Application Server, Version 6.1
Information Center. In the information center, hold your cursor over the task icon to see a description of
the task. The task preview feature is unavailable for Mozilla Web browsers.

Set traces and  [ConsolefConsole]|

logs
For more detailed
information on
enabling traces by
using scripting,
see the
Troubleshooting
with scripting
chapter in the
Administering
applications and
their environment
PDF book.

Work with |Detailed steps [Show me)
message logs

Detect hung Detailed steps

threads

Detect product Detailed steps
configuration file
problems

Troubleshoot Detailed steps
problems that
occur during a

task

Debug Detailed steps
WebSphere

applications

during

development

Add tracing and [Detailed steps
logging to your
applications

Collect details Detailed steps
for IBM Support

Using JSR47 for |Detailed steps
logging
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ftp://ftp.software.ibm.com/software/eod/WAS_6-0/PD/Simulations//WASv6_Logging_Tracing.viewlet/WASv6_Logging_Tracing_viewlet_swf.html

Using JSR47 for
logging: Writing
a handler

Detailed steps|

Using JSR47 for |Detailed steps
logging: Writing

a formatter

Using JSR47 for |Detailed steps
logging: Writing

a filter

Using JSR47 for
logging:

Configuring

access logs

Using Common
Base Events for

logging

Creating
Common Base

Events

Legend for "How do 1?..."” links

demonstration

Detailed steps Show me Tell me Guide me Teach me
Refer to the detailed |Watch a brief View the presentation |Be led through the Perform the tutorial
steps and reference multimedia for an overview console pages with sample code

Approximate time:
Varies

Approximate time: 3
to 5 minutes

Approximate time:
10 minutes+

Approximate time:

1/2 hour+

Approximate time: 1
hour+

10 Troubleshooting and support




Chapter 3. Installing maintenance packages

This topic describes how to use the IBM Update Installer for WebSphere Software to install interim fixes,
fix packs, and refresh packs. The Update Installer for WebSphere Software is also known as the Update
Installer program, the Updatelnstaller program, and the Update installation wizard.

Use the proper authorizations to successfully install product updates.

When administrative security is enabled on WebSphere Application Server, for example, you must supply
the administrative user ID and password before you can update the files.

Use the Update Installer program from a user profile with *ALLOBJ special authority.

Important:

» The user account that originally installed the WebSphere Application Server product to be
updated should be used to launch the Installation Wizard to install the Update Installer, and
the same user account should be used to launch the Update Installer program to update a
product.

— When a different user account uses the location, that user account must have

reading and running access to that location. It must also have writing access to the
Iogs directory and its subdirectory.

— When a different user account is used to update the target WebSphere Application
Server product location, that user account must have full access (reading, writing, and
running) to the target location where a maintenance package is to be applied.

* Make sure that no processes from any users are locking any files in the target location
where a maintenance package is to be installed.
The Update Installer wizard is an InstallShield for Multiplatforms wizard that runs with in silent mode with a
The following descriptions contain reference information about installing interim fixes, fix packs, and
refresh packs on WebSphere Application Server products and components:
Overview of the installation procedure
1. Download, unpack, and install the Update Installer for WebSphere Software; or install the
Update Installer that is on the WebSphere Application Server supplements disc.
2. Download the most current version of the interim fix, fix pack, or refresh pack file from the
Support site.
3. Download the interim fix, fix pack, or refresh pack from the Support Web site into the

maintenance directory.
4. Use the Update Installer to install the interim fix, fix pack, or refresh pack.

The Update Installer creates a backup file in the [app_server_roolproperties/version/nif/backup
directory.
Updating existing profiles in WebSphere Application Server products
The Update Installer updates the core product files in a WebSphere Application Server product.
Service in a maintenance package might update the following files in the installation root directory:
» JAR files in the lib directory
« Scripts in the bin directory
* Profile templates
Viewing the fix level of the product
Use the versioninfo command and the historylnfo command in the bin directory of the installation
root directory to display the exact fix and version level of the product. However, do not use either
command while installing or uninstalling a maintenance package.
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Important: See the release notes for your product for the latest information about the Update Installer.

The following procedure describes how to install a maintenance package.
1. Log on as a user profile with “ALLOBJ special authority.
2. Install the product that you intend to update.

You have very likely already installed the software that you are now updating. But if not, install the
software now.

3. Optional: Install a new version of the Update Installer.

Back up and uninstall any older copy of the Update Installer before downloading and installing the
current Update Installer. To use a newer version of the Update Installer, you must first remove the
older version.

a. Back up any files and subdirectories in the maintenance directory if necessary.
b. Uninstall the older version of the Update Installer using the program underuninstall.

c. Download, unpack, and install the Update Installer for WebSphere Software; or install the Update
Installer that is on the WebSphere Application Server supplements disc.

4. Download the maintenance package *.pak file from the Support Web site into the maintenance
directory.

Tip: Do not attempt to unzip or unpack the *.pak file.
5. Stop all processes that use the WebSphere Application Server product.

Before installing or uninstalling interim fixes, fix packs, and refresh packs on a machine, stop all Java
processes on the machine that use the WebSphere Application Server product.

WebSphere Application Server processes include application server processes, such as the process
created when server1 is running.

6. Verify that the following prerequisite conditions are met:
* All of the product hardware and software prerequisites exist.

The official statement of supported hardware and software is on the [Supported hardware and
[software Web site |

* The WebSphere software that you are updating is correctly installed and is not corrupt.
e The user has *ALLOBJ special authority.

7. Use the Update Installer to install the maintenance package.
Issue the following command to use the silent interface:

Table 1. Update installer command for installing in silent mode

Command example Type of installation Description
update -options "responsefiles/file_name” Silent mode with an Overrides all default values with
options file values that you specified in the

options response file.

Always use a response file that is
based on the response file under

updi_roofresponsefiles.

This procedure results in installing maintenance packages to update WebSphere software.

After installing all maintenance packages, continue to use your WebSphere software.

install.txt

The Update Installer for WebSphere Software can use an options response file to install maintenance
packages from a command line interface.
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The install.txt file has one directive that identifies the backup file for installing a service update. Comments
in the file describe how to set the string value.

The Update Installer for WebSphere Software wizard reads the options file to determine installation
choices. The Update Installer installs the maintenance package in silent mode instead of displaying a
graphical user interface.

Location of the response file

The sample options response file is named install.txt. The file is in the responsefiles directory
after you install the Update Installer for WebSphere Software into the installation root directory of the
WebSphere software product.

Installing silently
The options file supplies the values to the Update installer wizard when installing silently.

The following command uses a copy of the options file named myresponsefile.ixt to provide installation
option responses during a silent installation:

update -options responsefiles/myresponsefile.txt

There is no need to specify the -silent parameter as it is already defined in the update script.

Response file user entry validation

In a silent installation, response file validation is coded into the installation. If the validation does not pass,
the failure is recorded in the log files in the |app_server_roofflogs/update/tmp directory.

Location of the maintenance package to be installed

Default directive setting
-W maintenance.package=""

Valid setting
You must set this directive to the location of the maintenance package PAK file. For
example, you might specify the following location:

/QIBM/ProdData/WebSphere/updateinstaller/V61/UPDI/maintenance/PQ20029.pak
Error identifiers:
* Maintenance package maintenance_package _name is already installed on the system.
» Selected product is not supported.
« Configuration failed. The config action that failed was: configuration_action.

* Install the following prerequisite APARs before installing the current maintenance to the
target product: list_ of  prerequisite_ maintenance_ packages_ to_ install

 Install the following prerequisite maintenance packages before installing the package
you are currently attempting to install: list_ of prerequisite_ maintenance_ packages_
to_ install

» Uninstall the following APARs before applying the current maintenance to the target
product: list_ of _ prerequisite_ maintenance_ packages_ to_ uninstall

» Uninstall the following maintenance packages before applying the current maintenance
to the target product: list_ of  prerequisite_ maintenance_ packages_ to_ uninstall

* Unable to locate the correct version of the_update_installer. Looking for version
version_identifier.

* Maintenance_package is not a valid maintenance package.

Product location

Chapter 3. Installing maintenance packages 13



Default directive setting
-W product.location="SPECIFY_PRODUCT_INSTALL_LOCATION_HERE"

Valid setting
Set this directive to the installation root directory of the product. For example, you might
specify the following location:

/QIBM/ProdData/WebSphere/AppServer/V61/Express

Error identifiers:

Maintenance package maintenance_package_name is already installed on the system.
Selected product is not supported.
Configuration failed. The config action that failed was: configuration_action.

Install the following prerequisite APARs before installing the current maintenance to the
target product: list_ of prerequisite_ maintenance_ packages_ to_ install

Install the following prerequisite maintenance packages before installing the package
you are currently attempting to install: list_ of  prerequisite_ maintenance_ packages_
to_ install

Uninstall the following APARs before applying the current maintenance to the target
product: list_ of_ prerequisite_ maintenance_ packages_ to_ uninstall

Uninstall the following maintenance packages before applying the current maintenance
to the target product: list_ of  prerequisite_ maintenance_ packages_ to_ uninstall

Unable to locate the correct version of the_update_installer. Looking for version
version_identifier.

Maintenance_package is not a valid maintenance package.
Alternate_product_directory could not be validated as an existing directory.

Usage notes

» The file is not a read-only file.

 Edit this file directly with your flat file editor of choice, such as Kate on SLES or WordPad on a
Windows platform.

* The file must exist to perform a silent installation. The Update installer wizard reads this file to
determine installation parameters. Provide the fully qualified file path to the backup file.

+ Save the copy of the options file in the responsefiles directory for best results.

Example install.txt file

Edit the version of the file that is included in the Update Installer for WebSphere Software ZIP file. The
following example is not guaranteed to be an accurate representation of the actual file.

[dddddddsdsdsdsdsdsdsdsdsdsdsdsdsdsdadsdsdsdsdsdsssdsdsdsdasssssssssagasaaaaaaad

#

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

This is the silent install response file for installing maintenance packages
using the update installer.

A common use of an options file is to run the wizard in silent mode. This lets
the options file author specify wizard settings without having to run the
wizard in graphical or console mode. To use this options file for silent mode
execution, *uncomment* and modify the parameters defined within.

Use the following command Tine when running the wizard from the update
installer directory:

update -options responsefiles/install.txt
Please enclose all values within a single pair of double quotes.

######E# R R R R R AR AR AR AR AR AR AR AR AR AR R AR AR AR AR AR AR AR AR AR AR AR AR AR AR AR AR AR AR

[dddddddddsdsdsdsdsdsdsdsdsdsdsdsdsdadadsdsdsdsdsdsssdsdddadsssdasaddgagaaagasad
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Used to input the maintenance package full filename specification to be installed.
Edit as appropriate.

je. -W maintenance.package="/QIBM/ProdData/WebSphere/UpdateInstaller/V61/UPDI/maintenance/PQ20029.pak"

Note: If no package is specified, a default of the last downloaded maintenance
package will be used (based on timestamp).

L L

-W maintenance.package=

[dddddddddddsdsdsdsdsdsdsdsasdsdadadadadsdsdadsdadadadadadasassdagagagagagagagadd

#

# Used to input the product install Tocation that will be updated.

#

# ie. -W product.location="/QIBM/ProdData/WebSphere/AppServer/V61/Express"
#

# Note: The product install location should always been specified, and it should
# always be the full path.

#

-W product.location=""

fdzddgsddssddssddsddsddssddsddssddssdddsdddsddssddasddadddasddasddadddaadddddd
#

# Do not edit these values.

#

-W update.type="install"

Updating the Update Installer for WebSphere Software

To get updates for the Update Installer for WebSphere Software, download the most current version from

the support site and reinstall it.

Important: Only one copy of the Update Installer should be installed on your system at any one time for
use with all Version 6.x products. Before installing a newer version of the Update Installer, you

must first remove the existing Update Installer.

The Update Installer ships on the Version 6.1 supplements disk. The Update Installer undergoes regular
maintenance and offers updated versions on the WebSphere software support pages.

See |Recommended Updates for WebSphere Application Served Look under your release of the
WebSphere software for a link to the Update Installer download page.

This topic describes how to update the Update Installer after you installed it into a product.
1. Uninstall the Update Installer.

Run the uninstall command in the |app_server_roofbin directory.
2. Download the updated Update Installer files from the product Support site.

For example, see [Recommended Updates for WebSphere Application Server to locate the Update
Installer download page.

3. Unpack the downloaded file to reveal the install program.
4. Install the new Update Installer.
» For remote GUI installation, do the following:
a. Open Windows Explorer and select your disc drive.

b. Click the downloaded_path\Updatelnstalleninstall.exe file to start the InstallShield for
Multiplatforms (ISMP) program.

e For local silent QSH installation, run the INSTALL command from Qshell.
a. On a CL command line, run the STRQSH command to start the Qshell command shell.
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b. Issue the INSTALL command to start the installation program.

cd downloaded_path/Updatelnstaller
INSTALL -options path/responsefile

The Update Installer is installed under the root directory that you specified during installation.

See |Chapter 3, “Installing maintenance packages,” on page 11|for information about using the Update
Installer to install maintenance packages.

16  Troubleshooting and support



Chapter 4. Debugging applications

To debug your application, you must use a development environment like Application Server Toolkit or
Rational Application Developer to create a Java project. You must then import the program that you want
to debug into the project. By following the steps below, you can import the WebSphere Application Server
examples into a Java project.

Two debugging styles are available:

» Step-by-step debugging mode prompts you whenever the server calls a method on a Web object. A
dialog lets you step into the method or skip it. In the dialog, you can turn off step-by-step mode when
you are finished using it.

» Breakpoints debugging mode lets you debug specific parts of programs. Add breakpoints to the part of
the code that you must debug and run the program until one of the breakpoints is encountered.

Breakpoints actually work with both styles of debugging. Step-by-step mode just lets you see which Web
objects are being called without having to set up breakpoints ahead of time.

You do not need to import an entire program into your project. However, if you do not import all of your
program into the project, some of the source might not compile. You can still debug the project. Most
features of the debugger work, including breakpoints, stepping, and viewing and modifying variables. You
must import any source that you want to set breakpoints in.

The inspect and display features in the source view do not work if the source has build errors. These
features let you select an expression in the source view and evaluate it.

Create a Java Project by opening the New Project dialog.

Select Java from the left side of the dialog and Java Project in the right side of the dialog.
Click Next and specify a name for the project, for example, WASExamples.

Click Finish to create the project.

Select the new project, choose File > Import > File System, then Next to open the import file
system dialog.

6. Browse the directory for files.

Go to the following directory: instalIedApps/node_name/DefauItAppIication.ear/
DefaultWebApplication.war.

7. Select DefaultWebApplication.war in the left side of the Import dialog and then click Finish. This
imports the JavaServer Pages files and Java source for the examples into your project.

8. Add any JAR files needed to build to the Java Build Path.

Select Properties from the right-click menu. Choose the Java Build Path node and then select the
Libraries tab. Click Add External JARs to add the following JAR files:
+ [profile_roofjinstalledApps/node_name/DefaultApplication.ear/Increment.jar.

When you have added this JAR file, select it and use the Attach Source function to attach the
Increment.jar file because it contains both the source and class files.

* |app_server _rootlib/i2ee.jar

* |app_server_rooflib/pagelist.jar

* |app_server_rooflib/webcontainer.jar

Click OK when you have added all of the JARs.

9. You can set some breakpoints in the source at this time if you like, however, it is not necessary as
step-by-step mode will prompt you whenever the server calls a method on a Web object.
Step-by-step mode is explained in more detail below.

10. To start debugging, you need to start the WebSphere Application Server in debug mode and make
note of the JVM debug port. The default value of the JVM debug port is 7777.

ok~
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11. When the server is started, switch to the debug perspective by selecting Window > Open
Perspective > Debug. You can also enable the debug launch in the Java Perspective by choosing
Window > Customize Perspective and selecting the Debug and Launch checkboxes in the Other
category.

12. Select the workbench toolbar Debug pushbutton and then select WebSphere Application Server
Debug from the list of launch configurations. Click the New pushbutton to create a new configuration.

13. Give your configuration a name and select the project to debug (your new WASExamples project).
Change the port number if you did not start the server on the default port (7777).

14. Click Debug to start debugging.
15. Load one of the examples in your browser. For example: http://your.server.name:9080/hitcount

To learn more about debugging, launch the Application Server Toolkit, select Help > Help Contents and
choose the Debugger Guide bookshelf entry. To learn about known limitations and problems that are
associated with the Application Server Toolkit, see the Application Server Toolkit release notes. For current
information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |[Must gatherl documents page for information to gather to send to IBM
Support.

Debugging components in the Application Server Toolkit

The Application Server Toolkit, included with the WebSphere Application Server on a separately-installable
CD, includes debugging functionality that is built on the Eclipse workbench. Documentation for the
Application Server Toolkit is provided with that product. To learn more about the debug components,
launch the Application Server Toolkit, select Help > Help Contents and choose the Debugger Guide
bookshelf entry.

The Application Server Toolkit includes the following:

The WebSphere Application Server debug adapter
which allows you to debug Web objects that are running on WebSphere Application Server and
that you have launched in a browser. These objects include enterprise beans, JavaServer Pages
files, and servlets.

The JavaScript debug adapter
which enables server-side JavaScript debugging.

The Compiled language debugger
which allows you to detect and diagnose errors in compiled-language applications.

The Java development tools (JDT) debugger
which allows you to debug Java code.

All of the debug components in the Application Server Toolkit can be used for debugging locally and for

remote debugging. To learn more about the debug components, launch the Application Server Toolkit,
select Help > Help Contents and choose the Debugger Guide bookshelf entry.
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Chapter 5. Add logging and tracing to your application

You can add logging and tracing to applications to help analyze performance and diagnose problems in
WebSphere Application Server.

Deprecation: The JRas framework that is described in this information center is deprecated. However, you
can achieve the same results using Java logging.

Designers and developers of applications that run with or under WebSphere Application Server, such as
servlets, JavaServer Pages (JSP) files , enterprise beans, client applications, and their supporting classes,
might find it useful to use Java logging for generating their application logging.

This approach has advantages over adding System.out.printIn statements to your code:

* Your messages are displayed in the WebSphere Application Server standard log files, using a standard
message format with additional data, such as a date and time stamp that are added automatically.

* You can more easily correlate problems and events in your own application to problems and events that
are associated with WebSphere Application Server components.

* You can take advantage of the WebSphere Application Server log file management features.

_o| User Handler1 [ 5 Output

Application = com.xyz.abc.def 5 sliar) Coce
code e (Logger)
com.xyz.abc
3 (Log);er) ]
. ) User Handler2 Output
Application com.xyz.abc.ghi —> )
> (Handler ) device
code > (Logger)
1
Application - JRAS API | Anonymous
»
code (deprecated) - (Logger)
Applications root | Applications
WebSphere Application Server (Logger) WebSphere
4 Application Server
’ g . WebSphere
Sbervklce > corr('l.llbm.Wf.)xyz > corcubm.ws Application |- g:\;;::l;t
(L CE 0gge (Logger) Server handlers

To use Java logging, configure properties using the administrative console.

2. Customize the properties to meet your logging needs. For example, enable or disable a particular log,
specify the number of logs to be kept, and specify a format for log output.

3. Restart the application server after making static configuration changes.

Log and trace with Java logging

Java logging is the logging toolkit that is provided by the java.util.logging package. Java logging provides a
standard logging API for your applications.

The application server redirects the system streams at the server startup. There is no way to allow the
application to output logging to the console because the system streams can not be obtained by the
application. If you would like to use console to monitor the application without using the console handler,
you can either monitor the SystemOut.1og file, or monitor a file created by another file handler.
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Note: The application server uses Java logging internally and therefore certain restrictions apply for using
system streams with this logging API by applications. During server startup, the standard output and
error streams are replaced with special streams that write to the logging infrastructure, in order to
include the output of the system streams in the log files. Because of this, applications can not
usejava.util.logging.ConsoleHandler, or any handler writing to System.err or System.out
streams, attached to the root logger. If the user does attache the handler to the root logger, an
infinite loop is created within the logging infrastructure, leading to stack overflow and server crash.

If the use of a handler that writes to system streams is necessary, attach it to a non-root logger so
that it does not publish log records to parent handlers. The data written to the system streams is
then formatted and written to the corresponding system stream log file. To monitor what is being
written system streams, the configured log files (SystemQut.log and SystemErr.Tog by default) can
be monitored.

Developing, deploying and maintaining applications are complex tasks. When an application encounters an
unexpected condition, it might not be able to complete a requested operation. You might want the
application to inform the administrator that the operation failed and tell the administrator why the operation
failed. This information enables the administrator to take the proper corrective action. Application
developers might need to gather detailed information that relates to the path of a running application to
determine the root cause of a failure that is due to a code bug. The facilities that are used for these
purposes are typically referred to as logging and tracing.

Message logging (messages) and diagnostic trace (trace) are conceptually similar, but do have important
differences. These differences are important for application developers to understand to use these tools
properly. The following operational definitions of messages and trace are provided.

Message
A message entry is an informational record that is intended for end users, systems administrators,
and support personnel to view. The text of the message must be clear, concise, and interpretable
by an end user. Messages are typically localized and displayed in the national language of the end
user. Although the destination and lifetime of messages might be configurable, enable some level
of message logging in normal system operation. Use message logging judiciously because of
performance considerations and the size of the message repository.

Trace A trace entry is an information record that is intended for service engineers or developers to use.
As such, a trace record might be considerably more complex, verbose, and detailed than a
message entry. Localization support is typically not used for trace entries. Trace entries can be
fairly inscrutable, understandable only by the appropriate developer or service personnel. It is
assumed that trace entries are not written during normal runtime operation, but can be enabled as
needed to gather diagnostic information.

« To use Java logging, see [‘Configuring logging properties using the administrative console” on page 61|

» See the Java documentation for the java.util.logging class for a full description of the syntax and the
construction of logging methods.

Loggers

Loggers are used by applications and runtime components to capture message and trace events.

When situations occur that are significant either due to a change in state, for example when a server
completes startup or because a potential problem is detected, such as a timeout waiting for a resource, a
message is written to the logs. Trace events are logged in debugging scenarios, where a developer needs
a clear view of what is occurring in each component to understand what might be going wrong. Logged
events are often the only events available when a problem is first detected, and are used during both
problem recovery and problem resolution.

Loggers are organized hierarchically. Each logger can have zero or more child loggers.
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Loggers can be associated with a resource bundle. If specified, the resource bundle is used by the logger
to localize messages that are logged to the logger. If the resource bundle is not specified, a logger uses
the same resource bundle as its parent.

You can configure loggers with a [evel. If specified, the level is compared by the logger to incoming
events. The events that are less severe than the level set for the logger are ignored by the logger. If the
level is not specified, a logger takes on the level that is used by its parent. The default level for loggers is
Level.INFO.

Loggers can have zero or more attached . If supplied, all events that are logged to the logger are
passed to the attached handlers. Handlers write events to output destinations such as log files or network
sockets. When a logger finishes passing a logged event to all of the handlers that are attached to that
logger, the logger passes the event to the handlers that are attached to the parents of the logger. This
process stops if a parent logger is configured not to use its parent handlers. Handlers in WebSphere
Application Server are attached to the root logger. Set the useParentHandlers logger property to false to
prevent the logger from writing events to handlers that are higher in the hierarchy.

Loggers can have a If supplied, the filter is invoked for each incoming event to tell the logger whether
or not to ignore it.

Applications interact directly with loggers to log events. To obtain or create a logger, a call is made to the
Logger.getLogger method with a name for the logger. Typically, the logger name is either the package
qualified class name or the name of the package that the logger is used by. The hierarchical logger
namespace is automatically created by using the dots in the logger name. For example, the
com.ibm.websphere.ras logger has a com.ibm.websphere parent logger, which has a com.ibm parent. The
parent at the top of the hierarchy is referred to as the root logger. This root logger is created during
initialization. The root logger is the parent of the com logger.

Loggers are structured in a hierarchy. Every logger, except the root logger, has one parent. Each logger
can also have 0 or more children. A logger inherits log handlers, resource bundle names, and event
filtering settings from its parent in the hierarchy. The logger hierarchy is managed by the LogManager
function.

Loggers create log records. A log record is the container object for the data of an event. This object is
used by filters, handlers, and formatters in the logging infrastructure.

The logger provides several sets of methods for generating log messages. Some log methods take only a
level and enough information to construct a message. Other, more complex logp (log precise) methods
support the caller in passing class name and method name attributes, in addition to the level and message
information. The logrb (log with resource bundle) methods add the capability of specifying a resource
bundle as well as the level, message information, class name, and method name. Using methods such as
severe, warning, fine, finer, and finest you can log a message at a particular level. For more information on
logging and how to use it in your applications read [‘Using loggers in an application” on page 25| For a
complete list of methods, see the java.util.logging documentation at |http://java.sun.com/j2se/}

Log handlers

Log handlers write log record objects to output devices like log files, sockets, and notification mechanisms.

Loggers can have zero or more attached handlers. All objects that are logged to the logger are passed to
the attached handlers, if handlers are supplied.

You can configure handlers with a The handler compares the level that is specified in the logged

object to the level that is specified for the handler. If the level of the logged object is less severe than the
level set in the handler, the object is ignored by the handler. The default level for handlers is ALL.
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Handlers can have a If a filter is supplied, the filter is invoked for each incoming object to tell the
handler whether or not to ignore it.

Handlers can have a[formatter] If a formatter is supplied, the formatter controls how the logged objects are
formatted. For example, the formatter can decide to first include the time stamp, followed by a string
representation of the level, followed by the message that is included in the logged object. The handler
writes this formatted representation to the output device. Read r‘java.util.logging custom formatters” on|

for information on using a custom formatter in your applications.

Both loggers and handlers can have levels and filters, and a logged object must pass all of these elements
to be output. For example, you can set the logger level to FINE, but if the handler level is set at
WARNING, only WARNING level messages are displayed in the output for that handler. Conversely, if your
log handler is set to output all messages (level=All), but the logger level is set to WARNING, the logger
never sends messages lower than WARNING to the log handler.

Log levels

Levels control which events are processed by Java logging. WebSphere Application Server controls the
levels of all loggers in the system.

The level value is set from configuration data when the logger is created and can be changed at run time
from the administrative console. If a level is not set in the configuration data, a level is obtained by
proceeding up the hierarchy until a parent with a level value is found. You can also set a level for each
handler to indicate which events are published to an output device. When you change the level for a
logger in the administrative console, the change is propagated to the children of the logger.

Levels are cumulative; a logger can process logged objects at the level that is set for the logger, and at all
levels above the set level. Valid levels are:

Level Content / Significance

Off No events are logged.

Fatal Task cannot continue and component cannot function.

Severe Task cannot continue, but component can still function

Warning Potential error or impending error

Audit Significant event affecting server state or resources

Info General information outlining overall task progress

Config Configuration change or status

Detail General information detailing subtask progress

Fine Trace information - General trace + method entry / exit /
return values

Finer Trace information - Detailed trace

Finest Trace information - A more detailed trace - Includes all
the detail that is needed to debug problems

All All events are logged. If you create custom levels, All
includes your custom levels, and can provide a more
detailed trace than Finest.

For instructions on how to set logging levels, see I“Configuring logging properties using the administrative|
lconsole” on page 61|
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Note: Trace information, which includes events at the Fine, Finer and Finest levels, can be written only to
the trace log. Therefore, if you do not enable diagnostic trace, setting the log detail level to Fine,
Finer, or Finest does not effect the logged data.

Log filters

Log filters help control more detailed logging settings that are not handled by usual log level settings.

A filter provides an optional, secondary control over what is logged, beyond the control that is provided by
setting the Applications can apply a filter mechanism to control logging output through the logging
APls. An example of filter usage is to suppress all the events with a particular message key.

A filter is attached to a logger or log handler using the appropriate setFilter method. Read |“java.uti|.|ogging|
lcustom filters” on page 34 for information on implementing custom filters. For a complete list of filter
methods, see the java.util.logging documentation at [http://java.sun.com/j2se/|

Log formatters

Log formatters format log messages so they can be used by various log handlers.

Handlers can be configured with a log formatter that knows how to format log records. The event, which is
represented by the log record object, is passed to the appropriate formatter by the handler. The formatter
returns formatted output to the handler, which writes the output to the output device.

The formatter is responsible for rendering the event for output. This formatter uses the resource bundle
that is specified in the event to look up the message in the appropriate language.

Formatters are attached to handlers using the setFormatter method.

You can find the java.util.logging documentation at |http://java.sun.com/j2se/

Logging properties for an application
Use the Logger.properties file to set logger attributes for specific loggers.

The properties file is loaded the first time that the Logger.getLogger(logger_name) method is called within
an application.

Important: The name of the Logger.properties file is case sensitive. Use a capital "L" in the file name.

When an application calls the Logger.getLogger method for the first time, all the available logger properties
files are loaded. Applications can provide Logger.properties files in:

» the META-INF directory of the Java archive (JAR) file for the application
» directories included in the class path of an application module
» directories included in the application class path

The properties file contains two categories of parameters, logger control and logger data:

» Logger control information
— Minimum localization level: The minimum LogRecord level for which localization is attempted
— Group: The logical group that this component belongs to

— Event factory: The Common Base Event template file to use with the event factory. The naming
convention for this template is the fully qualified component name, with a file extension of
.event.xml. For example, a template that applies to the com.ibm.compXYZ package is called
com.ibm.compXYZ.event.xml.

» Logger data information
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Product name

Organization name

Component name

Extensions and additional properties

Syntax of the Logger.properties file
Use the following syntax to set logger properties:
<logger base name>.<property>=value

where:

logger base name is the starting part of the logger name to which the property applies. All loggers with
names starting with this string have the property applied.

property is one of the following properties:
* organization

* product

e component

* minimum_localization_level

e group

» eventfactory

Sample Logger.properties file

In the following sample, the com.ibm.xyz.MyEventFactory event factory is used by any loggers in the
com.ibm.websphere.abc package or any sub packages that do not override this value in their configuration
file.

com.ibm.websphere.abc.eventfactory=com.ibm.xyz.MyEventFactory
Group Logger.properties file

In the following example, the group is MyTraceGroup and the components are com.ibm.stuff and
com.ibm.morestuff:

com.ibm.stuff.group=MyTraceGroup
com.ibm.morestuff.group=MyTraceGroup

Sample security policy for logging
Set up a security policy to allow your applications to modify logging and handler properties.

The sample security policy that follows grants access to the file system and runtime classes. Include this
security policy, with the entry permission java.util.logging.LoggingPermission "control", in the
META-INF directory of your application if you want your applications to programmatically alter controlled
properties of loggers and handlers. The META-INF file is located in the following locations for the different
module types:

EJB projects ejbModule/META-INF/MANIFEST.MF
Application client projects appClientModule/META-INF/MANIFEST.MF
Dynamic Web projects WebContent/META-INF/MANIFEST.MF
Connector projects connectorModule/META-INF/MANIFEST.MF
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Below is a sample security policy that grants permission to modify logging properties:

[T e riiellieelieilliiiiii
//
// WebSphere Application Server Security Policy

/1l
LTI 111111111111
LTI I EL LT r1itiiililelelelelelelilig

// Allow all access to the file system and runtime classes
[IIETETTETIETL LTI LI L i i i i iiiieiieiierlirliiiiiiiiiieiiiiiiil
grant codeBase "file:${application}" {

permission java.util.logging.LoggingPermission "control";

}s

Using loggers in an application
This topic describes how to use Java logging within an application.

To create an application using Java logging, perform the following steps:
1. Create the necessary handler, formatter, and filter classes if you need your own log files.

2. If localized messages are used by the application, create a resource bundle, as described in
[log resource bundles and message files” on page 29

3. In the application code, get a reference to a logger instance, as described in [‘Using a logger.’|
4. Insert the appropriate message and trace logging statements in the application, as described in

Using a logger
You can use Java logging to log messages and add tracing.

Use WsLevel.DETAIL level and above for messages, and lower levels for trace. The WebSphere
Application Server Extension API (the com.ibm.websphere.logging package) contains the WsLevel class.

For messages use:

WsLevel.FATAL
Level.SEVERE
Level.WARNING
WsLevel .AUDIT
Level.INFO
Level.CONFIG
WsLevel .DETAIL

For trace use:

Level .FINE

Level .FINER

Level.FINEST

1. Use the logp method instead of the log or the logrb method. The logp method accepts parameters for
class name and method name. The log and logrb methods will generally try to infer this information,
but the performance penalty is prohibitive.

2. Avoid using the logrb method. This method leads to inefficient caching of resource bundles and poor
performance.

3. Use the isLoggable method to avoid creating data for a logging call that does not get logged. For
example:

if (lTogger.isLoggable(Level.FINEST)) {
String s = dumpComponentState(); // some expensive to compute method
logger.logp(Level .FINEST, className, methodName, "componentX state
dump:\n{0}", s);
1
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The following sample applies to localized messages:

// note - generally avoid use of FINE, FINER, FINEST Tevels for messages to be consistent with
// WebSphere Application Server

String componentName = "com.ibm.websphere.componentX";
String resourceBundleName = "com.ibm.websphere.componentX.Messages";
Logger Togger = Logger.getlLogger(componentName, resourceBundleName);

// "Convenience" methods - not generally recommended due to lack of class
/ method names
// - cannot specify message substitution parameters
// - cannot specify class and method names
if (logger.isLoggable(Level.SEVERE))
Togger.severe("MSG_KEY 01");

if (logger.isLoggable(Level .WARNING))
Togger.warning("MSG_KEY_01");

if (logger.isLoggable(Level.INFO))
Togger.info("MSG_KEY_01");

if (logger.isLoggable(Level.CONFIG))
Togger.config("MSG_KEY_01");

// 1og methods are not generally used due to lack of class and method

names

// - enable use of WebSphere Application Server-specific levels
// - enable use of message substitution parameters

// - cannot specify class and method names

if (logger.isLoggable(WsLevel.FATAL))
Togger.log(WsLevel.FATAL, "MSG_KEY 01", "parameter 1");

if (logger.isLoggable(Level.SEVERE))
Togger.log(Level.SEVERE, "MSG_KEY 01", "parameter 1");

if (logger.isLoggable(Level.WARNING))
Togger.log(Level .WARNING, "MSG_KEY 01", "parameter 1");

if (logger.isLoggable(WsLevel.AUDIT))
Togger.log(WsLevel .AUDIT, "MSG_KEY 01", "parameter 1");

if (logger.isLoggable(Level.INFO))
Togger.log(Level.INFO, "MSG_KEY 01", "parameter 1");

if (logger.isLoggable(Level.CONFIG))
Togger.log(Level.CONFIG, "MSG_KEY 01", "parameter 1");

if (logger.isLoggable(WsLevel.DETAIL))
Togger.log(WsLevel .DETAIL, "MSG_KEY 01", "parameter 1");

// logp methods are the way to Tog

// - enable use of WebSphere Application Server-specific levels
// - enable use of message substitution parameters
// - enable use of class and method names

if (logger.isLoggable(WsLevel.FATAL))
Togger.logp(WsLevel .FATAL, className, methodName, "MSG_KEY 01",
"parameter 1");

if (logger.isLoggable(Level.SEVERE))
Togger.logp(Level.SEVERE, className, methodName, "MSG_KEY 01",
"parameter 1");

if (Togger.isLoggable(Level.WARNING))
Togger.logp(Level .WARNING, className, methodName, "MSG_KEY 01",
"parameter 1");
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if (Togger.isLoggable(WsLevel.AUDIT))
logger.logp(WsLevel .AUDIT, className, methodName, "MSG_KEY 01",
"parameter 1");

if (Togger.isLoggable(Level.INFO))
Togger.logp(Level.INFO, className, methodName, "MSG_KEY 01",
"parameter 1");

if (logger.isLoggable(Level.CONFIG))
Togger.logp(Level .CONFIG, className, methodName, "MSG_KEY_ 01",
"parameter 1");

if (logger.isLoggable(WsLevel .DETAIL))
logger.logp(WsLevel .DETAIL, className, methodName, "MSG_KEY 01",
"parameter 1");

// logrb methods are not generally used due to diminished performance
of switching resource bundles dynamically

// - enable use of WebSphere Application Server-specific levels
// - enable use of message substitution parameters
// - enable use of class and method names

String resourceBundleNameSpecial =
""com.ibm.websphere.componentX.MessagesSpecial";

if (logger.isLoggable(WsLevel.FATAL))
logger.logrb(WsLevel .FATAL, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.SEVERE))
logger.logrb(Level .SEVERE, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (Togger.isLoggable(Level.WARNING))
Togger.logrb(Level .WARNING, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (Togger.isLoggable(WsLevel.AUDIT))
logger.logrb(WsLevel .AUDIT, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.INFO0))
logger.logrb(Level.INFO, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(Level.CONFIG))
logger.logrb(Level.CONFIG, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

if (logger.isLoggable(WsLevel.DETAIL))
logger.logrb(WsLevel .DETAIL, className, methodName, resourceBundleNameSpecial,
"MSG_KEY_01", "parameter 1");

For trace, or content that is not localized, the following sample applies:

// note - generally avoid use of FATAL, SEVERE, WARNING, AUDIT,
// INFO, CONFIG, DETAIL Tevels for trace
// to be consistent with WebSphere Application Server

String componentName = "com.ibm.websphere.componentX";
Logger Togger = Logger.getLogger(componentName);

// Entering / Exiting methods are used for non trivial methods

if (logger.isLoggable(Level.FINER))
logger.entering(className, methodName);
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if (logger.isLoggable(Level.FINER))
Togger.entering(className, methodName, "method paraml");

if (logger.isLoggable(Level.FINER))
Togger.exiting(className, methodName);

if (logger.isLoggable(Level.FINER))
Togger.exiting(className, methodName, "method result");

// Throwing method is not generally used due to lack of message - use
logp with a throwable parameter instead

if (logger.isLoggable(Level.FINER))

Togger.throwing(className, methodName, throwable);

// Convenience methods are not generally used due to Tack of class
/ method names
// - cannot specify message substitution parameters
// - cannot specify class and method names
if (logger.isLoggable(Level.FINE))
Togger.fine("This is my trace");

if (logger.isLoggable(Level.FINER))
Togger.finer("This is my trace");

if (logger.isLoggable(Level.FINEST))
Togger.finest("This is my trace");

// 1og methods are not generally used due to Tack of class and
method names

// - enable use of WebSphere Application Server-specific levels
// - enable use of message substitution parameters
// - cannot specify class and method names

if (logger.isLoggable(Level.FINE))
Togger.log(Level .FINE, "This is my trace", "parameter 1");

if (logger.isLoggable(Level.FINER))
Togger.log(Level.FINER, "This is my trace", "parameter 1");

if (logger.isLoggable(Level.FINEST))
Togger.log(Level.FINEST, "This is my trace", "parameter 1");

// logp methods are the recommended way to Tog

// - enable use of WebSphere Application Server-specific levels
// - enable use of message substitution parameters
// - enable use of class and method names

if (logger.isLoggable(Level.FINE))
Togger.logp(Level.FINE, className, methodName, "This is my trace",
"parameter 1");

if (logger.isLoggable(Level.FINER))
Togger.logp(Level.FINER, className, methodName, "This is my trace",
"parameter 1");

if (logger.isLoggable(Level.FINEST))

Togger.logp(Level.FINEST, className, methodName, "This is my trace",
"parameter 1");

// Togrb methods are not applicable for trace logging because no localization
is involved
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Logger hierarchy

WebSphere Application Server handlers are attached to the Java root logger, which is at the top of the
logger hierarchy. As a result, any request from anywhere in the logger tree can be processed by
WebSphere Application Server handlers.

With WebSphere Application Server, you can configure the system to do the following:

» Forward all application logging requests to the WebSphere Application Server handlers. This behavior is
the default.

» Forward all application logging requests to your own custom handlers. Set the useParentHandlers
option to false on one of your custom loggers, and then attach your handlers to that logger.

» Forward all application logging requests to both WebSphere Application Server handlers, and your
custom handlers, but do not forward WebSphere Application Server logging requests to your custom
handlers. Set the useParentHandlers option to true on one of your non-root custom loggers, and then
attach your handlers to that logger.True is the default setting.

» Forward all WebSphere Application Server logging requests to both WebSphere Application Server
handlers, and your custom handlers. WebSphere Application Server logging requests are always
forwarded to WebSphere Application Server handlers. To forward WebSphere Application Server
requests to your custom handlers, attach your custom handlers to the Java root logger, so that they are
at the same level in the hierarchy as the WebSphere Application Server handlers.

The following example shows how these requirements can be met using the Java logging infrastructure.

+ | User Handler1 [ 5 Output

Application = com.xyz.abc.def il Coles
code > (Logger)
com.xyz.abc
> (Logyger) |
s ) User Handler2 Output
Application | com.xyz.abc.ghi Handi > devi
code > (lawear) (Handler ) evice
4
Application - JRAS API | Anonymous
code | (deprecated) - (Logger)
Applications root Applications
WebSphere Application Server (Logger) WebSphere
#V Application Server
Servi m.ibm.ws.xyz ib WebSphere Output
ber\‘/(lce > col (.Lo .ef.) y. > CO:].I m.ws Application BN dev:)ce
roker 99 (Logger) Server handlers

Creating log resource bundles and message files

Every method that accepts messages localizes those messages. The mechanism for providing localized
messages is the resource bundle support provided by the IBM Developer Kit, Java Technology Edition. If
you are not familiar with resource bundles as implemented by the Developer Kit, you can get more
information from various texts, or by reading the APl documentation for the java.util. ResourceBundle,
java.util.ListResourceBundle and java.util.PropertyResourceBundle classes, as well as the
java.text.MessageFormat class.

The PropertyResourceBundle class is the preferred mechanism to use.

You can forward messages that are written to the internal WebSphere Application Server logs to other
processes for display. For example, messages that are displayed on the administrative console, which can
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be running in a different location than the server process, can be localized using the /ate binding process.
Late binding means that WebSphere Application Server does not localize messages when they are logged,
but defers localization to the process that displays the message.

To properly localize the message, the displaying process must have access to the resource bundle where
the message text is stored. You must package the resource bundle separately from the application, and
install it in a location where the viewing process can access it.

By default, the WebSphere Application Server runtime localizes all the messages when they are logged.
This localization eliminates the need to pass a . jar file to the application, unless you need to localize in a
different location. However, you can use the early binding technique to localize messages as they log. An
application that uses early binding must localize the message before logging it. The application looks up
the localized text in the resource bundle and formats the message. Use the early binding technique to
package the application resource bundles with the application.

To create a resource bundle, perform the following steps.

1. Create a text properties file that lists message keys and the corresponding messages. The properties
file must have the following characteristics:

» Each property in the file is terminated with a line-termination character.

» If a line contains white space only, or if the first non-white space character of the line is the pound
sign symbol (#) or exclamation mark (!), the line is ignored. The # and ! characters can therefore be
used to put comments into the file.

« Each line in the file, unless it is a comment or consists of white space only, denotes a single
property. A backslash (\) is treated as the line-continuation character.

* The syntax for a property file consists of a key, a separator, and an element. Valid separators
include the equal sign (=), colon (:), and white space ().

* The key consists of all characters on the line from the first non-white space character to the first
separator. Separator characters can be included in the key by escaping them with a backslash (\),
but doing this process is not recommended, because escaping characters is error prone and
confusing. Instead, use a valid separator character that does not display in any keys in the
properties file.

* White space after the key and separator is ignored until the first non-white space character is
encountered. All characters remaining before the line-termination character define the element.

See the Java documentation for the java.util.Properties class for a full description of the syntax and the
construction of properties files.

2. Translate the file into localized versions of the file with language-specific file names. For example, a
file named DefaultMessages.properties can be translated into DefaultMessages_de.properties for
German and DefaultMessages_ja.properties for Japanese.

3. When the translated resource bundles are available, put the bundle in a directory that is part of the
application class path.

4. When a message logger is obtained from the log manager, configure it to use a particular resource
bundle. Messages logged with the Logger API use this resource bundle when message localization is
performed. At run time, the user locale setting determines the properties file from which to extract the
message that is specified by a message key, ensuring that the message is delivered in the correct
language.

5. If the message loggers msg method is called, a resource bundle name must be explicitly provided.

The application locates the resource bundle based on the file location relative to any directory in the class
path. For instance, if the DefaultMessages.properties property resource bundle is located in the
baseDir/subDirl/subDir2/resources directory and baseDir is in the class path, the name
subdirl.subdir2.resources.DefaultMessage is passed to the message logger to identify the resource
bundle.

Resource bundle logging:
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You can create resource bundles in several ways. The best and easiest way is to create a properties file
that supports a properties resource bundle. This sample shows how to create such a properties file.

Resource bundle sample

For this sample, four localizable messages are provided. The properties file is created and the key-value
pairs are inserted. All the normal properties file conventions and rules apply to this file. In addition, the
creator must be aware of other restrictions that are imposed on the values by the Java MessageFormat
class. For example, apostrophes must be escaped or they cause a problem. Avoid the use of non-portable
characters. WebSphere Application Server does not support the use of extended formatting conventions
that the MessageFormat class supports, such as {1, date} or {0,number, integer}.

Assume that the base directory for the application that uses this resource bundle is baseDir and that this
directory is in the class path. Assume that the properties file is stored in the subdirectory baseDir that is
not in the class path (for example, baseDir/subDirl/subDir2/resources). To allow the messages file to
resolve, the subDirl.subDir2.resources.DefaultMessage name is used to identify the property resource
bundle and is passed to the message logger.

For this sample, the properties file is named DefaultMessages.properties.

# Contents of the DefaultMessages.properties file

MSG_KEY_00=A message with no substitution parameters.

MSG_KEY_01=A message with one substitution parameter: parml={0
={0}, parm2 = {1}

MSG_KEY_02=A message with two substitution parameters: parml={0}
1}, parm3={2}

}

0
MSG_KEY_03=A message with three parameter: parml={0}, parm2 = {
When the DefaultMessages.properties file is created, the file can be sent to a translation center where
the localized versions are generated.

Changing the message IDs used in log files
You can change the default format for message IDs in server logs by setting the
com.ibm.websphere.logging.messageld.version system property.

In new releases of WebSphere Application Server logging files will be formatted according to a
standardized system, but the default runtime behavior is still configured to use the older format, In new
releases of WebSphere Application Server the message IDs written to log files will be changed to ensure
they do not conflict with other IBM products. The default runtime behavior is still configured to use the
older message IDs, deprecated in Version 6.1.

The following is a sample of an entry in a trace.log file using a default message ID. Note that the message
ID is PMONOOO1A

[1/26/05 10:17:12:529 EST] 0000000a PMIImpl A PMONOOO1A: PMI is enabled

A sample of the same entry using a new message ID follows. Note that the message ID is CWPMIO001A.
All new WebSphere Application Server message IDs begin with 'CW’.

[1/26/05 10:17:12:529 EST] 0000000a PMIImpl A CWPMIOOO1A: PMI is enabled.

If you are using a logging tool that uses the new standardized format, you might want to change the
default configuration settings to format the logging output appropriately. You will need to change the
configuration for each JVM in the cell if you want the output formatting to be the same across application
servers.

To configure logging files to be formatted according to the new system, use the following command in the
wsadmin utility:

set jvmEntry [$AdminConfig list JavaVirtualMachine]
$AdminConfig create Property $jvmEntry {{name com.ibm.websphere.logging.messageld.version} {value 6} {required false}}
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Note: You must restart the application server for the changes to take effect. Also, remember to do this for
each JVM in the cell for consistent output formatting.

Message IDs written to log files will now be compliant with the new standard.
Converting log files to use IBM unique Message IDs:

The convertlog command creates a new log file with either new or old message IDs substituted in place of
the message IDs in the source file.

Prior to Version 6.x, components were assigned message IDs that are not necessarily unique across IBM
software products. In Version 6.0, a system property was provided to map the message IDs in output logs
to a set of IBM unique message IDs (all WebSphere Application Server message IDs now start with CW)
that do not conflict with other IBM software products. The default runtime behavior still uses the old
message IDs.

To facilitate the migration of logging tools that are reliant on the old message IDs, the convertlog command
is provided to convert the message IDs of log entries from the old standard to the new standard, or the
new standard back to the old. By default, the software is configured to use the old message IDs when
logging, but you can change the default output with the com.ibm.websphere.logging.messageld.version
system property. Read [‘Changing the message IDs used in log files” on page 31|for more information.

Use the convertlog command to convert the log output:

convertlog <source file name> <destination file name> [options]
options: -newMessageFormat convert message IDs to CCCCCnnnnS format
(cannot be used with -m5)
-oldMessageFormat convert message IDs to CCCCnnnnS format
(cannot be used with -m6)

After using the convertlog command you have a new file with message IDs in the chosen format.
convertlog command:

The convertlog command is used to convert the message IDs in log entries from the old standard to the
new standard, or the new standard back to the old.

Previous versions of WebSphere Application Server used message IDs that are deprecated in WebSphere
Application Server Version 6.1. To facilitate the migration of tools based on the old message IDs, the
convertlog command is implemented to translate log files from one message ID standard to the other.

Use the convertlog command as follows:

convertlog <source file name> <destination file name> [options]
options: -newMessageFormat convert message IDs to CCCCCnnnnS format
(cannot be used with -m5)
-oldMessageFormat convert message IDs to CCCCnnnnS format
(cannot be used with -m6)

MessageConverter class:

The com.ibm.websphere.logging.MessageConverter class provides a method to convert a message ID at
the front of a String into either a new message ID or an old message ID. The direction of the conversion is
controlled with the conversionType argument.

Use the MessageConverter class with log analysis tools to convert message IDs from earlier versions of
WebSphere Application Server into the corresponding message IDs that are used in later releases, or to
revert message IDs to an earlier format. See the article|“Message reference” on page 107|for list of
message ID mappings.
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Method
public static java.lang.String convert(java.lang.String in, short conversionType)
Parameters

Use the following parameters with the MessageConverter class:

Parameter Name Description

in The message to convert. The method assumes the
message ID is the first part of the supplied message with
no leading white space.

conversionType CONVERSION_TYPE_WASV5_TO_WASV6
CONVERSION_TYPE_WASV6_TO_WASV5

java.util.logging custom log handlers
There may be occasions when you want to propagate log records to your own log handlers rather than
participate in integrated logging.

To use a stand-alone log handler, set the useParentHandlers flag to false in your application.

The mechanism for creating a customer handler is the Handler class support that is provided by the IBM
Developer Kit, Java Technology Edition. If you are not familiar with handlers, as implemented by the
Developer Kit, you can get more information from various texts, or by reading the APl documentation for
the java.util.logging API.

The following sample shows a custom handler:

import java.io.FileQutputStream;
import java.io.PrintWriter;

import java.util.logging.Handler;
import java.util.logging.LogRecord;

[**

* MyCustomHandler outputs contents to a specified file
*/

public class MyCustomHandler extends Handler {

FileOutputStream fileOutputStream;
PrintWriter printWriter;

public MyCustomHandler(String filename) {
super();

// check input parameter
if (filename == null)
filename = "mylogfile.txt";

try {

// initialize the file

fileOutputStream = new FileOutputStream(filename);
printWriter = new PrintWriter(fileOQutputStream);

}

catch (Exception e) {

// implement exception handling...

}
}

/* (non-API documentation)
* @see java.util.logging.Handler#publish(java.util.logging.LogRecord)
*/

Chapter 5. Add logging and tracing to your application 33



public void publish(LogRecord record) {

// ensure that this Tog record should be logged by this Handler
if (!isLoggable(record))
return;

// Output the formatted data to the file
printWriter.printin(getFormatter().format(record));

}

/* (non-API documentation)

* @see java.util.logging.Handler#flush()
*/

public void flush() {
printWriter.flush();

1

/* (non-API documentation)
* @see java.util.logging.Handler#close()
*
/
public void close() throws SecurityException {
printWriter.close();
1
1

java.util.logging custom filters

A custom filter provides optional, secondary control over what is logged, beyond the control that is
provided by the level.

The mechanism for creating a customer filter is the Filter interface support that is provided by the IBM
Developer Kit, Java Technology Edition. If you are not familiar with filters, as implemented by the
Developer Kit, you can get more information from various texts, or by reading the APl documentation the
for java.util.logging API.

The following example shows a custom filter:

import java.util.Vector;
import java.util.logging.Filter;
import java.util.logging.LogRecord;

[ **

* MyCustomFilter rejects any log records whose Level is not contained in the
* configured Tist of Levels.

*/

public class MyCustomFilter implements Filter {

private Vector acceptablelevels;

public MyCustomFilter(Vector acceptablelLevels) {
super();
this.acceptablelevels = acceptablelevels;

}

/* (non-API documentation)

* @see java.util.logging.Filter#isLoggable(java.util.logging.LogRecord)
*/

public boolean isLoggable(LogRecord record) {

return (acceptablelevels.contains(record.getLevel()));

}
}

java.util.logging custom formatters
A formatter formats events. Handlers are associated with one or more formatters.
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The mechanism for creating a customer formatter is the Formatter class support that is provided by the
IBM Developer Kit, Java Technology Edition. If you are not familiar with formatters, as implemented by the
Developer Kit, you can get more information from various texts, or by reading the APl documentation for
the java.util.logging API.

The following example shows a custom formatter:

import java.util.Date;
import java.util.logging.Formatter;
import java.util.logging.LogRecord;

[**

* MyCustomFormatter formats the LogRecord as follows:
* date  Tevel Tlocalized message with parameters
*/

public class MyCustomFormatter extends Formatter {

public MyCustomFormatter()
super();

public String format(LogRecord record) {

// Create a StringBuffer to contain the formatted record
// start with the date.
StringBuffer sb = new StringBuffer();

// Get the date from the LogRecord and add it to the buffer
Date date = new Date(record.getMillis());
sh.append(date.toString());

sbh.append(" ");

// Get the level name and add it to the buffer
sbh.append(record.getLevel().getName());
sh.append(" ");

// Get the formatted message (includes localization
// and substitution of paramters) and add it to the buffer
sbh.append(formatMessage(record));

return sb.toString();
}
1

Custom handlers, filters, and formatters

In some cases you might want to have your own custom log files. Adding custom handlers, filters, and
formatters enables you to customize your logging environment beyond what can be achieved by the
configuration of the default WebSphere Application Server logging infrastructure.

The following example demonstrates how to add a new handler to process requests to the
com.myCompany subtree of loggers (see ['Logger hierarchy” on page 29). The main method in this sample
gives an example of how to use the newly configured logger.

import java.util.Vector;

import java.util.logging.Filter;
import java.util.logging.Formatter;
import java.util.logging.Handler;
import java.util.logging.Level;
import java.util.logging.Logger;

public class MyCustomLogging {

public MyCustomLogging() {
super();

Chapter 5. Add logging and tracing to your application 35



public static void initializelLogging() {

// Get the logger that you want to attach a custom Handler to
String defaultResourceBundleName = "com.myCompany.Messages";
Logger logger = Logger.getLogger("com.myCompany", defaultResourceBundleName);

// Set up a custom Handler (see MyCustomHandler example)
Handler handler = new MyCustomHandler("MyOutputFile.log");

// Set up a custom Filter (see MyCustomFilter example)
Vector acceptablelLevels = new Vector();
acceptablelevels.add(Level.INFO);
acceptablelevels.add(Level.SEVERE);

Filter filter = new MyCustomFilter(acceptablelLevels);

// Set up a custom Formatter (see MyCustomFormatter example)
Formatter formatter = new MyCustomFormatter();

// Connect the filter and formatter to the handler
handler.setFilter(filter);
handler.setFormatter(formatter);

// Connect the handler to the Togger
logger.addHandler(handler);

// avoid sending events Togged to com.myCompany showing up in WebSphere
// Application Server logs
logger.setUseParentHandlers(false);

}

public static void main(String[] args) {
initializelLogging();

Logger Togger = Logger.getLogger("com.myCompany");

logger.info("This is a test INFO message");

logger.warning("This is a test WARNING message");

logger.logp(Level.SEVERE, "MyCustomLogging", "main", "This is a test SEVERE message");
1
1

When the above program is run, the output of the program is written to the MyOutputFile.log file. The
content of the log is in the expected log file, as controlled by the custom handler, and is formatted as
defined by the custom formatter. The warning message is filtered out, as specified by the configuration of
the custom filter. The output is as follows:

C:\>type MyOutputFile.log

Sat Sep 04 11:21:19 EDT 2004 INFO This is a test INFO message

Sat Sep 04 11:21:19 EDT 2004 SEVERE This is a test SEVERE message

Configuring applications to use Jakarta Commons Logging

Jakarta Commons Logging provides a simple logging interface and thin wrappers for several logging
systems. WebSphere Application Server supports Jakarta Commons Logging by providing a logger. The
support does not change interfaces defined by Jakarta Commons Logging.

The WebSphere Application Server logger is a thin wrapper for the WebSphere Application Server logging
facility. The logger name is com.ibm.websphere.commons.logging.WsJDK14Logger. The logger can handle
logging objects defined by either of the following:

« Java Logging found in [Java Specification Request 47: Logging API Specification|
+ [Common Base Event|
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A logging object is an object that holds logging entry information.

To better understand Jakarta Commons Logging, read[Jakarta Commons|and the specifications for Java
Logging and for Common Base Event. To better understand use of the WebSphere Application Server
logger, read [‘Jakarta Commons Logging.”]

WebSphere Application Server provides the Jakarta Commons Logging binary distribution in its T1ibraries
directory. By default, the product uses the Jakarta Commons Logging LogFactory implementation and
JDK14Logger.

For an application to use the WebSphere Application Server logger, the application must provide its own
configuration for the logger. To configure an application to use the WebSphere Application Server logger,
complete the steps that follow.

1. Examine [‘Configurations for the WebSphere Application Server logger” on page 40 and determine
which configuration best suits your application.

2. Change your application configuration as needed to enable use of the WebSphere Application Server
logger.

After the application starts, Jakarta Commons Logging routes the application’s logging output to the
WebSphere Application Server logger.

Jakarta Commons Logging

Jakarta Commons Logging provides a simple logging interface and thin wrappers for several logging
systems. The logging interface enables application logging to be simple and independent of the logging
system that the application uses. You can change the logging implementation for a deployed application
without having to change the application logging code. However, the simplicity of the logging interface
prevents the application from leveraging all the functionality of the logging systems.

This topic provides the following information about Jakarta Commons Logging in WebSphere Application
Server:

« [“Support for Jakarta Commons Logging’|

- [‘Benefits of support for Jakarta Commons Logging’]

« [‘Overview of the process for using Jakarta Commons Logging” on page 38|

« [‘Classes used to obtain a logger factory and logger” on page 38

* [“‘Logger level configuration and mapping” on page 39

Support for Jakarta Commons Logging

WebSphere Application Server supports [Jakarta Commons Logging| by providing a logger, a thin wrapper
for the WebSphere Application Server logging facility. The logger can handle both|Java Logging| (JSR-47)
and [Common Base Event logging objects. A logging object is an object that holds logging entry
information.

The WebSphere Application Server support for Jakarta Commons Logging does not change interfaces
defined by Jakarta Commons Logging.

Benefits of support for Jakarta Commons Logging

The WebSphere Application Server support for Jakarta Commons Logging provides the following benefits:
* WebSphere Application Server is pre-configured to use Jakarta Commons Logging.

All of the functionality of Jakarta Commons Logging is provided for any application or WebSphere
Application Server component. Logging calls are routed by default to the underlying WebSphere
Application Server logging facility.

* Alogger that uses the WebSphere Application Server logging facility.
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Applications and components can pass both Java Logging and Common Base Event logging objects to
the WebSphere Application Server logger without conversion to strings, providing applications with
enhanced logging. Further, Jakarta Commons Logging Logger levels are integrated into WebSphere
Application Server administrative facilities.

Overview of the process for using Jakarta Commons Logging

Logging with Jakarta Commons Logging consists of the steps that follow. |“Configurations for the|
|WebSphere Application Server logger” on page 40| provides details on configuring your application to use
the WebSphere Application Server logger.

1. Obtain an instance of a logger factory.

To obtain a logger factory, use Jakarta Commons Logging code. You can configure the code to meet
your needs. In WebSphere Application Server, Jakarta Commons Logging is configured by default to
instantiate the Jakarta Commons Logging default logger factory. Applications or WebSphere Application
Server components can provide their own configuration if they use a different logger factory
implementation. Applications can use more than one factory.

2. Obtain an instance of a logger.

To obtain a logger, use code implemented by a logger factory. Configuration of the code is
implementation specific.

The WebSphere Application Server logger implements the methods defined in the logging interface.
The logging methods take at least one argument, which can be any Java object. The WebSphere
Application Server logger, the WsJDK14Logger logger described in [‘Classes used to obtain a loggern
factory and logger,”| handles the following objects passed into the following logging methods:
CommonBaseEvent

Wrapped into CommonBaseEventLogRecord
CommonBaseEventLogRecord

Passed without change
LogRecord

Passed without change
Other objects

Converted to String

Applications or WebSphere Application Server components can provide their own configuration if they
use an implementation of a logger that is not specific to WebSphere Application Server. An application
must know what factory is being used in order to configure it.

3. Start your application. Jakarta Commons Logging routes the application’s logging output to the
designated logger

Classes used to obtain a logger factory and logger

Class name Description

LogFactory LogFactory is a Jakarta Commons Logging class that implements initialization logic. LogFactory
is an abstract class that every logger factory implementation has to extend. It provides static
methods for obtaining:

* An instance of a factory class

 Instances of a logger, using an instance of the factory class

LogFactory provides methods for obtaining instances of loggers, although these methods
delegate the logger instantiation and configuration to an instance of a logger factory class.

Logger factories, once instantiated, are cached on a per context class loader basis. The
instances in a cache can be released. This functionality is designed for platform container
implementations rather than for applications.

38  Troubleshooting and support



Class name

Description

LogFactorylmpl

LogFactorylmpl is a Jakarta Commons Logging concrete class that implements the default
logger factory using methods in LogFactory. To use Java Logging, there must always be at least
one instance of a logger factory class, even if the application has not explicitly obtained one. If
the configuration does not name a logger factory class, LogFactorylmpl is used as the default.

Log

Log is a Jakarta Commons Logging interface for loggers. Commons logging loggers have to
implement the Log interface. Because the goal of Jakarta Commons Logging is to wrapper any
logging system, the Log interface defines a small set of common logging methods. In
WebSphere Application Server, WsJDK14Logger implements the Log interface.

Logger instantiation and configuration is specific to every logger factory. Logging in WebSphere
Application Server uses the default logger factory provided in Jakarta Commons Logging, which
keeps instantiated loggers in cache, on a per class loader context basis.

WsJDK14Logger

WsJDK14Logger is a WebSphere Application Server class that provides a Jakarta Commons
Logging logger by implementing the Log interface. The WsJDK14Logger logger differs from the
Java Logging logger in that the WsJDK14Logger logger enables Java Logging or Common Base
Event objects to be passed over without converting them into String objects. This prevents any
information loss the conversion to String might cause as well as allows the logging output to be
more descriptive and precise. In contrast, the Java Logginglogger that is provided in Jakarta
Commons Logging converts objects passed into the logging calls to String objects before
passing them over to the underlying Java Logging.

Logger level configuration and mapping

Because Jakarta Commons Logging loggers are thin wrappers for specific logging systems, the loggers do
not have their own level, but use the level of the logger from the underlying logging system. Although the
underlying system can provide methods for changing level, there are no methods for changing level
defined on the Log interface, which all Jakarta Commons Logging logger must implement.
WsJDK14Logger uses the level of its underlying Java Logging logger.

Following table shows, on the left, the mapping of Jakarta Commons Logging levels within
WsJDK14Logger to levels in the WebSphere Application Server implementation of Java Logging. On the
right, it shows the levels defined in Java Logging and the level mapping in the Jakarta Commons Logging
JDK14Logger to the Java Logging levels.

Java Logging in WebSphere
WsJDK14Logger Application Server Java Logging JDK14Logger
Fatal Fatal
Error Severe Severe Fatal, Error
Warning Warning Warning Warning
Audit
Info Info Info Info
Config Config
Detail
Debug Fine Fine Debug
Finer Finer
Trace Finest Finest Trace

The WsJDK14Logger level is synchronized with the underlying Java Logging logger level. WebSphere
Application Server administration controls the WsJDK14Logger level.
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Configurations for the WebSphere Application Server logger
This topic describes several ways to configure an application to use the WebSphere Application Server

logger.

The type of configuration that best suits an application depends upon the following:

* Whether the class loader order setting for the application is Classes loaded with parent class Toader
first (Parent First) or Classes loaded with application class Toader first (Parent Last), you can
set the class loader delegation mode on a console page. For more details about class load order and
delegation, consult the class loading chapter in the Developing and deploying applications PDF book

* Whether Jakarta Commons Logging is bundled with the application configuration

* Whether Jakarta Commons Logging is provided within the application

The following tables describe the conditions required to enable an application to use the WebSphere

Application Server logger.

Class loader mode is Parent First and Jakarta Commons Logging is bundled with the application

Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

The application provides the
configuration by either of the
following:

» The properties file
commons-logging.properties in
the application classpath is not
read by the LogFactory
because the parent class
loader finds the WebSphere
properties file first.

* The class name is read from
the file

META-INF/services/
org.apache.commons
.logging.LogFactory

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration,
unless the
configuration is
provided in a
META-INF file of
the application or
module.

The log used is either
of the following:

* The Log
implementation
specified in the
WebSphere
Application Server
default configuration

* An application-
specific

Log implementation if
an application-specific
LogFactory that
instantiates a different
Log implementation is
used.

The application parent class loader
is the first class loader to load the
Jakarta Commons Logging code. The
WebSphere bundle that supports
Jakarta Commons Logging provides
the LogFactory static code that looks
up the LogFactory configuration
attributes.

For the static LogFactory code to
instantiate the LogFactory instance
specified in the application
configuration, the LogFactory instance
must be on the classpath of the parent
class loader.

Not provided by the application

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere default
configuration.

The log used is the
Log implementation
specified in the
WebSphere default
configuration.

The Jakarta Commons Logging
bundled with the application is not
used.

Class loader mode is Parent First and Jakarta Commons Logging is not bundled with the

application
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Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

The application provides the
configuration by either of the
following:

* The properties file
commons-1logging.properties in
the application classpath is not
read by the LogFactory
because the parent class
loader finds the WebSphere
Application Server properties
file first.

* The class name is read from
the file

META-INF/services/
org.apache.commons
.Togging.LogFactory

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration,
unless the
configuration is
provided in a
META-INF file of
the application or
module.

The log used is either
of the following:

* The Log
implementation
specified in the
WebSphere
Application Server
default configuration

* An
application-specific
Log implementation if
an application-specific
LogFactory that
instantiates a different
Log implementation is
used.

The application parent class loader
is the first class loader to load the
Jakarta Commons Logging code. The
WebSphere bundle that supports
Jakarta Commons Logging provides
the LogFactory static code that looks
up the LogFactory configuration
attributes.

For the static LogFactory code to
instantiate the LogFactory instance
specified in the application
configuration, the LogFactory instance
must be on the classpath of the parent
class loader.

Not provided by the application

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration.

The log used is the
Log implementation
specified in the
WebSphere
Application Server
default configuration.

Same as in the previous row

Class loader mode is Parent Last and Jakarta Commons Logging is bundled with the application

Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

The application provides the
configuration by either of the
following:

» The properties file
commons-1logging.properties in
the application classpath is
read by the LogFactory
because the parent class
loader finds the WebSphere
Application Server properties
file first.

* The class name is read from
the file

META-INF/services/
org.apache.commons
.Togging.LogFactory

The log factory
used is either of
the following:

* The default
Jakarta Commons
Logging
LogFactory

* The LogFactory
specified in the
application
configuration

The log used is the
Log implementation
specified in the
application
configuration.

If the log factory used
is the default Jakarta
Commons Logging
LogFactory, the Log
implementation must
be on the classpath
of the application
class loader.

The application class loader is the
first class loader to load the Jakarta
Commons Logging code. The
application bundle that supports
Jakarta Commons Logging provides
the LogFactory static code that looks
up the LogFactory configuration
attributes.

For the static LogFactory code to
instantiate the LogFactory instance
specified in the application
configuration, the LogFactory instance
must be on the classpath of the
application class loader.
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Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

Not provided by the application

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration.

The log used is the
Log implementation
specified in the
WebSphere
Application Server
default configuration.

Class loader mode is Parent Last and Jakarta Commons Logging

application

is not bundled with the

Jakarta Commons Logging
configuration

LogFactory
instance

Log instance

Comments

The application provides the
configuration by either of the
following:

» The properties file
commons-logging.properties in
the application classpath is
read by the LogFactory
because the parent class
loader finds the WebSphere
properties file first.

* The class name is read from
the file

META-INF/services/
org.apache.commons
.logging.LogFactory

The log factory
used is either of
the following:

* The default
Jakarta Commons
Logging
LogFactory

* The LogFactory
specified in the
application
configuration

The log used is the
Log implementation
specified in the
application
configuration.

If the log factory used
is the default Jakarta
Commons Logging
LogFactory, the Log
implementation must
be on the classpath
of the application
class loader.

There is no Jakarta Commons Logging
code at the application class loader.
Thus, the WebSphere bundle that
supports Jakarta Commons Logging
provides the LogFactory static code
that looks up the LogFactory
configuration attributes.

For the static LogFactory code to
instantiate the LogFactory instance
specified in the application
configuration, the LogFactory instance
must be on the classpath of the parent
class loader.

Not provided by the application

The log factory
used is the
LogFactory
implementation
specified in the
WebSphere
Application Server
default
configuration.

The log used is the
Log implementation
specified in the
WebSphere
Application Server
default configuration.

Programming with the JRas framework

Use the JRas extensions to incorporate message logging and diagnostic trace into WebSphere Application

Server applications.

The JRas framework that is described in this task and its sub-tasks is deprecated. However, you can
achieve similar results using Java logging.

The JRas extensions allow message logging and diagnostic trace to work with WebSphere Application
Server applications. They are based on the stand-alone JRas logging toolkit.

1. Retrieve a reference to the JRas manager.
2. Retrieve message and trace loggers by using methods on the returned manager.
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3. Call the appropriate methods on the returned message and trace loggers to create message and trace
entries, as appropriate.

JRas logging toolkit

The JRas logging toolkit provides diagnostic information to help the administrator diagnose problems or
tune application performance.

Deprecated: The JRas framework that is described in this task and its sub-tasks is deprecated. However,
you can achieve similar results using Java logging.

Developing, deploying, and maintaining applications are complex tasks. For example, when a running
application encounters an unexpected condition, it might not be able to complete a requested operation. In
such a case, you might want the application to inform the administrator that the operation failed and
provide information. This action enables the administrator to take the proper corrective action. Those who
develop or maintain applications might need to gather detailed information relating to the path of a running
application to determine the root cause of a failure that is due to a code bug. The facilities that are used
for these purposes are typically referred to as message logging and diagnostic trace.

Message logging (messages) and diagnostic trace (trace) are conceptually quite similar, but do have
important differences. It is important for application developers to understand these differences to use
these tools properly. To start with, the following operational definitions of messages and trace are provided.
Message
A message entry is an informational record that is intended for end users, systems administrators
and support personnel to view. The text of the message must be clear, concise, and interpretable.
Messages are typically localized, meaning that they display in the national language of the end
user. Although the destination and lifetime of messages might be configurable, some level of
message logging is always enabled in normal system operation. Message logging must be used
judiciously due to both performance considerations and the size of the message repository.

Trace A trace entry is an information record that is intended for service engineers or developers to use.
This trace record might be considerably more complex, verbose, and detailed than a message
entry. Localization support is typically not used for trace entries. Trace entries can be fairly
inscrutable, understandable only by the appropriate developer or service personnel. It is assumed
that trace entries are not written during normal runtime operation, but might be enabled as needed
to gather diagnostic information.

WebSphere Application Server provides a message logging and diagnostic trace API that applications can
use. This API is based on the stand-alone JRas logging toolkit, which was developed by IBM. The
stand-alone JRas logging toolkit is a collection of interfaces and classes that provide message logging and
diagnostic trace primitives. These primitives are not tied to any particular product or platform. The
stand-alone JRas logging toolkit provides a limited amount of support, which is typically referred to as
systems management support, including log file configuration support based on property files.

As designed, the stand-alone JRas logging toolkit does not contain the support that is required for
integration into the WebSphere Application Server run time or for use in a Java 2 Platform, Enterprise
Edition (J2EE) environment. To overcome these limitations, WebSphere Application Server provides a set
of extension classes to address these shortcomings. This collection of extension classes is referred to as
the JRas extensions. The JRas extensions do not modify the interfaces that are introduced by the
stand-alone JRas logging toolkit, but provide the appropriate implementation classes. The conceptual
structure that is introduced by the stand-alone JRas logging toolkit is described in the following section. It
is equally applicable to the JRas extensions.

JRas concepts

The section contains a basic overview of important concepts and constructs that are introduced by the
stand-alone JRas logging toolkit. This information is not an exhaustive overview of the capabilities of this
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logging toolkit, nor is it intended as a detailed discussion of usage or programming paradigms. More

detailed information, including code examples, is available in|[JRas extensions|and its subtopics, including

in the API documentation for the various interfaces and classes that make up the logging toolkit.

Event types
The stand-alone JRas logging toolkit defines a set of event types for messages and a set of event
types for trace. Examples of message types include informational, warning, and error. Examples of
trace types include entry, exit, and trace.

Event classes
The stand-alone JRas logging toolkit defines both message and trace event classes.

Loggers
A logger is the primary object with which the user code interacts. Two types of loggers are defined:
message loggers and trace loggers. The set of methods on message loggers and trace loggers
are different because they provide different functionality. Message loggers create message records
only and trace loggers create trace records only. Both types of loggers contain masks that indicate
which categories of events the logger processes and which to ignore. Although every JRas logger
is defined to contain both a message and trace mask, the message logger uses only the message
mask and the trace logger uses the trace mask only. For example, by setting a message logger
message mask to the appropriate state, it can be configured to process only error messages and
ignore informational and warning messages. Changing the trace mask state of a message logger
has no effect.

A logger contains one or more handlers to which it forwards events for further processing. When
the user calls a method on the logger, the logger compares the event type that is specified by the
caller to its current mask value. If the specified type passes the mask check, the logger creates an
event object to capture the information relating to the event that passed to the logger method. This
information can include information, such as the names of the class and method which logs the
event, a message, and parameters to log, among others. When the logger creates the event
object, it forwards the event to all handlers currently registered with the logger.

Methods that are used within the logging infrastructure do not make calls to the logger method.
When an application uses an object that extends a thread class, implements the hashCode
method, and makes a call to the logging infrastructure from that method, the result is a recursive
loop.

Handlers
A handler provides an abstraction over an output device or event consumer. An example is a file
handler, which knows how to write an event to a file. The handler also contains a mask that is
used to further restrict the categories of events the handler processes. For example, a message
logger might be configured to pass both warning and error events, but a handler attached to the
message logger might be configured to pass error events only. Handlers also include formatters,
which the handler invokes to format the data in the passed event before it is written to the output
device.

Formatters
Handlers are configured with formatters, which know how to format events of certain types. A
handler can contain multiple formatters, each of which knows how to format a specific class of
event. The event object is passed to the appropriate formatter by the handler. The formatter
returns formatted output to the handler, which then writes it to the output device.

JRas Extensions

JRas extensions is the collection of implementation classes that support JRas integration into the
WebSphere Application Server environment.

JRas extensions

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.
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The stand-alone JRas logging toolkit defines interfaces and provides a variety of concrete classes that
implement these interfaces. Because the stand-alone JRas logging toolkit is developed as a general
purpose toolkit, the implementation classes do not contain the configuration interfaces and methods that
are necessary for use in the WebSphere Application Server product. In addition, many of the
implementation classes are not written appropriately for use in a Java 2 Platform, Enterprise Edition
(J2EE) environment. To overcome these shortcomings, WebSphere Application Server provides the
appropriate implementation classes that support integration into the WebSphere Application Server
environment. The collection of these implementation classes is referred to as the JRas extensions.

Usage model

You can use the JRas extensions in three distinct operational modes:

Integrated
In this mode, message and trace records are written only to logs that are defined and maintained
by the WebSphere Application Server run time. This mode is the default mode of operation and is
equivalent to the WebSphere Application Server V4.0 mode of operation.

stand-alone
In this mode, message and trace records are written solely to stand-alone logs that are defined
and maintained by the user. You control which categories of events are written to which logs, and
the format in which entries are written. You are responsible for configuration and maintenance of
the logs. Message and trace entries are not written to WebSphere Application Server runtime logs.

Combined
In this mode, message and trace records are written to both WebSphere Application Server
runtime logs and to stand-alone logs that you must define, control, and maintain. You can use
filtering controls to determine which categories of messages and trace are written to which logs.

The JRas extensions are specifically targeted to an integrated mode of operation. The integrated mode of
operation can be appropriate for some usage scenarios, but many scenarios are not adequately addressed
by these extensions. Many usage scenarios require a stand-alone or combined mode of operation instead.
A set of user extension points are defined that support JRas extensions in either a stand-alone or
combined mode of operations.

JRas extension classes

WebSphere Application Server provides a base set of implementation classes that are collectively referred
to as the JRas extensions. Many of these classes provide the appropriate implementations of loggers,
handlers, and formatters for use in a WebSphere Application Server environment.

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

The collection of JRas classes is targeted at an integrated mode of operation. If you choose to use the
JRas extensions in either stand-alone or combined mode, you can reuse the logger and manager class
that are provided by the extensions, but you must provide your own implementations of handlers and
formatters.

WebSphere Application Server message and trace loggers

The message and trace loggers that are provided by the stand-alone JRas logging toolkit cannot be
directly used in the WebSphere Application Server environment. The JRas extensions provide the
appropriate logger implementation classes. Instances of these message and trace logger classes are
obtained directly and exclusively from the WebSphere Application Server Manager class. You cannot
directly instantiate message and trace loggers. Obtaining loggers in any manner other than directly from
the Manager class is not allowed and directly violates the programming model.

The message and trace logger instances that are obtained from the WebSphere Application Server
Manager class are subclasses of the RASMessagelLogger and RASTraceLogger classes that are provided
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by the stand-alone JRas logging toolkit. The RASMessagelogger and RASTracelLogger classes define the
set of methods that are directly available. Public methods that are introduced by the JRas extensions
logger subclasses cannot be called directly by user code because it is a violation of the programming
model.

Loggers are named objects and are identified by name. When the Manager class is called to obtain a
logger, the caller is required to specify a name for the logger. The Manager class maintains a
name-to-logger instance mapping. Only one instance of a named logger is ever created within the lifetime
of a process. The first call to the Manager class with a particular name results in the logger, which is
configured by the Manager class. The Manager class caches a reference to the instance, then returns it to
the caller. Subsequent calls to the Manager class that specify the same name result in a returned
reference to the cached logger. Separate namespaces are maintained for message and trace loggers. You
can use a single name obtain both a message logger and a trace logger from the Manager, without
ambiguity, and without causing a namespace collision.

In general, loggers have no predefined granularity or scope. A single logger can be used to instrument an

entire application. You might determine that having a logger per class is more effective, or the appropriate

granularity might be somewhere in between. Partitioning an application into logging domains is determined
by the application writer.

The WebSphere Application Server logger classes that are obtained from the Manager class are
thread-safe. Although the loggers provided as part of the stand-alone JRas logging toolkit implement the
serializable interface, loggers are not serializable. Loggers are stateful objects, tied to a Java virtual
machine instance and are not serializable. Attempting to serialize a logger is a violation of the
programming model.

Personal or individual logger subclasses are not supported in a WebSphere Application Server
environment.

WebSphere Application Server handlers

WebSphere Application Server provides the appropriate handler class that is used to write message and
trace events to the WebSphere Application Server run time logs. You cannot configure the WebSphere
Application Server handler to write to any other destination. The creation of a WebSphere Application
Server handler is a restricted operation and is not available to user code. Every logger that is obtained
from the Manager comes preconfigured with an instance of this handler already installed. You can remove
the WebSphere Application Server handler from a logger when you want to run in stand-alone mode.
When you remove it, you cannot add the WebSphere Application Server handler again to the logger from
which it is removed or any other logger. Also, you cannot directly call any method on the WebSphere
Application Server handler. Attempting to create an instance of the WebSphere Application Server handler,
to call methods on the WebSphere Application Server handler or to add a WebSphere Application Server
handler to a logger by user code is a violation of the programming model.

WebSphere Application Server formatters

The WebSphere Application Server handler comes preconfigured with the appropriate formatter for data
that is written to WebSphere Application Server logs. The creation of a WebSphere Application Server
formatter is a restricted operation and not available to user code. No mechanism exists that allows the
user to obtain a reference to a formatter installed in a WebSphere Application Server handler, or to change
the formatter a WebSphere Application Server handler is configured to use.

WebSphere Application Server manager
WebSphere Application Server provides a Manager class in the com.ibm.websphere.ras package. All
message and trace loggers must be obtained from this Manager class. A reference to the Manager class is

obtained by calling the static Manager.getManager method. Message loggers are obtained by calling the
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createRASMessagelLogger method on the Manager class. Trace loggers are obtained by calling the
createRASTraceLogger method on the Manager class.

The manager also supports a group abstraction that is useful when dealing with trace loggers. The group
abstraction supports multiple, unrelated trace loggers to register as part of a named entity called a group.
WebSphere Application Server provides the appropriate systems management facilities to manipulate the
trace setting of a group, similar to the way the trace settings of an individual trace logger work.

For example, suppose component A consists of 10 classes. Suppose each class is configured to use a
separate trace logger. All 10 trace loggers in the component are registered as members of the same
group, for example, Component_A_Group. You can turn on trace for a single class, or you can turn on
trace for all 10 classes in a single operation using the group name, if you want a component trace. Group
names are maintained within the namespace for trace loggers.

JRas framework (deprecated)

Because the JRas extensions classes do not provide the flexibility and behavior that are required for many
scenarios, a variety of extension points are defined. You can write your own implementation classes to
obtain the required behavior.

Deprecated: The JRas framework described in this topic is deprecated. However, you can achieve similar
results using Java logging.

In general, the JRas extensions require you to call the Manager class to obtain a message logger or trace
logger. No provision is made for you to provide your own message or trace logger subclasses. In general,
user-provided extensions cannot be used to affect the integrated mode of operation. The behavior of the
integrated mode of operation is solely determined by the WebSphere Application Server run time and the
JRas extensions classes.

Handlers

The stand-alone JRas logging toolkit defines the RASIHandler interface. All handlers must implement this
interface. You can write your own handler classes that implement the RASIHandler interface. Directly
create instances of user-defined handlers and add them to the loggers that are obtained from the Manager
class.

The stand-alone JRas logging toolkit provides several handler implementation classes. These handler
classes are inappropriate for use in the Java 2 Platform, Enterprise Edition (J2EE) environment. You
cannot directly use or subclass any of the Handler classes that are provided by the stand-alone JRas
logging toolkit. Doing so is a violation of the programming model.

Formatters

The stand-alone JRas logging toolkit defines the RASIFormatter interface. All formatters must implement
this interface. You can write your own formatter classes that implement the RASIFormatter interface. You
can add these classes to a user-defined handler only. WebSphere Application Server handlers cannot be
configured to use user-defined formatters. Instead, directly create instances of your formatters and add
them to the your handlers appropriately.

As with handlers, the stand-alone JRas logging toolkit provides several formatter implementation classes.
Direct use of these formatter classes is not supported.

Message event types
The stand-alone JRas toolkit defines message event types in the RASIMessageEvent interface. In
addition, the WebSphere Application Server reserves a range of message event types for future use. The

RASIMessageEvent interface defines three types, with values of 0x01, 0x02, and 0x04. The values 0x08
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through 0x8000 are reserved for future use. You can provide your own message event types by extending
this interface appropriately. User-defined message types must have a value of 0x1000 or greater.

Message loggers that are retrieved from the Manager class have their message masks set to pass or
process all message event types defined in the RASIMessageEvent interface. To process user-defined
message types, you must manually set the message logger mask to the appropriate state by user code
after the message logger is obtained from the Manager class. WebSphere Application Server does not
provide any built-in systems management support for managing message types.

Message event objects

The stand-alone JRas toolkit provides a RASMessageEvent implementation class. When a message
logging method is called on the message logger, and the message type is currently enabled, the logger
creates and distributes an event of this class to all handlers that are currently registered with that logger.

You can provide your own message event classes, but they must implement the RASIEvent interface. You
must directly create instances of such user-defined message event classes. When it is created, pass your
message event to the message logger by calling the message logger’s fireRASEvent method directly.
WebSphere Application Server message loggers cannot directly create instances of user-defined types in
response to calling a logging method (msg.message) on the logger. In addition, instances of user-defined
message types are never processed by the WebSphere Application Server handler. You cannot create
instances of the RASMessageEvent class directly.

Trace event types

The stand-alone JRas toolkit defines trace event types in the RASITraceEvent interface. You can provide
your own trace event types by extending this interface appropriately. In such a case, you must ensure that
the values for the user-defined trace event types do not collide with the values of the types that are
defined in the RASITraceEvent interface.

Trace loggers that are retrieved from the Manager class typically have their trace masks set to reject all
types. A different starting state can be specified by using WebSphere Application Server systems
management facilities. In addition, you can change the state of the trace mask for a logger at run-time,
using WebSphere Application Server systems management facilities.

To process user-defined trace types, the trace logger mask must be manually set to the appropriate state
by user code. WebSphere Application Server systems management facilities cannot be used to manage
user-defined trace types, either at start time or run time.

Trace event objects

The stand-alone JRas toolkit provides a RASTraceEvent implementation class. When a trace logging
method is called on the WebSphere Application Server trace logger and the type is currently enabled, the
logger creates and distributes an event of this class to all the handlers that are currently registered with
that logger.

You can provide your own trace event classes. Such trace event classes must implement the RASIEvent
interface. You must create instances of such user-defined event classes directly. When it is created, pass
the trace event to the trace logger by calling the trace logger’s fireRASEvent method directly. WebSphere
Application Server trace loggers cannot directly create instances of user-defined types in response to
calling a trace method (entry, exit, trace) on the trace logger. In addition, instances of user-defined trace
types are never processed by the WebSphere Application Server handler. You cannot create instances of
the RASTraceEvent class directly.
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User defined types, user defined events and WebSphere Application Server

By definition, the WebSphere Application Server handler processed user-defined message or trace types,
or user-defined message or trace event classes. Message and trace entries of either a user-defined type
or user-defined event class cannot be written to the WebSphere Application Server run-time logs.

JRas programming interfaces for logging (deprecated):

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

General considerations

You can configure the WebSphere Application Server to use Java 2 security to restrict access to protected
resources such as the file system and sockets. Because user-written extensions typically access such
protected resources, user-written extensions must contain the appropriate security checking calls, using
AccessController doPrivileged calls. In addition, the user-written extensions must contain the appropriate
policy file. In general, locating user-written extensions in a separate package is a good practice. It is your
responsibility to restrict access to the user-written extensions appropriately.

Writing a handler

User-written handlers must implement the RASIHandler interface. The RASIHandler interface extends the
RASIMaskChangeGenerator interface, which extends the RASIObject interface. A short discussion of the
methods that are introduced by each of these interfaces follows, along with implementation pointers. For
more in-depth information on any of the particular interfaces or methods, see the corresponding product
API documentation.

RASIObiject interface

The RASIObject interface is the base interface for stand-alone JRas logging toolkit classes that are

stateful or configurable, such as loggers, handlers, and formatters.

* The stand-alone JRas logging tookit supports rudimentary properties-file based configuration. To
implement this configuration support, the configuration state is stored as a set of key-value pairs in a
properties file. The public Hashtable getConfig and public void setConfig(Hashtable ht) methods are
used to get and set the configuration state. The JRas extensions do not support properties-based
configuration. Implement these methods as no-operations. You can implement your own
properties-based configuration using these methods.

» Loggers, handlers, and formatters can be named objects. For example, the JRas extensions require the
user to provide a name for the loggers that are retrieved from the manager. You can name your
handlers. The public String getName and public void setName(String name) methods are provided to
get or set the name field. The JRas extensions currently do not call these methods on user handlers.
You can implement these methods as you want, including as no operations.

* Loggers, handlers, and formatters can also contain a description field. The public String getDescription
and public void setDescription(String desc) methods can be used to get or set the description field. The
JRas extensions currently do not use the description field. You can implement these methods as you
want, including as no operations.

» The public String getGroup method is provided for use by the RASManager interface. Since the JRas
extensions provide their own Manager class, this method is never called. Implement this as a
no-operation.

RASIMaskChangeGenerator interface
The RASIMaskChangeGenerator interface is the interface that defines the implementation methods for

filtering of events based on a mask state. It is currently implemented by both loggers and handlers. By
definition, an object that implements this interface contains both a message mask and a trace mask,
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although both need not be used. For example, message loggers contain a trace mask, but the trace mask

is never used because the message logger never generates trace events. Handlers, however, can actively

use both mask values. For example, a single handler can handle both message and trace events.

* The public long getMessageMask and public void setMessageMask(long mask) methods are used to
get or set the value of the message mask. The public long getTraceMask and public void
setTraceMask(long mask) methods are used to get or set the value of the trace mask.

In addition, this interface introduces the concept of calling back to interested parties when a mask changes

state. The callback object must implement the RASIMaskChangeListener interface.

* The public void addMaskChangeListener(RASIMaskChangeListener listener) and public void
removeMaskChangeListener(RASIMaskChangeListener listener) methods are used to add or remove
listeners to the handler. The public Enumeration getMaskChangeListeners method returns an
enumeration over the list of currently registered listeners. The public void
fireMaskChangedEvent(RASMaskChangeEvent mc) method is used to call back all the registered
listeners to inform them of a mask change event.

For efficiency reasons, the JRas extensions message and trace loggers implement the
RASIMaskChangeListener interface. The logger implementations maintain a composite mask in addition to
the logger mask. The logger composite mask is formed by logically or’ing the appropriate masks of all
handlers that are registered to that logger, then and’ing the result with the logger mask. For example, the
message logger composite mask is formed by or’ing the message masks of all handlers that are registered
with that logger, then and’ing the result with the logger message mask.

All handlers are required to properly implement these methods. In addition, when a user handler is
instantiated, the logger that is added must be registered with the handler; use the addMaskChangeListener
method. When either the message mask or trace mask of the handler is changed, the logger must be
called back to inform it of the mask change. With this process, the logger can dynamically maintain the
composite mask.

The RASMaskChangedEvent class is defined by the stand-alone JRas logging toolkit. Direct use of that
class by user code is supported in this context.

In addition, the RASIMaskChangeGenerator interface introduces the concept of caching the names of all
message and trace event classes that the implementing object process. The intent of these methods is to
support a management program such as a graphical user interface to retrieve the list of names, introspect
the classes to determine the event types that they might possibly process and display the results. The
JRas extensions do not ever call these methods, so they can be implemented as no operations.

* The public void addMessageEventClass(String name) and public void
removeMessageEventClass(String name) methodscan be called to add or remove a message event
class name from the list. The method public Enumeration getMessageEventClasses returns an
enumeration over the list of message event class names. Similarly, the public void
addTraceEventClass(String name) and public void removeTraceEventClass(String name) methods can
be called to add or remove a trace event class name from the list. The public Enumeration
getTraceEventClasses method returns an enumeration over the list of trace event class names.

RASIHandler interface

The RASIHandler interface introduces the methods that are specific to the behavior of a handler.

The RASIHandler interface, as provided by the stand-alone JRas logging toolkit, supports handlers that
run in either a synchronous or asynchronous mode. In asynchronous mode, events are typically queued by
the calling thread and then written by a worker thread. Because spawning of threads is not supported in

the WebSphere Application Server environment, it is expected that handlers do not queue or batch events,
although this activity is not expressly prohibited.
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* The public int getMaximumQueueSize() and public void setMaximumQueueSize(int size) methods
create I11egalStateException exceptions to manage the maximum queue size. The public int
getQueueSize method is provided to query the actual queue size.

* The public int getRetrylnterval and public void setRetryInterval(int interval) methods support the notion
of error retry, which implies some type of queueing.

» The public void addFormatter(RASIFormatter formatter), public void removeFormatter(RASIFormatter
formatter) and public Enumeration getFormatters methods are provided to manage the list of formatters
that the handler can be configured with. Different formatters can be provided for different event classes,
if appropriate.

* The public void openDevice, public void closeDevice and public void stop methods are provided to
manage the underlying device that the handler abstracts.

* The public void logEvent(RASIEvent event) and public void writeEvent(RASIEvent event) methods are
provided to pass events to the handler for processing.

Writing a formatter

User-written formatters must implement the RASIFormatter interface. The RASIFormatter interface extends
the RASIObject interface. The implementation of the RASIObject interface is the same for both handlers
and formatters. A short discussion of the methods that are introduced by the RASIFormatter interface
follows. For more in-depth information on the methods introduced by this interface, see the corresponding
product APl documentation.

RASIFormatter interface

» The public void setDefault(boolean flag) and public boolean isDefault methods are used by the concrete
RASHandler classes that are provided by the stand-alone JRas logging toolkit to determine if a
particular formatter is the default formatter. Because these RASHandler classes must never be used in
a WebSphere Application Server environment, the semantic significance of these methods can be
determined by the user.

» The public void addEventClass(String name), public void removeEventClass(String name) and public
Enumeration getEventClasses methods are provided to determine which event classes a formatter can
use to format. You can provide the appropriate implementations.

» The public String format(RASIEvent event) method is called by handler objects and returns a formatted
String representation of the event.

Programming model summary

The programming model that is described in this section builds upon and summarizes some of the
concepts already introduced. This section also formalizes usage requirements and restrictions. Use of the
WebSphere Application Server JRas extensions in a manner that does not conform to the following
programming guidelines is prohibited.

Deprecated: The JRas framework described in this task and its sub-tasks is deprecated. However, you
can achieve similar results using Java logging.

You can use the WebSphere Application Server JRas extensions in three distinct operational modes. The

programming models concepts and restrictions apply equally across all modes of operation.

* You must not use implementation classes that are provided by the stand-alone JRas logging toolkit
directly, unless specifically noted otherwise. Direct usage of those classes is not supported. IBM
Support provides no diagnostic aid or bug fixes relating to the direct use of classes that are provided by
the stand-alone JRas logging toolkit.

* You must obtain message and trace loggers directly from the Manager class. You cannot directly
instantiate loggers.

* You cannot replace the WebSphere Application Server message and trace logger classes.

* You must guarantee that the logger names that are passed to the Manager class are unique, and follow
the documented naming constraints. When a logger is obtained from the Manager class, you must not
attempt to change the name of the logger by calling the setName method.
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* Named loggers can be used more than once. For any given name, the first call to the Manager class
results in the Manager class creating a logger that is associated with that name. Subsequent calls to the
Manager class that specify the same name result in a returned reference to the existing logger.

» The Manager class maintains a hierarchical namespace for loggers. Use a dot-separated, fully qualified
class name to identify any logger. Other than dots or periods, logger names cannot contain any
punctuation characters, such as an asterisk (*), a comma (.), an equals sign (=), a colon (:), or quotes.

* Group names must comply with the same naming restrictions as logger names.

* The loggers returned from the Manager class are subclasses of the RASMessagelLogger and the
RASTracelLogger classes that are provided by the stand-alone JRas logging toolkit. You can call any
public method that is defined by the RASMessagelLogger and RASTracelLogger classes. You cannot call
any public method that is introduced by the provided subclasses.

» If you want to operate in either stand-alone or combined mode, you must provide your own Handler
and Formatter subclasses. You cannot use the Handler and Formatter classes that are provided by the
stand-alone JRas logging toolkit. User written handlers and formatters must conform to the documented
guidelines.

* Loggers that are obtained from the Manager class come with a WebSphere Application Server handler
installed. This handler writes message and trace records to logs that are defined by the WebSphere
Application Server run time. Manage these logs using the provided systems management interfaces.

* You can programmatically add and remove user-defined handlers from a logger at any time. Multiple
additions and removals of user defined handlers are supported. You are responsible for creating an
instance of the handler to add, configuring the handler by setting the handler mask value and formatter
appropriately, then adding the handler to the logger using the addHandler method. You are responsible
for programmatically updating the masks of user-defined handlers, as appropriate.

*  You might get a reference to the handler that is installed within a logger by calling the getHandlers
method on the logger and processing the results. You must not call any methods on the handler that are
obtained in this way. You can remove the WebSphere Application Server handler from the logger by
calling the logger removeHandler method, passing in the reference to the WebSphere Application
Server handler. When removed, the WebSphere Application Server handler cannot be added again to
the logger.

*  You can define your own message type. The behavior of user-defined message types and restrictions
on their definitions is discussed in [Extending the JRas framework|

*  You can define your own message event classes. The use of user-defined message event classes is
discussed in [Extending the JRas framework|

*  You can define your own trace types. The behavior of user-defined trace types and restrictions on your
definitions is discussed in [Extending the JRas framework.

* You can define your own trace event classes. The use of user-defined trace event classes is discussed
in [Extending the JRas frameworkl

* You must programmatically maintain the bits in the message and trace logger masks that correspond to
any user-defined types. If WebSphere Application Server facilities are used to manage the predefined
types, these updates must not modify the state of any of the bits that correspond to those types. If you
are assuming ownership responsibility for the predefined types, then you can change all bits of the
masks.

JRas messages and trace event types
This topic describes JRas message and trace event types.

Event types

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

The base message and trace event types that are defined by the stand-alone JRas logging toolkit are not
the same as the native types that are recognized by the WebSphere Application Server run-time. Instead,
the basic JRas types are mapped onto the native types. This mapping can vary by platform or edition. The
mapping is discussed in the following section.
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Platform message event types

The message event types that are recognized and processed by the WebSphere Application Server
runtime are defined in the RASIMessageEvent interface that is provided by the stand-alone JRas logging
toolkit. These message types are mapped onto the native message types, as follows.

WebSphere Application Server native type JRas RASIMessageEvent type
Audit TYPE_INFO, TYPE_INFORMATION
Warning TYPE_WARN, TYPE_WARNING
Error TYPE_ERR, TYPE_ERROR

Platform trace event types

The trace event types that are recognized and processed by the WebSphere Application Server run time
are defined in the RASITraceEvent interface that is provided by the stand-alone JRas logging toolkit. The
RASITraceEvent interface provides a rich and complex set of types. This interface defines both a simple
set of levels, as well as a set of enumerated types.

» For a user who prefers a simple set of levels, the RASITraceEvent interface provides TYPE_LEVELI,
TYPE _LEVEL2, and TYPE_LEVEL3. The implementations provide support for this set of levels. The levels
are hierarchical, enabling level 2 also enables level 1, enabling level 3 also enables levels 1 and 2.

» For users who prefer a more complex set of values that can be OR’d together, the RASITraceEvent
interface provides TYPE_API, TYPE CALLBACK, TYPE_ENTRY_EXIT, TYPE _ERROR EXC, TYPE MISC DATA,
TYPE_OBJ_CREATE, TYPE_OBJ DELETE, TYPE_PRIVATE, TYPE PUBLIC, TYPE_STATIC, and TYPE_SVC.

The trace event types are mapped onto the native trace types as follows:

Mapping WebSphere Application Server trace types to the JRas RASITraceEvent level types.

WebSphere Application Server native type JRas RASITraceEvent level type
Event TYPE_LEVELA
EntryExit TYPE_LEVEL2
Debug TYPE_LEVEL3

Mapping WebSphere Application Server trace types to the JRas RASITraceEvent enumerated types.

WebSphere Application Server native type JRas RASITraceEvent enumerated types

Event TYPE_ERROR_EXC, TYPE_SVC, TYPE_OBJ_CREATE,
TYPE_OBJ_DELETE

EntryExit TYPE_ENTRY_EXIT, TYPE_API, TYPE_CALLBACK,
TYPE_PRIVATE, TYPE_PUBLIC, TYPE_STATIC

Debug TYPE_MISC_DATA

For simplicity, it is recommended that one or the other of the tracing type methodologies is used
consistently throughout the application. If you decide to use the non-level types, choose one type from
each category and use those types consistently throughout the application, to avoid confusion.

Message and trace parameters
The various message logging and trace method signatures accept the Object, Object[] and Throwable

parameter types. WebSphere Application Server processes and formats the various parameter types as
follows:
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Primitives

Primitives, such as int and long are not recognized as subclasses of Object type and cannot be

directly passed to one of these methods. A primitive value must be transformed to a proper Object

type (Integer, Long) before passing as a parameter.
Object

The toString method is called on the object and the resulting String is displayed. Implement the

toString method appropriately for any object that is passed to a message logging or trace method.

It is the responsibility of the caller to guarantee that the toString method does not display

confidential data such as passwords in clear text, and does not cause infinite recursion.

Object[]

The Object[] type is provided for the case when more than one parameter is passed to a message

logging or trace method. The toString method is called on each Object in the array. Nested arrays

are not handled, that is none of the elements in the Object array belong in an array.
Throwable

The stack trace of the Throwable type is retrieved and displayed.
Array of primitives

An array of primitive, for example, byte[], int[], is recognized as an Object, but is treated

somewhat as a second cousin of Object by Java code. In general, avoid arrays of primitives, if

possible. If arrays of primitives are passed, the results are indeterminate and can change,
depending on the type of array passed, the API used to pass the array, and the release of the
product. For consistent results, user code needs to preprocess and format the primitive array into
some type of String form before passing it to the method. If such preprocessing is not performed,
the following problems can result:

» [B@924586a0b - This message is deciphered as a byte array at location X. This message is
typically returned when an array is passed as a member of an Object[] type and results from
calling the toString method on the byte][] type.

 lllegal trace argument : array of long. This response is typically returned when an array of
primitives is passed to a method taking an Object.

* 01040703: The hex representation of an array of bytes. Typically this problem can occur when a
byte array is passed to a method taking a single Object. This behavior is subject to change and
cannot be relied on.

+ 1" "2": The String representation of the members of an int[] type formed by converting each
element to an integer and calling the toString method on the integers. This behavior is subject
to change and cannot be relied on.

» [Ljava.lang.Object; @9136fa0b : An array of objects. Typically this response is seen when an
array containing nested arrays is passed.

Controlling message logging

Writing a message to a WebSphere Application Server log requires that the message type passes three

levels of filtering or screening:

1. The message event type must be one of the message event types that is defined in the
RASIMessageEvent interface.

2. Logging of that message event type must be enabled by the state of the message logger mask.

3. The message event type must pass any filtering criteria that is established by the WebSphere
Application Server run-time.

When a WebSphere Application Server logger is obtained from the Manager class, the initial setting of the
mask forwards all native message event types to the WebSphere Application Server handler. It is possible
to control what messages get logged by programmatically setting the state of the message logger mask.

Some editions of the product support user specified message filter levels for a server process. When such
a filter level is set, only messages at the specified severity levels are written to WebSphere Application
Server. Message types that pass the mask check of the message logger can be filtered out by WebSphere
Application Server.
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Control tracing

Each edition of the product provides a mechanism for enabling or disabling trace. The various editions can
support static trace enablement (trace settings are specified before the server is started), dynamic trace
enablement (trace settings for a running server process can be dynamically modified), or both.

Writing a trace record to a WebSphere Application Server requires that the trace type passes three levels

of filtering or screening:

1. The trace event type must be one of the trace event types that is defined in the RASITraceEvent
interface.

2. Logging of that trace event type must be enabled by the state of the trace logger mask.

3. The trace event type must pass any filtering criteria that is established by the WebSphere Application
Server run-time.

When a logger is obtained from the Manager class, the initial setting of the mask is to suppress all trace
types. The exception to this rule is the case where the WebSphere Application Server run time supports
static trace enablement and a non-default startup trace state for that trace logger is specified. Unlike
message loggers, the WebSphere Application Server can dynamically modify the trace mask state of a
trace logger. WebSphere Application Server only modifies the portion of the trace logger mask that
corresponds to the values that are defined in the RASITraceEvent interface. WebSphere Application
Server does not modify undefined bits of the mask that might be in use for user-defined types.

When the dynamic trace enablement feature that is available on some platforms is used, the trace state
change is reflected both in the application server run time and the trace mask of the trace logger. If user
code programmatically changes the bits in the trace mask corresponding to the values that are defined by
in the RASITraceEvent interface, the mask state of the trace logger and the run time state become
unsynchronized and unexpected results occur. Therefore, programmatically changing the bits of the mask
corresponding to the values that are defined in the RASITraceEvent interface is not supported.

Instrumenting an application with JRas extensions
You can create an application using JRas extensions.

The JRas framework that is described in this task and its sub-tasks is deprecated. However, you can
achieve similar results using Java logging.

To create an application using the WebSphere Application Server JRas extensions, perform the following
steps:

1. Determine the mode for the extensions: integrated, stand-alone, or combined.

2. If the extensions are used in either stand-alone or combined mode, create the necessary handler and
formatter classes.

3. If localized messages are used by the application, create a resource bundle.

4. In the application code, get a reference to the Manager class and create the manager and logger
instances.

5. Insert the appropriate message and trace logging statements in the application.

Creating JRas resource bundles and message files

The WebSphere Application Server message logger provides the message and msg methods so the user
can log localized messages. In addition, the message logger provides the textMessage method to log
messages that are not localized. Applications can use either or both, as appropriate.

The JRas framework that is described in this task and its sub-tasks is deprecated. However, you can
achieve similar results using Java logging.
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The mechanism for providing localized messages is the resource bundle support that is provided by the
IBM Developer Kit, Java Technology Edition. If you are not familiar with resource bundles as implemented
by the Developer Kit, you can get more information from various texts, or by reading the API
documentation for the java.util. ResourceBundle, java.util.ListResourceBundle and
java.util.PropertyResourceBundle classes, as well as the java.text. MessageFormat class.

The PropertyResourceBundle class is the preferred mechanism to use. In addition, note that the JRas
extensions do not support the extended formatting options such as {1, date} or {0, number, integer} that
are provided by the MessageFormat class.

You can forward messages that are written to the internal WebSphere Application Server logs to other
processes for display. For example, messages that are displayed on the administrative console, which can
be running in a different location than the server process, can be localized using the /ate binding process.
Late binding means that WebSphere Application Server does not localize messages when they are logged,
but defers localization to the process that displays the message.

To properly localize the message, the displaying process must have access to the resource bundle where
the message text is stored. You must package the resource bundle separately from the application, and
install it in a location where the viewing process can access it. If you do not want to take these steps, you
can use the early binding technique to localize messages as they are logged.

The two techniques are described as follows:

Early binding
The application must localize the message before logging it. The application looks up the localized
text in the resource bundle and formats the message. When formatting is complete, the application
logs the message using the textMessage method. Use this technique to package the application
resource bundles with the application.

Late binding
The application can choose to have the WebSphere Application Server run time localize the
message in the process where it displays. Using this technique, the resource bundles are
packaged in a stand-alone . jar file, separately from the application. You must then install the
resource bundle . jar file on every machine in the installation from which an administrative console
or log viewing program might be run. You must install the .jar file in a directory that is part of the
extensions class path. In addition, if you forward logs to IBM service, you must also forward the
.jar file that contains the resource bundles.

To create a resource bundle, perform the following steps.

1. Create a text properties file that lists message keys and the corresponding messages. The properties
file must have the following characteristics:

» Each property in the file is terminated with a line-termination character.

* If a line contains only white space, or if the first non-white space character of the line is the number
sign symbol (#) or exclamation mark (!), the line is ignored. The # and ! characters can therefore be
used to put comments into the file.

* Each line in the file, unless it is a comment or consists only of white space, denotes a single
property. A backslash (\) is treated as the line-continuation character.

* The syntax for a property file consists of a key, a separator, and an element. Valid separators
include the equal sign (=), colon (:), and white space ().

* The key consists of all characters on the line from the first non-white space character to the first
separator. Separator characters can be included in the key by escaping them with a backslash (\),
but using this approach is not recommended because escaping characters is error prone and
confusing. Instead, use a valid separator character that does not display in any keys in the
properties file.

* White space after the key and separator is ignored until the first non-white space character is
encountered. All characters that remain before the line-termination character define the element.
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See the Java documentation for the java.util.Properties class for a full description of the syntax and
construction of properties files.

2. Translate the file into localized versions of the file with language-specific file names for example, the
DefaultMessages.properties file can be translated into DefaultMessages de.properties for German
and DefaultMessages ja.properties for Japanese.

3. When the translated resource bundles are available, write them to a system-managed persistent
storage medium. Resource bundles are used to convert the messages into the requested national
language and locale.

4. When a message logger is obtained from the JRas manager, configure the logger to use a particular
resource bundle. Messages logged through the message API use this resource bundle when message
localization is performed. At run time, the user’s locale setting is used to determine the properties file
from which to extract the message that is specified by a message key, ensuring that the message is
delivered in the correct language.

5. If the message loggers msg method is called, explicitly identify a resource bundle name.

The application locates the resource bundle based on the file location relative to any directory in the class
path. For instance, if the DefaultMessages.properties property resource bundle is in the
baseDir/subDirl/subDir2/resources directory and baseDir is in the class path, the name
subdiri.subdir2.resources.DefaultMessage is passed to the message logger to identify the resource
bundle.

JRas resource bundles:

You can create resource bundles in several ways. The best and easiest way is to create a properties file
that supports a PropertiesResourceBundle resource bundle. This sample shows how to create such a
properties file.

Resource bundle sample

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

For this sample, four localizable messages are provided. The properties file is created and the key-value
pairs are inserted into it. All the normal properties files conventions and rules apply to this file. In addition,
the creator must be aware of other restrictions that are imposed on the values by the Java
MessageFormat class. For example, apostrophes must be escaped or they cause a problem. Avoid the
use of non-portable characters. WebSphere Application Server does not support the use of extended
formatting conventions that the MessageFormat class supports, such as {1, date} or {0, number, integer}.

Assume that the base directory for the application that uses this resource bundle is baseDir and that this
directory is in the class path. Assume that the properties file is stored in the subdirectory baseDir that is
not in the class path (baseDir/subDir1/subDir2/resources). To allow the messages file to resolve, the
subDir1.subDir2.resources.DefaultMessage name is used to identify the PropertyResourceBundle resource
bundle and is passed to the message logger.

For this sample, the properties file is named DefaultMessages.properties:

# Contents of the DefaultMessages.properties file

MSG_KEY_00=A message with no substitution parameters.

MSG_KEY_01=A message with one substitution parameter: parml={0}

MSG_KEY_02=A message with two substitution parameters: parml={0}, parm2 = {1}
MSG_KEY_03=A message with three substitution parameters: parml={0}, parm2 = {1}, parm3={2}

When the DefaultMessages.properties file is created, the file can be sent to a translation center where
the localized versions are generated.
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JRas manager and logger instances

You can use the JRas extensions in integrated, stand-alone, or combined mode. Configuration of the
application varies depending on the mode of operation, but use of the loggers to log message or trace
entries is identical in all modes of operation.

Deprecated: The JRas framework described in this task and its sub-tasks is deprecated. However, you
can achieve similar results using Java logging.

Integrated mode is the default mode of operation. In this mode, message and trace events are sent to the
WebSphere Application Server logs.

In the combined mode, message and trace events are logged to both WebSphere Application Server and
user-defined logs.

In the stand-alone mode, message and trace events are logged only to user-defined logs.
Using the message and trace loggers

Regardless of the mode of operation, the use of message and trace loggers is the same.
Using a message logger

The message logger is configured to use the DefaultMessages resource bundle. Message keys must be
passed to the message loggers if the loggers are using the message API.

msgLogger.message (RASIMessageEvent.TYPE_WARNING, this,
methodName, "MSG_KEY_00");
. msgLogger.message (RASIMessageEvent.TYPE_WARN, this,
methodName, "MSG_KEY 01", "some string");

If message loggers use the msg API, you can specify a new resource bundle name.

msgLogger.msg(RASIMessageEvent.TYPE_ERR, this, methodName,
"ALT_MSG_KEY_00", "alternateMessageFile");

You can also log a text message. If you are using the textMessage API, no message formatting is done.

msgLogger.textMessage (RASIMessageEvent.TYPE_INFO, this, methodName,"String and Integer",
"A String", new Integer(5));

Using a trace logger

Because trace is normally disabled, guard trace methods for performance reasons.
private void methodX(int x, String y, Foo z)

{
// trace an entry point. Use the guard to make sure tracing is enabled.
Do this checking before you gather parameters to trace.
if (trcLogger.isLoggable(RASITraceEvent.TYPE_ENTRY_EXIT) {
// 1 want to trace three parameters, package them up in an Object[]
Object[] parms = {new Integer(x), y, z};
trcLogger.entry(RASITraceEvent.TYPE_ENTRY_EXIT, this, "methodX", parms);
}
. logic
// a debug or verbose trace point
if (trcLogger.isLoggable(RASITraceEvent.TYPE MISC DATA) {
trcLogger.trace(RASITraceEvent.TYPE_MISC_DATA, this, "methodX" "reached here");
}

// Another classification of trace event. An important state change is
detected, so a different trace type is used.
if (trcLogger.isLoggable(RASITraceEvent.TYPE_SVC) {
trcLogger.trace(RASITraceEvent.TYPE_SVC, this, "methodX", "an important event");
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}

// ready to exit method, trace. No return value to trace
if (trcLogger.isLoggable(RASITraceEvent.TYPE_ENTRY_EXIT)) {
trcLogger.exit(RASITraceEvent.TYPE_ENTRY_EXIT, this, "methodX");
1

}

Setting up for integrated JRas operation
Use JRas operations in integrated mode to send trace events and logging messages to only WebSphere
Application Server logs.

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

In the integrated mode of operation, message and trace events are sent to WebSphere Application Server
logs. This approach is the default mode of operation.
1. Import the requisite JRas extensions classes:
import com.ibm.ras.*;
import com.ibm.websphere.ras.x*;
2. Declare logger references:

private RASMessagelogger msglLogger = null;
private RASTracelLogger trcLogger = null;

3. Obtain a reference to the Manager class and create the loggers. Because loggers are named
singletons, you can do this activity in a variety of places. One logical candidate for enterprise beans is
the ejbCreate method. For example, for the myTestBean enterprise bean, place the following code in
the ejbCreate method:
com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();

msglLogger = mgr.createRASMessagelLogger("Acme", "WidgetCounter", "RasTest",
myTestBean.class.getName());

// Configure the message logger to use the message file that is created

// for this application.

msgLogger.setMessageFile("acme.widgets.DefaultMessages");

trcLogger = mgr.createRASTracelLogger("Acme", "Widgets", "RasTest",
myTestBean.class.getName());

mgr.addLoggerToGroup (trcLogger, groupName);

Setting up for combined JRas operation
Use JRas operation in combined mode to output trace data and logging messages to both WebSphere
Application Server and user-defined logs.

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

In combined mode, messages and trace are logged to both WebSphere Application Server logs and
user-defined logs. The following sample assumes that:

* You wrote a user-defined handler named SimpleFileHandler and a user-defined formatter named
SimpleFormatter.

* You are not using user-defined types or events.
1. Import the requisite JRas extensions classes:

import com.ibm.ras.*;
import com.ibm.websphere.ras.=*;

2. Import the user handler and formatter:

import com.ibm.ws.ras.test.user.*;
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3. Declare the logger references:

private RASMessagelogger msglLogger = null;
private RASTracelLogger trcLogger = null;

4. Obtain a reference to the Manager class, create the loggers, and add the user handlers. Because
loggers are named singletons, you can obtain a reference to the loggers in a number of places. One
logical candidate for enterprise beans is the ejbCreate method. Make sure that multiple instances of
the same user handler are not accidentally inserted into the same logger. Your initialization code must
support this approach. The following sample is a message logger sample. The procedure for a trace
logger is similar.
com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();

msglLogger = mgr.createRASMessagelLogger("Acme", "WidgetCounter", "RasTest",
myTestBean.class.getName());
// Configure the message logger to use the message file defined

// in the ResourceBundle sample.
msgLogger.setMessageFile("acme.widgets.DefaultMessages");

// Create the user handler and formatter. Configure the formatter,

// then add it to the handler.

RASIHandler handler = new SimpleFileHandler("myHandler", "FileName");
RASIFormatter formatter = new SimpleFormatter("simple formatter");
formatter.addEventClass("com.ibm.ras.RASMessageEvent");
handler.addFormatter(formatter);

// Add the Handler to the logger. Add the Togger to the Tist of the
//handlers Tlisteners, then set the handlers

// mask, which updates the loggers composite mask appropriately.

// WARNING - there is an order dependency here that must be followed.
msgLogger.addHandler (handler);
handler.addMaskChangelListener(msglLogger);

handler.setMessageMask (RASIMessageEvent.DEFAULT_MESSAGE_MASK) ;

Setting up for stand-alone JRas operation
You can configure JRas operations to output trace data and logging messages to only user-defined
locations.

The JRas framework described in this task and its sub-tasks is deprecated. However, you can achieve
similar results using Java logging.

In stand-alone mode, messages and traces are logged only to user-defined logs. The following sample
assumes that:

You have a user-defined handler named SimpleFileHandler and a user-defined formatter named
SimpleFormatter.

You are not using user-defined types of events.

1. Import the requisite JRas extensions classes:

import com.ibm.ras.*;
import com.ibm.websphere.ras.*;

2. Import the user handler and formatter:
import com.ibm.ws.ras.test.user.*;
3. Declare the logger references:
private RASMessagelLogger msglLogger
private RASTracelLogger trcLogger
4. Obtain a reference to the Manager class, create the loggers, and add the user handlers. Because
loggers are named singletons, you can obtain a reference to the loggers in a number of places. One
logical candidate for enterprise beans is the ejpbCreate method. Make sure that multiple instances of
the same user handler are not accidentally inserted into the same logger. Your initialization code must

support this approach. The following sample is a message logger sample. The procedure for a trace
logger is similar.

null;
null;
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com.ibm.websphere.ras.Manager mgr = com.ibm.websphere.ras.Manager.getManager();
msgLogger = mgr.createRASMessagelLogger("Acme", "WidgetCounter", "RasTest",
myTestBean.class.getName());
// Configure the message logger to use the message file that is defined in
//the ResourceBundle sample.
msglLogger.setMessageFile("acme.widgets.DefaultMessages");

// Get a reference to the Handler and remove it from the logger.
RASIHandler aHandler = null;
Enumeration enum = msglLogger.getHandlers();
while (enum.hasMoreElements()) {
aHandler = (RASIHandler)enum.nextElement();
if (aHandler instanceof WsHandler)
msgLogger.removeHandler(wsHandler) ;

}

// Create the user handler and formatter. Configure the formatter,

// then add it to the handler.

RASIHandler handler = new SimpleFileHandler("myHandler", "FileName");
RASIFormatter formatter = new SimpleFormatter("simple formatter");
formatter.addEventClass("com.ibm.ras.RASMessageEvent");
handler.addFormatter(formatter);

// Add the Handler to the logger. Add the Togger to the Tist of the
// handlers listeners, then set the handlers

// mask, which will update the loggers composite mask appropriately.
// WARNING - there is an order dependency here that must be followed.
msgLogger.addHandler(handler);
handler.addMaskChangeListener(msgLogger);

handler.setMessageMask (RASIMessageEvent .DEFAULT_MESSAGE_MASK) ;

Configuring logging properties using the administrative console

Use this task to browse or change the properties of Java logging.

Before applications can log diagnostic information, you need to specify how you want the server to handle

log output, and what level of logging you require. Using the administrative console, you can:

» Enable or disable a particular log, specify where log files are stored and how many log files are kept.

» Specify the level of detail in a log, and specify a format for log output.
» Set a log level for each logger.

You can change the log configuration statically or dynamically. Static configuration changes affect
applications when you start or restart the application server. Dynamic or run time configuration changes

apply immediately.

When a log is created, the level value for that log is set from the configuration data. If no configuration

data is available for a particular log name, the level for that log is obtained from the parent of the log. If no
configuration data exists for the parent log, the parent of that log is checked, and so on up the tree, until a
log with a non-null level value is found. When you change the level of a log, the change is propagated to

the children of the log, which recursively propagates the change to their children, as necessary.

To configure loggers and log handlers for Java logging, use the administrative console to complete the

following steps:
1. Set the logging levels for your logs:
a. In the navigation pane, click Servers > Application Servers.
b. Click the name of the server that you want to work with.
c. Under Troubleshooting, click Logging and tracing.
d. Click Change Log Detail levels.
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e. To make a static change to the configuration, click the Configuration tab. A list of well-known
components, packages, and groups is displayed. To change the configuration dynamically, click the
Runtime tab. The list of components, packages, and groups displays all the components that are
currently registered on the running server.

f. Select a component, package, or group to set a logging level.
g. Click Apply.
h. Click OK.
2. To have static configuration changes take effect, stop then restart the application server.

Log level settings
Use this topic to configure and manage log level settings.

Using log levels you can control which events are processed by Java logging. When you change the level
for a logger, the change is propagated to the children of the logger.

Change Log Detail Levels

Enter a log detail level that specifies the components, packages, or groups to trace. The log detail
level string must conform to the specific grammar described in this topic. You can enter the log
detail level string directly, or generate it using the graphical trace interface.

If you select the Configuration tab, a static list of well-known components, packages, and groups is
displayed. This list might not be exhaustive.

If you select the Runtime tab, the list of components, packages, and group are displayed with all
the components that are registered on the running application server and in the static list.

The format of the log detail level specification is:
<component> = <level>

where <component> is the component for which to set a log detail level, and <level> is one of the
valid logger levels (off, fatal, severe, warning, audit, info, config, detail, fine, finer, finest, all).
Separate multiple log detail level specifications with colons (:).

Components correspond to Java packages and classes, or to collections of Java packages. Use
an asterisk (*) as a wildcard to indicate components that include all the classes in all the packages
that are contained by the specified component. For example:

*  Specifies all traceable code running in the application server, including the product system
code and customer code.

com.ibm.ws.*
Specifies all classes with the package name beginning with com.ibm.ws.

com.ibm.ws.classloader.JarClassLoader
Specifies the JarClassLoader class only.

An error can occur when setting a log detail level specification from the administrative console if
selections are made from both the Groups and Components lists. In some cases, the selection
made from one list is lost when adding a selection from the other list. To work around this
problem, enter the log detail level specification directly into the log detail level entry field.

Select a component or group to set a log detail level. The table following lists the valid levels for
application servers at WebSphere Application Server Version 6 and later, and the valid logging and trace
levels for earlier versions:

Version 6 logging level Logging level before Trace level before Version | Content / Significance
Version 6 6

62 Troubleshooting and support



Off Off All disabled” Logging is turned off.

* In Version 6, a trace level
of All disabled turns off
trace, but does not turn off
logging. Logging is enabled
from the Info level.

Fatal Fatal - Task cannot continue and
component, application, and
server cannot function.

Severe Error - Task cannot continue but
component, application, and
server can still function.
This level can also indicate
an impending fatal error.

Warning Warning - Potential error or impending
error. This level can also
indicate a progressive
failure (for example, the
potential leaking of
resources).

Audit Audit - Significant event affecting
server state or resources

Info Info - General information
outlining overall task
progress

Config - - Configuration change or
status

Detail - - General information
detailing subtask progress

Fine - Event Trace information - General
trace + method entry, exit,
and return values

Finer - Entry/Exit Trace information - Detailed
trace
Finest - Debug Trace information - A more

detailed trace that includes
all the detail that is needed
to debug problems

All All enabled All events are logged. If you
create custom levels, All
includes those levels, and
can provide a more detailed
trace than finest.

When you enable a logging level in Version 6.0 or above, you are also enabling all of the levels with
higher severity. For example, if you set the logging level to warning on your Version 6.x application server,
then warning, severe and fatal events are processed.

Trace information, which are events at the Fine, Finer and Finest levels, can be written only to the trace

log. Therefore, if you do not enable diagnostic trace, setting the log detail level to Fine, Finer, or Finest will
not have an effect on the data that is logged.
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HTTP error and NCSA access log settings

Use this page to configure an HTTP error log and National Center for Supercomputing Applications
(NCSA) access logs for an HTTP transport channel. The HTTP error log contains HTTP errors. The level
of error logging that occurs is dependent on the value that is selected for the Error log level field.

To view this administrative console page, click Application servers > server name > HTTP error and
NCSA access logging.

The NCSA access log contains a record of all inbound client requests that the HTTP transport channel
handles. All of the messages that are contained in these logs are in NCSA format.

After you configure the HTTP error log and the NCSA access logs, make sure that the Enable NCSA
access logging field is selected for the HTTP channels for which you want logging to occur. To view the
settings for an HTTP channel, click Servers > Application Servers > server > Web Container Transport
Chains > HTTP Inbound Channel.

Enable service at server startup
When selected, either an NCSA access log or an HTTP error log, or both are initialized when the server
starts.

Enable access logging
When selected, a record of inbound client requests that the HTTP transport channel handles is kept in the
NCSA access log.

Access log file path
Indicates the directory path and name of the NCSA access log. Standard variable substitutions, such as
$(SERVER_LOG_ROOT), can be used when specifying the directory path.

Access log maximum size

Indicates the maximum size, in megabytes, of the NCSA access log file. When this size is reached, the
logfile_name.1 archive log is created. However, every time that the original log file overflows this archive
file, the file is overwritten with the most current version of the original log file.

NCSA access log format

Indicates that the NCSA format is used when logging client access information. If Common is selected, the
log entries contain the requested resource and a few other pieces of information, but does not contain
referral, user agent, or cookie information. If Combined is selected, referral, user agent, and or cookie
information is included.

Enable error logging
When selected, HTTP errors that occur while the HTTP channel processes client requests are recorded in
the HTTP error log.

Error log file path
Indicates the directory path and the name of the HTTP error log. Standard variable substitutions, such as
$(SERVER_LOG_ROOT), can be used when specifying the directory path.

Error log maximum size

Indicates the maximum size, in megabytes, of the HTTP error log file. When this size is reached, the
logfile_name.1 archive log is created. However, every time that the original log file overflows this archive
file, this file is overwritten with the most current version of the original log file.

Error log level
Indicates the type of error messages that are included in the HTTP error log.

You can select:
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Critical
Only critical failures that stop the Application Server from functioning properly are logged.

Error The errors that occur in response to clients are logged. These errors require Application Server
administrator intervention if they result from server configuration settings.

Warning
Information on general errors, such as socket exceptions that occur while handling client requests,
are logged. These errors do not typically require Application Server administrator intervention.

Information
The status of the various tasks that are performed while handling client requests is logged.

Debug
More verbose task status information is logged. This level of logging is not intended to replace
RAS logging for debugging problems, but does provide a steady status report on the progress of
individual client requests. If this level of logging is selected, you must specify a large enough log
file size in the Error log maximum size field to contain all of the information that is logged.

The Common Base Event in WebSphere Application Server

This topic describes how WebSphere Application Server takes advantage of the Common Base Events.

An application creates an event object whenever something happens that either needs to be recorded for

later analysis or which might require the trigger of additional work. An event is a structured notification that

reports information that is related to a situation. An event reports three kinds of information:

» The situation: What happened

* The identity of the affected component: For example, the server that shut down

* The identity of the component that is reporting the situation, which might be the same as the affected
component

The application that creates the event object is called the event source. Event sources can use a common
structure for the event. The accepted standard for such a structure is called the Common Base Event. The
Common Base Event is an XML document that is defined as part of the autonomic computing initiative.
The Common Base Event defines common fields, the values they can take, and the exact meanings of
these values.

The Common Base Event model is a standard that defines a common representation of events that is
intended for use by enterprise management and business applications. This standard, which is developed
by the IBM Autonomic Computing Architecture Board, supports encoding of logging, tracing, management,
and business events using a common XML-based format. This format makes it possible to correlate
different types of events that originate from different applications. For more information about the Common
Base Event model, see the Common Base Event specification (Canonical Situation Data Format: The
Common Base Event V1.0.1). The common event infrastructure currently supports Version 1.0.1 of the
specification.

The basic concept behind the Common Base Event model is the situation. A situation can be anything that
happens anywhere in the computing infrastructure, such as a server shutdown, a disk-drive failure, or a
failed user login. The Common Base Event model defines a set of standard situation types that
accommodate most of the situations that might arise (for example, StartSituation and CreateSituation).

The Common Base Event contains all of the information that is needed by the consumers to understand
the event. This information includes data about the runtime environment, the business environment, and
the instance of the application object that created the event.

For complete details on the Common Base Event format, see the XML schema that is included in the
Common Base Event specification document, at [ftp://www6.software.ibm.com/software/developer/library/

ac-toolkitdg.pdf .
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Types of problem determination events

Problem determination involves multiple types of data, including at least two different classes of event
data, log events, and diagnostic events.

Log events, which are also referred to as message events, are typically emitted by components of a
business application during normal deployment and operations. Log events might identify problems, but
these events are also normally available and emitted while an application and its components are in
production mode. The target audience for log and message events is users and administrators of the
application and the components that make up the application. Log events are normally the only events
available when a problem is first detected, and are typically used during both problem recovery and
problem resolution.

Diagnostic events, which are commonly referred to as trace events, are used to capture internal diagnostic
information about a component, and are usually not emitted or available during normal deployment and
operation. The target audience for diagnostic events is the developers of the components that make up the
business application. Diagnostic events are typically used when trying to resolve problems within a
component, such as a software failure, but are sometimes used to diagnose other problems, especially
when the information provided by the log events is not sufficient to resolve the problem. Diagnostic events
are typically used when trying to resolve a problem.

A Common Base Event is a common structure for an event. It defines common fields, the values that
these fields can take, and the exact meanings of these values for an event. Common Base Events are
primarily used to represent log events.

The structure of the Common Base Event

A Common Base Event is a common structure for an event. It defines common fields, the values that
these fields can take, and the exact meanings of these values for an event.

The Common Base Event contains several structural elements. These elements include:
* Common header information

« Component identification, both source and reporter

» Situation information

* Message data

» Extended data

» Context data

* Associated events and association engine

Each of these structural elements has its own embedded elements and attributes.
The following table presents a summary of all the fields in the Common Base Event and their usage

requirements for problem determination events. This table shows whether a particular element or attribute
is required, recommended, optional, prohibited, or discouraged for log events, and the base specification.

Field name Log events Base specification
Version Required Required
creationTime Required Required
severity Required Optional
Msg Required Optional
sourceComponentld* Required Required
sourceComponentld.location Required Required
sourceComponentld.locationType Required Required
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sourceComponentld.component Required Required
sourceComponentld.subComponent Required Required
sourceComponentld.componentldType Required Required
sourceComponentld.componentType Required Required
sourceComponentld.application Recommended Optional
sourceComponentld.instanceld Recommended Optional
sourceComponentld.processld Recommended Optional
sourceComponentld.threadld Recommended Optional
sourceComponentld.executionEnvironment Optional Optional
situation* Required Required
situation.categoryName Required Required
situation.situationType* Required Required
situation.situationType.reasoningScope Required Required
situation.situationType.(specific Situation Type elements) Required Required
msgDataElement* Recommended Optional
msgDataElement .msgld Recommended Optional
msgDataElement .msgldType Recommended Optional
msgDataElement .msgCatalogld Recommended Optional
msgDataElement .msgCatalogTokens Recommended Optional
msgDataElement .msgCatalog Recommended Optional
msgDataElement .msgCatalogType Recommended Optional
msgDataElement .msgLocale Recommended Optional
extensionName Recommended Optional
locallnstanceld Optional Optional
globallnstanceld Optional Optional
priority Discouraged Optional
repeatCount Optional Optional
elapsedTime Optional Optional
sequenceNumber Optional Optional
reporterComponentld* Optional Optional
reporterComponentld.location Required (2) Required (2)
reporterComponentld.locationType Required (2) Required (2)
reporterComponentld.component Required (2) Required (2)
reporterComponentld.subComponent Required (2) Required (2)
reporterComponentld.componentldType Required (2) Required (2)
reporterComponentld.componentType Required (2) Required (2)
reporterComponentld.instanceld Optional Optional
reporterComponentld.processld Optional Optional
reporterComponentld.threadld Optional Optional
reporterComponentld.application Optional Optional
reporterComponentld.executionEnvironment Optional Optional
extendedDataElements™ Note 3 Optional
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contextDataElements™ Note 4 Optional

associatedEvents* Note 5 Optional

Notes:

Items followed by an asterisk (*) are elements that consist of sub elements and attributes. The fields in
those elements are listed in the table directly following the parent element name.

Some of the elements are optional, but when included, they include sub elements and attributes that are
required. For example, the reporterComponentld element has a Componentldentification type. The
component attribute in Componentidentification is required. Therefore, the
reporterComponentld.component attribute is required, but only when the reporterComponentld parent
element is included.

The extendedDataElements element can be included multiple times to supply extended data
information. See the Extended data section for more information on required and recommended
extended data element values.

The contextDataElements element can be included multiple times to supply context data information.

The associatedEvents element can be included multiple times to supply correlation data. No
recommended uses of this element exist for the producers of problem determination data, and the use
of this element is discouraged.

Common header information

This topic provides additional information about how to format and use these fields for problem
determination events, which can be used to clarify and extend the information provided in the other
documents.

The Common Base Event specification [CBE101] provides information on the required format of these
fields and the Common Base Event Developer’s Guide [CBEBASE] provides general usage guidelines.

The common header information in the Common Base Event includes the following information about an
event:

Version: The version of this Common Base Event

creationTime: The date and time when the event generated

Severity and priority: The severity of the condition (situation) that is identified by the event
extensionName: The type of event that was captured

locallnstanceld and globallnstanceld: Identifiers that can be used to quickly identify a specific event
within a set of events

repeatCount and elapsedTime: Information that supports a system to efficiently report multiple events of
the same type, by consolidating those events into a single event

sequenceNumber: Sequence information that supports a system to order a set of events in other ways
than time of capture

severity

All problem determination events must provide an indication as to the relative severity of the condition
(situation) being reported by providing appropriate values for the severity field in the Common Base
Event. The severity field is required for problem determination events. This field is more restrictive than
the base specification for the Common Base Event, which lists this field as optional because effective
and efficient problem determination requires the ability to quickly identify the information that is needed
to resolve a problem as well as prioritize the problems that need addressing. Typically, the following
values are used for problem determination events:
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10

Information

Log information events, normal
conditions, and events that are
supplied to clarify operations, for
example, state transitions, operational
changes. These events typically do
not require administrator action or
intervention.

20

Harmless

Similar to information events, but are
used to capture audit items, such as
state transitions or operational
changes. These events typically do
not require administrator action or
intervention.

30

Warning

Warnings typically represent
recoverable errors, for example a
failure that the system can correct.
These events can require
administrator action or intervention.

40

Minor

Minor errors describe events that
represent an unrecoverable error
within a component. The failure
affects the component ability to
service some requests. The business
application can continue to perform its
normal functions, but its overall
operation might be degraded. These
events require administrator action or
intervention to address the condition.

50

Critical

Critical errors describe events that
represent an unrecoverable error
within a component. The failure
significantly affects the component
ability to service most requests. The
business application can continue
most, but not all of its normal
functions and its overall operation
might be degraded. These events
require administrator action or
intervention to address the condition.

60

Fatal

Fatal errors describe events that
represent an unrecoverable error
within a component. The failure
usually results in the complete failure
of the component. The business
application can continue some normal
functions, but its overall operation
might be degraded. These events
require administrator action or
intervention to address the condition.

msg

Refer to [‘Message data” on page 73 for information on this attribute.

priority
The use of the priority field is discouraged for problem determination events. The severity field is

typically used to communicate and evaluate the importance of problem determination events. Use the
priority field to enhance the information that is provided in the severity field, that is. prioritize events of

the same severity.
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extensionName
The extensionName field is used to communicate the type of event that is reported, for example, what
general class of events is being reported. In many cases this field provides an indication of what
additional data you can expect with the event, for example, optional data values.

repeatCount
The repeatCount field is valid for problem determination events, but is not typically used or supplied by
the event producers. This field is used for data reduction and consolidation by event management and
analysis systems.

elapsedTime
The elapsedTime field is valid for problem determination events, but is not typically used or supplied
by the event producers. This field is used for data reduction and consolidation by event management
and analysis systems.

sequenceNumber
The sequenceNumber field is valid for problem determination events. It is typically used only by event
producers when the granularity of the event time stamp (the creationTime field) is not sufficient in
ordering events. The sequenceNumber field is typically used to sequence events that have the same
time stamp value.

Event management and analysis systems can use the sequenceNumber field for a number of reasons,
including providing alternative sequencing, not necessarily based on a time stamp. The
recommendations here are provided primarily for event producers.

Component identification for source and reporter

The component identification fields in the Common Base Event are used to indicate which component in
the system is experiencing the condition that is described by the event (the sourceComponentID) and
which component emitted the event (the reporterComponentID). Typically, these components are the
same, in which case only the sourceComponentID is supplied. Some notes and scenarios on when to use
these two elements in the Common Base Event:

» The sourceComponentlD is always used to identify the component experiencing the condition that is
described by the event.

* The reporterComponentID is used to identify the component that actually produced and emitted the
event. This element is typically used only within events that are emitted by a component that is
monitoring another component and providing operational information regarding that component. The
monitoring component (for example, a Tivoli agent or hardware device driver) is identified by the
reporterComponentID and the component being monitored (for example, a monitored server or
hardware device) is identified by the sourceComponentID.

A potential misuse of the reporterComponentID is to identify a component that provides event
conversion or management services for a component, for example, identifying an adapter that
transforms the events that are captured by a component into Common Base Event format. The event
conversion function is considered an extension of the component and not identified separately.

The information that is used to identify a component in the system is the same, regardless of whether it is
the source component or reporter component:

location locationType Component location Identifies the location of the
component.

component componentType Component name Identifies the asset name of the
component, as well as the type of
component.

subcomponent Subcomponent name Identifies a specific part or
subcomponent of a component, for
example a software module or
hardware part.
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application Business application name Identifies the business application or
process the component is a part of
and provides services for.

instanceld Operational instance Identifies the operational instance of a

component, that is the actual running
instance of the component.

processld threadld

Operational instance

Identifies the operational instance of a
component within the context of a
software operating system, that is he
operating system process and thread
running when the event was
produced.

executionEnvironment

Operational instance Component
location

Provides additional information about
the operational instance of a
component or its location by
identifying the name of the
environment hosting the operational
instance of the component, for
example the operating system name
for a software application, the
application server name for a Java 2
Platform, Enterprise Edition (J2EE)
application, or the hardware server
type for a hardware part.

The Common Base Event specification [CBE101] provides information on the required format of these
fields and the Common Base Event Developer’s Guide [CBEBASE] provides general usage guidelines.
This section provides additional information about how to format and use some of these fields for problem
determination events, which can be used to clarify and extend the information that is provided in the other

documents.

Component

The Component field in a problem determination event is used to identify the manageable asset that is
associated with the event. A manageable asset is open for interpretation, but a good working definition
is a manageable asset represents a hardware or software component that can be separately obtained
or developed, deployed, managed, and serviced. Examples of typical component names are:

* IBM eServer xSeries model x330

* IBM WebSphere Application Server version 5.1 (5.1 is the version number)
* Microsoft Windows 2000

» The name of an internally developed software application for a component

subComponent

The Subcomponent field in a problem determination event identifies the specific part of a component
that is associated with the event. The subcomponent name is typically not a manageable asset, but
provides internal diagnostic information when diagnosing an internal defect within a component, that is
What part failed? Examples of typical subcomponents and their names are:

* Intel Pentium processor within a server system (Intel Pentium IV Processor)

» the enterprise bean container within a Web application server (enterprise bean container)

» the task manager within an operating system (Linux Kernel Task Manager)

» the name of a Java class and method (myclass.mycompany.com or
myclass.mycompany.com.methodname).

The format of a subcomponent name is determined by the component, but use the convention shown
previously for naming a Java class or the combination of a Java class and method is followed. The
subcomponent field is required in the Common Base Event.
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componentldType

The componentldType field is required by the Common Base Event specification, but provides minimal
value for problem determination events. For problem determination events, the use of the application
value is discouraged. The componentldType field identifies the type of component; the application is
identified by the application field.

application

The application field is listed as an optional value within the Common Base Event specification, but
provide it within problem determination events whenever it this value is available. The only reason this
field is not required for problem determination events is that instances exist where the issuing
component might not be aware of the overall business application.

instanceld

The instanceld field is listed as an optional value within the Common Base Event specification, but
provide this value within problem determination events whenever it is available.

Always provide the instancelD when a software component is identified and identify the operational
instance of the component (for example, which operation instance of an installed software image is
actually associated with the event). Provide this value for hardware components when these
components support the concept of operational instances.

The format of the supplied value is defined by the component, but must be a value that an analysis
system can use (either human or programmatic) to identify the specific running instance of the
identified component. Examples include:

» cell, node, server name for the IBM WebSphere Application Server
» deployed EAR file name for a Java enterprise bean
» serial number for a hardware processor

processlid

The processld field is listed as an optional value within the Common Base Event specification, but
provide this value for problem determination events whenever it is available and applicable. Always
provide this value for software-generated events, and identify the operating system process that is
associated with the component that is identified in the event. Match the format of the thread ID with
the format of the operating system (or other running environment, such as a Java virtual machine).
This field is typically not applicable or used for events that are emitted by hardware (for example,
firmware).

threadld

The threadld field is listed as an optional value within the Common Base Event specification, but
provide this value for problem determination events whenever it is available and applicable. Always
provide for software-generated events, and identify the active operating system thread when the event
was detected or issued. A notable exception to this recommendation is some operating systems or
running environments do not support threads. Match the format of the thread ID with the format of the
operating system (or other running environment, such as a Java virtual machine). This field is typically
not applicable or used for events that are emitted by hardware (for example, firmware).

executionEnvironment

The executionEnvironment field, when used, identifies the immediate running environment that is used by
the component being identified. Some examples are:

the operating system name when the component is a native software application.

the operating system/Java virtual machine name when the component is a Java 2 Platform, Standard
Edition (J2SE) application.

the Web server name when the component is a servlet.
the portal server name when the component is a portlet.
the application server name when the component is an enterprise bean.
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The Common Base Event specification [CBE101] provides information on the required format of these
fields and the Common Base Event Developer’'s Guide [CBEBASE] provides general usage guidelines.

Situation information
The situation information is used to classify the condition that is reported by an event into a common set of
situations.

The Common Base Event specification [CBE101] provides information on the set of situations defined for
the Common Base Event, with the values and formats that are used to describe these situations. The
Common Base Event Developer’s Guide [CBEBASE] provides general usage guidelines.

Consider the following points regarding situation information for problem determination events:

* Whenever possible, use the situation categorizations and qualifiers that are described in the base
Common Base Event specification. Avoid using your own situation definitions as much as possible.

* Not all messages and logs can be classified using the situation definitions that are supplied in the base
Common Base Event specification. You can use the OtherSituation categorization to provide your own
situation information, but the recommended course of action for problem determination events is to use
the ReportSituation categorization, with reportCategory=Log.

* Warning events can be confusing. A warning event (that is an event with severity=warning) typically
indicates a recoverable failure, but the situation settings can be interpreted as unrecoverable failures
(for example ConnectSituation, successDisposition=UNSUCCESSFUL). Use the appropriate situation
categorization so the severity setting indicates the severity of the situation, that is whether the
component recovered from the failure.

* The recommended setting for the reasoningScope value is EXTERNAL for all message events.

Message data
All problem determination Common Base Events must provide human readable text that describes the
specific reported event within the msg field of the Common Base Event.

The text that is associated with events representing actual messages or log entries is expected to be
translated and localized. Include the msgDataElement element in the Common Base Event whenever
internationalized text is provided in the event. This element provides information about how the message
text is created and how to interpret it. This information is particularly invaluable when trying to interpret the
event programmatically or when trying to interpret the message independent of the locale or language that
is used to format the message text.

Prerequisite: Understand the concepts that are associated with creating internationalized messages. A
good source of education on these concepts is provided by the documentation that is associated with
internationalization of Java information and the usage of resource bundles within the Java language.

The msgDataElement element in the Common Base Event includes the following information about the
value of the msg field that is provided with an event:

* The locale of the supplied message text, which identifies how the locale-independent fields within the
message are formatted, as well as the language of the message (msgLocale).

* A locale-independent identifier that is associated with the message that can be used to interpret the
message independent of the message language, message locale, and message format (msgld and
msgldType).

* Information on how a translated message is created, including:

— The identifier that is used to retrieve the message template (msgCatalogld).

— The name and type of message catalog that are used to retrieve the message template (msgCatalog
and msgCatalogType).

— Any locale-independent information that is inserted into the message template to create the final
message (msgCatalogTokens).
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The Common Base Event specification [CBE101] provides information on the required format of these
fields and the Common Base Event Developer’s Guide [CBEBASE] provides general usage guidelines.
This section provides additional information about how to format and use these fields for problem
determination events.

msg
All message, log, and trace events must provide a human-readable message in the msg field of the
Common Base Event. The msg field is required for problem determination events, both log events and
diagnostic events. This field is more restrictive than the base specification for the Common Base
Event, which lists this field as optional; effective and efficient problem determination requires the ability
to quickly identify the reported condition. The format and usage of this message is component-specific,
but use the following general guidelines:

* Expect the message text that is supplied with messages and log events to be internationalized.

* Provide the locale of the supplied message text with the msgLocale field in the msgDataElement
element of the Common Base Event.

* Provide additional information regarding the format and construction of internationalized messages
whenever possible, using the msgDataElement element of the Common Base Event.

msgLocale
Provide the message locale whenever message text is provided within the Common Base Event, as is
the case with all problem determination events. The msglLocale field is listed as an optional value
within the Common Base Event specification, but provide this information within problem determination
events whenever possible. The reason this field is not required for problem determination events is
that instances exist where the locale information is not provided or available when formatting the
Common Base Event.

msgld and msgldType
Several companies include a locale-independent identifier within internationalized message text that
you can use to interpret the described condition by the message text, independent of the message.
For example, most messages issued by IBM software look like IEE890I WTO Buffers in console
backup storage = 1024, where a unique, locale-independent identifier IEE890I precedes the translated
message text. This identifier provides a way to uniquely detect and identify a message independent of
location and language. This detection is invaluable for locale-independent and programmatic analysis.

The msgld field is listed as an optional value within the Common Base Event specification, but it must
be provided within problem determination events whenever this identifier is included in the message
text. Likewise, the msgldType field is listed as an optional value within the Common Base Event
specification, but it must be provided within problem determination events whenever a value is
supplied for msgld. Do not supply these fields when the message text is not translated or localized, for
example, for trace events.

msgCatalogld
The msgCatalogld field is listed as an optional value within the Common Base Event specification, but
provide this value whenever the Common Base Event includes localized or translated message text,
for example when providing problem determination events that represent issued messages or log
events. This field is not required for problem determination events because not all problem
determination events include translated message text Some cases exist where the value is not
provided or available when formatting the Common Base Event. Do not supply this field when the
message text is not translated or localized, for example, for trace events.

msgCatalogTokens
The msgCatalogTokens field is listed as an optional value within the Common Base Event
specification, but provide this value whenever the Common Base Event includes localized or translated
message text, for example when providing problem determination events that represent issued
messages or log events. This field is not required for problem determination events because not all
problem determination events include translated message text, and cases exist where the value is not

74  Troubleshooting and support



provided or available when formatting the Common Base Event. This value contains the list of
locale-independent values or message tokens that are inserted into the localized message text when
creating a translated message.

These values are difficult to extract from a translated message without knowing the translated
message template that is used to create the message. Do not supply this field when the message text
is not translated or localized

The Common Base Event provides several mechanisms for providing additional data about an event,
including this field, extended data elements, and extensions to the schema. Always use the
msgCatalogTokens field to supply the list of message tokens that is included in the message text
associated with an event. These values can also be supplied in other parts of the Common Base
Event, but they must be included in this field.

msgCatalog and msgCatalogType
The msgCatalog and msgCatalogType fields are listed as optional values within the Common Base
Event specification, but provide this value whenever the Common Base Event includes localized or
translated message text, for example when providing problem determination events that represent
issued messages or log events. These fields are not required for problem determination events
because not all problem determination events include translated message text, and cases exist where
the values are not provided or available when formatting the Common Base Event. Do not complete
these fields when the message text has is not translated or localized, for example, for trace events.

Extended data

The Common Base Event provides several methods for including this additional data, including extending
the Common Base Event schema or supplying one or more ExtendedDataElement elements within the
Common Base Event, which is the preferred approach.

The base information that is included in a Common Base Event might not be sufficient to represent all of
the information captured by a component when creating a problem determination event.

Use an ExtendedDataElement element to represent a single data item. A Common Base Event can
contain more than one of these elements, essentially one for each additional data item. A hint to the
number and type of ExtendedDataElement elements is supplied by the extensionName value, but this
information is only a hint. The usage of the attributes in the ExtendedDataElement element for problem
determination events is the same as those for any other Common Base Event.

Sample Common Base Event instance

This XML document is an example of a Common Base Event instance that is generated by a WebSphere
Application Server application.

Use the following example for reference:

<CommonBaseEvent creationTime="2004-09-18T04:03:28.484Z"
globalInstanceld="myhost:1095479647062:1899"
msg="WSVROO24I: Server serverl stopped"
severity="10"
version="1.0.1">

. several extendedDataElements for WebSphere Application Server internal use only ...

<sourceComponentId component="com.ibm.ws.runtime.component.ServerCollaborator"
componentIdType="Unknown"
executionEnvironment="Windows 2000[x86]#5.0"
instanceld="myhost\myhost\serverl"
location="myhost"
locationType="Hostname"
processId="1095479647062"
subComponent="Unknown"
threadId="Alarm : 0"
componentType="http://www.ibm.com/namespaces/autonomic/WebSphereApplicationServer"/>
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<msgDataElement msgLocale="en_US">

<msgCatalogTokens value="serverl"/>
<msgId>WSVR00241< /msgld>

<msgCatalogId>WSVROO24I< /msgCatalogIld>
<msgCatalog>com.ibm.ws.runtime.runtime< /msgCatalog>
</msgDataElement>

<situation categoryName="ReportSituation">
<situationType xsi:type="ReportSituation" reasoningScope="EXTERNAL" reportCategory="L0G"/>
</situation>

</CommonBaseEvent>

A number of extendedDataElement elements in the XML are used by WebSphere Application Server, but
are not for application use because these elements might change.

The CommonBaseEvent element defines the Common Base Event instance. This element has a set of
attributes that are common for all Common Base Events. This set includes the extensionName attribute,
which defines the type or class of the Common Base Event instance, the creation time, severity, and
priority.

Nested within the CommonBaseEvent element are elements giving more detail about the situation. The
first of these elements is the situation element. This classification is standardized.

The CommonBaseEvent element also includes the sourceComponentld and the (optional)
reporterComponentld elements. The sourceComponentld element describes where the situation occurred;
the reporterComponentld describes where the situation is detected. If the sourceComponentld and the
reporterComponentld elements are the same, the reporterComponentld element is omitted.

The attributes of both the sourceComponentld and the reporterComponentld elements are the same. They
identify the component type, name, operating system, and network location. The content of these attributes
provides vertical correlation of the stack of IT resources that are active when the Common Base Event is
created.

Also included in the CommonBaseEvent element are contextDataElements elements that describe the
context in which the situation occurred. This context correlates Common Base Event instances that are
part of the same work. This correlation is called horizontal correlation because an instance of a particular
context type correlates events at the same level of abstraction, for example at the business level, the
application level, or at the middleware level.

FExtended data elements contain additional data that is used to describe a situation. In this example, an
extended data element is added by WebSphere Application Server to describe the Java 2 Platform,
Enterprise Edition (J2EE) component that generated the Common Base Event instance and some
application data.

Sample Common Base Event template

The content handler uses template information to fill in blanks in the Common Base Event when the
Common Base Event complete method is called.

Components that use the WebSphere Application Server event factory home can include a Common Base
Event template XML file to provide data to populate Common Base Events. Information that is already
supplied in the event is not overridden if the same field is supplied in the template.

The following example illustrates a Common Base Event template:
<?xml version="1.0" encoding="UTF-8"?>

<TemplateEvent
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version="1.0.1"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalocation="templateEvent.xsd">

<CommonBaseEvent

<sourceComponentId application="My Application" component="com.ibm.componentX"/>
<extendedDataElements name="Sample ExtendedDataElement name" type="string">
<values>Sample ExtendedDataElement value</values>

</extendedDataElements>

</CommonBaseEvent>

</TemplateEvent>

Component identification for problem determination
This topic describes types of problem determination events.

A business application is made up of multiple components. A component can be made up of several
internal subcomponents. Consistent application of these concepts is critical for effective problem
determination of a business application; all of the parts of the application must use the same concepts and
assumptions when creating and formatting events. Use the following definitions and examples when
creating Common Base Events for problem determination.

Business application
A business application is the business logic and business data that is used to address a set of specific
business requirements. A business application consists of several components of multiple types,
combined in a unique manner by an enterprise, to provide the functions and resources that are
needed to address those requirements. The primary creator and manager of a business application is
the enterprise, and each enterprise or company creates unique business applications. Examples of
business applications are the Payroll Application for the ACME Corporation and the Inventory
Application for Spacely Sprockets.

Components
A business application is created and managed by the enterprise as a set of components.
Components are deployable assets, which are developed either by the enterprise or a vendor, and
managed by the enterprise. A component might be created by the enterprise, typically for use within a
specific business application. For example, the ACME Corporation might create a set of enterprise
beans to represent the business logic that is required by their Payroll Application. A component might
also be an asset that is produced by a vendor and acquired by an enterprise. Examples of these
components are hardware products, such as IBM eServers or Sun Solaris systems, or software
products, such as IBM WebSphere Application Server, Oracle Database Servers.

Subcomponents
A specific component, depending on its complexity, might consist of several subcomponents. For
example, the IBM WebSphere Application Server consists of many subcomponents, such as the
enterprise bean container and the servlet engine. Subcomponent information is typically used only by
the creator of the component to service the component, and as such are not separately deployable or
manageable resources in the enterprise. The enterprise might deploy a change or update to a
subcomponent, but only upon guidance from the component vendor and as part of the vendor’s
component. For example, a software fix for the enterprise bean container of the IBM WebSphere
Application Server is packaged and deployed as a software update to the IBM WebSphere Application
Server. Replacement of the processor in an IBM eServer is deployed as a physical part, but only as a
part of the original deployed component, the IBM eServer.

Logging Common Base Events in WebSphere Application Server
This topic describes how WebSphere Application Server takes advantage of the Common Base Events.

WebSphere Application Server uses Common Base Events within its logging framework. Common Base
Events can be created explicitly and then logged through the Java logging API, or can be created implicitly
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by using the Java logging API directly. For Common Base Event creation, the application server
environment provides a Common Base Event factory with a content handler that provides both runtime
data and template data for Common Base Events.

Logging with Common Base Event API and the Java logging API
In cases where the events that are generated by the Java logging API are insufficient to describe the

event that needs capturing, you can create Common Base Events with the Common Base Event factory
APls.

When you create a Common Base Event, you can add data to the Common Base Event before it is
logged. The following diagram illustrates how application code can create and log Common Base Events:
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WebSphere Application Server is configured to use an event factory that automatically populates
WebSphere Application Server-specific information into the Common Base Events that it generates. In
general, it is good practice to create events using the WebSphere Application Server default Common
Base Event factory because this approach ensures consistency of Common Base Event content across
events. However, you can create and use other Common Base Event factories.

» Application code invokes the createCommonBaseEvent method on the EventFactory class to create a
CommonBaseEvent.

» Application code wraps CommonBaseEvent event in a CommonBaseEventLogRecord record, and adds
event-specific data.

» Application code calls the CommonBaseEvent event complete method.
» The CommonBaseEvent event invokes the ContentHandler completeEvent method.

» The ContentHandler handler adds XML template data to the CommonBaseEvent event. Not all
ContentHandler handlers support templates.

* The ContentHandler handler adds runtime data to the CommonBaseEvent event.

» Application code passes the CommonBaseEventLogRecord record to the logger using the Logger.log
method.

» Logger passes CommonBaseEventLogRecord record to Handlers.
» Handlers format data and write to the output device.

After completing all the above steps you will have a Common Base event based on your configuration
settings.

Common Base Event content handler:

78  Troubleshooting and support



Content handlers populate data into Common Base Events when the Common Base Event complete
method is invoked. You can associate content handlers with Common Base Event templates, which
provide default information to transfer into each Common Base Event. Content handlers might also provide
any other information that is relevant to completing the population of the Common Base Event, such as
appropriate runtime defaults.

The use of content handlers ensures consistency of field use in the Common Base Event within a
component or within a set of components that share the same runtime. For example, some content
handlers support the specification of a template. If used consistently across a component, this template
ensures that all events for that component have the same template information filled in. Similarly, some
content handlers can also supply runtime information to their associated Common Base Events. If
consistently used throughout the entire runtime, runtime information ensures that all events use runtime
data in a similar way.

The event factory home that is used in the WebSphere Application Server runtime is associated with a
content handler that both reads from a template, and supplies runtime data. Have components use Event
Factories that are obtained from this event factory home with their own templates, to produce consistency
between application events and server events.

More details can be found in‘Creating custom Common Base Event content handlers’| or the API
documentation for org.eclipse.hyades.logging.events.cbe.ContentHandler at|www.eclipse.org/hyades|

Creating custom Common Base Event content handlers:

Create a custom Common Base Event content handler or template to automate configuration or values for
specific events.

A content handler is an object that automatically sets the property values of each event based on any
arbitrary policies that you want to use.

The following content handler classes were added to WebSphere Application Server to facilitate the use of
the Common Base Event infrastructure:

Class Name Description

WsContentHandlerimpl This provides an implementation of
org.eclipse.hyades.logging.events.cbe.ContentHandler specifically for use in
the WebSphere Application Server environment. This content handler
completes Common Base Events using information from the WebSphere
Application Server runtime, and it uses the same content handler as is used
internally by the WebSphere Application Server when completing Common
Base Events for logging.

WsTemplateContentHandlerimpl This provides the same function as WsContentHandlerImpl, but it extends
the org.eclipse.hyades.logging.events.cbe.impl.TemplateContentHandlerImpl
class to enable the use of a Common Base Event template. Template
content takes precedence in cases where the template data specifies values
for the same Common Base Event fields as does the
WsContentHandlerImpl.

In some situations, you might want some event property data set automatically for every event that you
create. This automation is a way to fill in certain standard values that do not change, such as the
application name, or to set some properties based on information that is available from the runtime
environment, like creation time or thread information. You can set property data automatically by creating a
content handler.

» Use the following code sample to implement the CustomContentHandler class:
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public class CustomContentHandler extends WsContentHandlerImpl {

public CustomContentHandler() {
super();
// TODO Custom initialization code goes here

}

public void completeEvent(CommonBaseEvent cbe) throws CompletionException {
// following code will add WAS content to the Content Base Event
super.completeEvent(che);
// TODO Custom content can be added to the Content Base Event here

}

}

* The following shows how to implement the CustomTemplateContentHandler class:
public class CustomTemplateContentHandler extends WsTemplateContentHandlerImpl {

public CustomTemplateContentHandler() {
super();
// TODO Custom initialization code goes here

}

public void completeEvent(CommonBaseEvent cbe) throws CompletionException {
// following code will add WAS content to the Content Base Event
super.completeEvent (cbe);
// TODO Custom content can be added to the Content Base Event here

}

}

You now have a content handler or a custom content handler template based on the settings that you
specified.

Common Base Event factory home:
Event Factory homes provide Event Factory instantiation that is based on a unique factory name.

Event Factory home implementations are tightly coupled with content handlers that are used to populate
Common Base Events with template or default data. Event Factory instances are maintained by the
associated Event Factory home, based on their unique name. For example, when application code
requests a named Event Factory, the newly created Event Factory instance is returned and persisted for
future requests for that named Event Factory. An abstract Event Factory home class provides the
implementation for the APIs in the Event Factory home interface. Implementers extend the abstract Event
Factory home class and implement the createContentHandler API to create a typed content handler that is
based on the type of Event Factory home implementation.

In WebSphere Application Server, the default Event Factory home that is obtained with a call to
EventFactoryContext.getinstance.getEventFactoryHome method is associated with a ContentHandler
handler capable of supplying both event template information, as well as WebSphere Application Server
runtime default information.

More details can be found in the APl documentation for
org.eclipse.hyades.logging.events.cbe.EventFactoryHome at www.eclipse.org/hyades.

Creating custom Common Base Event factory homes:

Use custom Common Base Event factory homes to control configuration and implementation of unique
Event Factories.

Event Factory Homes create and provide homes for Event Factory instances. Each Event Factory Home
has a Content Handler. This Content Handler is assigned to every Event Factory the Event Factory Home
creates. In turn, when a Common Base Event is created, the Content Handler from the Event Factory is
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assigned to it. Event Factory instances are maintained by the associated Event Factory Home, based on
their unique name. For example, when application code requests a named Event Factory, the newly
created Event Factory instance is returned and persisted for future requests for that named Event Factory.

The following classes were added to facilitate the use of Event Factory homes for logging Common Base
Events:

Class Name Description

WsEventFactoryHomelmpl This class extends the
org.eclipse.hyades.logging.events.cbe.impl.AbstractEventFactoryHome class.
This Event Factory Home returns Event Factory instances associated with the
WsContentHandlerimpl Content Handler. The WsContentHandlerlmpl is the
Content Handler used by the WebSphere Application Server by default when no
Event Factory template is in use.

WsTemplateEventFactory This class extends the

Homelmpl org.eclipse.hyades.logging.events.cbe.impl.EventXMLFileEventFactoryHomelmpl
class. This Event Factory Home returns Event Factory instances associated with
the WsTemplateContentHandlerimpl Content Handler. The
WsTemplateContentHandlerlmpl is the Content Handler used by the WebSphere
Application Server when an Event Factory template is required.

Custom event factory homes support the use of Common Base Event for logging in WebSphere
Application Server and make logging easy and consistent between the WebSphere Application Server
runtime and the exploiters of this API. The [CustomEventFactoryHome|and
[CustomTemplateEventFactoryHome| classes will be used to obtain an event factory. These classes are
there to make sure the correct content handler is being used with a particular event factory. The
[CustomEventFactoryHelper class is an example of how the infrastructure provider can hide the factory
selection details from infrastructure users, using their own set of parameters to decide which the
appropriate event factory is.

» The following code samples provide examples of how to implement and use the
CustomEventFactoryHome class.

1. Implementation of the CustomEventFactoryHome class is as follows:
public class CustomEventFactoryHome extends AbstractEventFactoryHome {

public CustomEventFactoryHome() {
super();
// TODO Custom intialization code goes here

}

public ContentHandler createContentHandler(String arg0) {
// Always use custom content handler
return resolveContentHandler();

}

public ContentHandler resolveContentHandler() {
// Always use custom content handler
return new CustomContentHandler();

}

1

2. The following is an example of how to use the CustomEventFactoryHome class:

// get the event factory
EventFactory eventFactory=(new CustomEventFactoryHome()).getEventFactory("XYZ");
// create an event - call appropriate method
eventFactory.createCommonBaseEvent();
// log event ...

» For the CustomTemplateEventFactoryHome class you can use the following code for implementation
and use:
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1. Implement the CustomTemplateEventFactoryHome class by using this code:

public class CustomTemplateEventFactoryHome extends
EventXMLFileEventFactoryHomeImpl {

public CustomTemplateEventFactoryHome() {
super();
// TODO Custom intialization code goes here

}

public ContentHandler createContentHandler(String arg0) {
// Always use custom content handler
return resolveContentHandler();

}

public ContentHandler resolveContentHandler() {
// Always use custom content handler
return new CustomTemplateContentHandler();

}
}

2. Use the CustomTemplateEventFactoryHome class by following this sample code:

// get the event factory
EventFactory eventFactory=(new
CustomTemplateEventFactoryHome()).getEventFactory ("XYZ");
// create an event - call appropriate method
eventFactory.createCommonBaseEvent();
// log event ...

» The CustomEventFactoryHelper class can be implemented and used by following the code below:
1. Implement the custom CustomEventFactoryHelper class using this code:

public class CustomTemplateEventFactoryHome extends
EventXMLFileEventFactoryHomeImpl {

public CustomTemplateEventFactoryHome() {
super();
// TODO Custom intialization code goes here

}

public ContentHandler createContentHandler(String arg0) {
// Always use custom content handler
return resolveContentHandler();

}

public ContentHandler resolveContentHandler() {
// Always use custom content handler
return new CustomTemplateContentHandler();

}

1

Figure 4 CustomTemplateEventFactoryHome class
public class CustomEventFactoryHelper {

// name of the event factory to use

pubTic static final String FACTORY_NAME="XYZ";

public static EventFactory getEventFactory(String paraml, String param2) {

EventFactory factory=null;

switch (resolveFactory(paraml,param2)) {

case 1:

factory=(new CustomEventFactoryHome()).getEventFactory(FACTORY_NAME);
break;

case 2:
factory=(new
CustomTemplateEventFactoryHome()).getEventFactory (FACTORY_NAME);
break;

default:
// Add default for event factory
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break;

}

return factory;

}

private static int resolveFactory(String paraml, String param2) {
int factory=0;
// Add code here to resolve which factory to use
return factory;

}

}

2. To use the CustomEventFactoryHelper class, use the following code:

// get the event factory
EventFactory eventFactory=
CustomEventFactoryHelper.getEventFactory("paraml”, "param2","param3");
// create an event - call appropriate method
eventFactory.createCommonBaseEvent () ;
// log event ...

Use the information provided here to implement a custom content factory home and the associated
classes based on the settings that you specify.

Common Base Event factory context:

The event factory context provides a service to look up event factory homes. Retrieve the event factory
context using a call to the EventFactoryContext.getinstance method.

Using this class, you can look up the event factory homes by name, and avoid the need to include the
typed home in code. The EventFactoryHome name must be located on the class path to be found. The
EventFactoryContext context also stores an EventFactoryHome name as a default, which can be obtained
with a call to the EventFactoryContext.getinstance.getEventFactoryHome method.

In WebSphere Application Server, the EventFactoryContext context is configured with a default
EventFactoryHome name which is associated to a ContentHandler handler that is capable of supplying
both event template information, as well as WebSphere Application Server runtime default information.

More details can be found in the API documentation for
org.eclipse.hyades.logging.events.cbe.EventFactory at www.eclipse.org/hyades.

Common Base Event factory:

Use event factories to create Common Base Events and complete event properties with associated
content handlers.

Content handlers populate data into Common Base Events when the Common Base Event invokes the
complete method. All event properties set by the application code have priority over all properties that are
specified by the content handler. Event factory implementations are tightly coupled with the content
handler instance, which is associated with the event factory when the event factory is instantiated. Factory
instances can be retrieved only from their associated event factory home. Event factory instances are
retrieved and maintained based on unique names. Event factory names are hierarchical; they are
represented using the standard Java dot-delimited, name-space naming conventions.

More details can be found in the API documentation for
org.eclipse.hyades.logging.events.cbe.EventFactory at www.eclipse.org/hyades.

java.util.logging -- Java logging programming interface
The java.util.logging.Logger class provides a variety of methods with which data can be logged.
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In the WebSphere Application Server, the Java logging API (java.util.logging) automatically creates
Common Base Events for events that are logged at the WsLevel. DETAIL level or above (including
WsLevel. DETAIL, Level. CONFIG, Level.INFO, WsLevel. AUDIT, Leve WARNING, Level.SEVERE, and
WsLevel.FATAL). These Common Base Events are created using the event factory that is associated with
the logger to which the message is logged. If no event factory is specified, WebSphere Application Server
uses a default event factory which automatically fills in WebSphere Application Server-specific information.

The WebSphere Application Server uses a special implementation of the java.util.logging.Logger class that
automatically creates Common Base Events for the following methods:

» config

* info

* warning

> severe

* log: All variants except log(LogRecord) when used with the WsLevel.DETAIL level or more severe levels
* logp: When used with the WsLevel. DETAIL level or more severe levels

* logrb: When used with the WsLevel.DETAIL level or more severe levels

The WebSphere Application Server logger implementation is used only for named loggers for example,
loggers that are instantiated with calls, such as Logger.getLogger("com.xyz.SomeLoggerName"). Loggers
instantiated with calls to the Logger.getAnonymousLogger and Logger.getLogger, or Logger.global
methods do not use the WebSphere Application Server implementation, and do not automatically create
Common Base Events for logging requests made to them. Log records that are logged directly with the

Logger.log(LogRecord) method are not automatically converted by WebSphere Application Server loggers
into Common Base Events.

The following diagram illustrates how application code can log Common Base Events:
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The Java logging API processing of named loggers and message-level events proceeds as follows:
1. Application code invokes the named logger (WsLevel.DETAIL or above) with event-specific data.

2. The logger creates a Common Base Event using the createCommonBaseEvent method on the event
factory that is associated with the logger.

3. The logger creates a Common Base Event using the event factory associated to the logger.

4. The logger wraps the common base event in a CommonBaseEventLogRecord record, and adds
event-specific data.

5. The logger calls the Common Base Event complete method.
6. The Common Base Event invokes the ContentHandler completeEvent method.
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7. The content handler adds XML template data to the Common Base Event (including for example, the
component name). Not all content handlers support templates.

8. The content handler adds runtime data to the Common Base Event (including for example, the
current thread name).

9. The logger passes the CommonBaseEventLogRecord record to the handlers.
10. The handlers format data and write to the output device.

Logger.properties file
Use the Logger.properties file to set logger attributes for your component.

The properties file is loaded the first time the Logger.getLogger(loggername) method is called within an
application. The Logger.properties file must be either on the WebSphere Application Server class path, or
the context class path.

The logging subsystem uses Common Base Events to represent all the messages in the WebSphere
Application Server activity.log file. You can specify your own event factory template to be used with your
loggers. Use the eventfactory property in your Logger.properties file. See [‘Sample Common Base Event]
ftemplate” on page 76|for details on the Common Base Event template.

By convention, the name of the event factory template file should be the fully qualified package name of
the package using the template. The name of the file must end with the .event.xml extension. For
example, a valid event factory template file name for the com.abc.somepackage package is:

com.abc.somepackage.event.xml

When you specify the property value for the eventfactory property in the Logger.properties file, include the
full path name with no leading slash relative to the root of your class path entry. Do not include the
.event.xml extension.

For example, if the template files from the example above are located in the com/abc/templates directory,
the valid value for the eventfactory property is:

com/abc/templates/com.abc.somepackage

Finally, if this event factory template file is used by the com.abc.somepackage.SomeClass logger, then the
following entry will appear in the Logger.properties file:

com.abc.somepackage.SomeClass.eventfactory=com/abc/templates/com.abc.somepackage

Generate Common Base Event content with the default event factory

A default Common Base Event content handler populates Common Base Events with WebSphere
Application Server runtime information. This content handler can also use a Common Base Event template
to populate Common Base Events.

The default content handler is used when the server creates CommonBaseEventLogRecords as would be
the case in the following example:

// Get a named logger

Logger logger = Logger.getLogger("com.ibm.somelogger");

// Log to the logger -- implicitly the default content handler

// will be associated with the CommonBaseEvent contained in the

// CommonBaseEventLogRecord. Togger.warning("MSG_KEY 001");

To specify a Common Base Event template in the above case, a Logger.properties file would need to be
provided with an eventfactory entry for com.ibm.someLogger. If a valid template is found on the classpath,
then the Logger’s event factory will use the specified template’s content in addition to the WebSphere
Application Server runtime information when populating Common Base Events. If the template is not found
on the classpath, or is invalid, then the Logger’s event factory will only use the WebSphere Application
Server runtime information when populating Common Base Events.
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The default content handler is also associated with the event factory home supplied in the global event
factory context. This is convenient for creating Common Base Events that need to be populated with
content similar to that generated from the WebSphere Application Server:

// Request the event factory from the global event factory home
EventFactory eventFactory = EventFactoryContext.getInstance().getEventFactoryHome().getEventFactory(templateName);

// Create a Common Base Event
CommonBaseEvent commonBaseEvent = eventFactory.createCommonBaseEvent();

// Complete the Common Base Event using content from the template (if specified above)
// and the server runtime information.
eventFactory.getContentHandler().completeEvent (commonBaseEvent);

In the above example, if the template referenced by templateName is found on the classpath, and the
template is valid, then the event factory home will return an event factory which uses a content handler
that combines the template’s content with the WebSphere Application Server runtime information when
populating Common Base Events. If the template is not found on the classpath, or is invalid, then the
event factory home will return an event factory which uses a content handler that uses only the
WebSphere Application Server runtime information when populating Common Base Events.

The default content handler populates Common Base Events in the server environment with the following
runtime information:

CommonBaseEvent.globallnstanceld
Value: The unique_record_id

Set this value only if the CommonBaseEvent.globallnstanceld value is null before the
completeEvent method is called.

CommonBaseEvent.msg
Value: A localized message that is based on the MsgDataElement element.

Set this value only if the CommonBaseEvent.msg message is null before the completeEvent
method is called.

CommonBaseEvent.severity
Value: Set based on the value of level set on the CommonBaseEventLogRecord record, if level >=
Level.SEVERE, set to 50; if level >= Level. WARNING, set to 30; the default is set to 10.

Set this value only if the CommonBaseEvent.severity value is null before the completeEvent
method is called.

CommonBaseEvent.Componentldentification.component
Value:Set based on the LoggerName value that is set on the CommonBaseEventLogRecord
record.

Set this value only if the CommonBaseEvent.Componentldentification.component is null before the
completeEvent method is called.

CommonBaseEvent.Componentldentification.componentidType
Value: "Unknown”

Set this value only if the CommonBaseEvent.Componentldentification.componentldType value is
null before the completeEvent method is called.

CommonBaseEvent.Componentidentification.executionEnvironment
Value: 0Sname[0Sarch] #0Sversion

Set this value only if the CommonBaseEvent.Componentldentification.executionEnvironment value
is null before the completeEvent method is called.

CommonBaseEvent.Componentldentification.instanceld
Value: cellName\nodeName\serverName
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Set this value only if the CommonBaseEvent.Componentldentification.instanceld value is null
before the completeEvent method is called. Set only in a server environment because this value is
ignored in a client application.

CommonBaseEvent.Componentldentification.location
Value:The host name

Set this value only if both the CommonBaseEvent.Componentidentification.location and the
CommonBaseEvent.Componentldentification.locationType values are null before the
completeEvent method is called.

CommonBaseEvent.Componentldentification.locationType
Value: The host name

Set this value only if both the CommonBaseEvent.Componentldentification.location and the
CommonBaseEvent.Componentldentification.locationType values are null before the
completeEvent method is called.

CommonBaseEvent.Componentldentification.processlid
Value: An internally generated representation of the process number.

Set this value only if the CommonBaseEvent.Componentldentification.processid value is null
before the completeEvent method is called

CommonBaseEvent.Componentldentification.subComponent
Value: Set based on values of the sourceClassName and the sourceMethodName names that are
set on the sourceClassName.sourceMethodName name of the CommonBaseEventLogRecord
record.

Set this value only if the CommonBaseEvent.Componentldentification.subComponent values is null
before the completeEvent method is called and both the sourceClassName and the
sourceMethodName names are set.

CommonBaseEvent.Componentldentification.threadid
Value: Set to the value of the Java Virtual Machine (JVM) thread name.

Set this value only if the CommonBaseEvent.Componentldentification.threadld values is null before
the completeEvent value is called.

CommonBaseEvent.Componentldentification.componentType
Value: http://www.ibm.com/namespaces/autonomic/WebSphereApplicationServer

Set this value only if the CommonBaseEvent.Componentldentification.componentType values is
null before the completeEvent method is called.

CommonBaseEvent.MsgDataElement.msgLocale
Value: Set based on the default locale of the JVM.

Set this value only if the CommonBaseEvent.msg value is null before the completeEvent method
is called.

CommonBaseEvent.Situation.categoryName
Value: ReportSituation

Set this value only if the CommonBaseEvent.Situation value is null before the completeEvent
method is called.

CommonBaseEvent.Situation.situationType.type
Value: ReportSituation

Set this value only if the CommonBaseEvent.Situation value is null before the completeEvent
method is called.

CommonBaseEvent.Situation.situationType.reasoningScope
Value: EXTERNAL
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Set this value only if the CommonBaseEvent.Situation value is null before the completeEvent
method is called.

CommonBaseEvent.Situation.situationType.reportCategory
Value: LOG

Set this value only if the CommonBaseEvent.Situation value is null before the completeEvent
method is called.

The sourceComponentldentification value is populated if no reporterComponentldentification ID exists
when the completeEvent method is invoked on the content handler. Otherwise, the
reporterComponentldentification ID is populated instead.

Best practices for logging Common Base Events in WebSphere Application Server
The following practices ensure consistent use of Common Base Events within your components, and
between your components and WebSphere Application Server components.

Follow these guidelines:

» Use a different logger for each component. Sharing loggers across components gets in the way of
associating loggers with component-specific information.

» Associate loggers with event templates that specify source component identification. This association
ensures that the source of all events created with the logger is properly identified.

» Use the same template for directly created Common Base Events (events created using the Common
Base Event factories) and indirectly created Common Base Events (events created using the Java
logging API) within the same component.

* Avoid calling the complete method on Common Base Events until you are finished adding data to the
Common Base Event and are ready to log it. This approach ensures that any decisions made by the
content handler based on data already in the event are made using the final data.

The following sample Logger.properties file entry demonstrates how to associate the
com.ibm.componentX logger with the com.ibm.componentX event factory:

com.ibm.componentX.eventfactory=com.ibm.componentX

The following sample code demonstrates the use of the same event factory setting for direct (Part 1) and
indirect (Part 2) Common Base Event logging:

<?xml version="1.0" encoding="UTF-8"?>

<TemplateEvent
version="1.0.1"
xmins:xsi=http://www.w3.0rg/2001/XMLSchema-instance
xsi:noNamespaceSchemalLocation="templateEvent.xsd">

<CommonBaseEvent
<sourceComponentId application="My application" component="com.ibm.componentX"/>
<extendedDataElements CommonBaseEventname="Sample ExtendedDataElement name" type="string">
<values>Sample ExtendedDataElement value</values>

</extendedDataElements>

< /CommonBaseEvent>

< /TemplateEvent>
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Chapter 6. Diagnosing problems (using diagnosis tools)

The purpose of this section is to aid you in understanding why your enterprise application, application
server, or WebSphere Application Server is not working and to help you resolve the problem. Unlike
performance tuning which focuses on solving problems associated with slow processes and un-optimized
performance, problem determination focuses on finding solutions to functional problems.

1. For tips on how to investigate common kinds of problems based on the component that is causing the
problem, see [Troubleshooting by component,

If deploying or running an application results in exceptions such as ClassNotFoundException,
[Class Loader Viewer|to diagnose problems with class loaders.

3. If you already have an error message and want to quickly look up its explanation and recommended

response, look up the message by expanding the Messages section of the Information Center under
Reference > Troubleshooter > Messages.

4. For help in knowing where to find error and warning messages, interpreting messages, and
configuring log files, see |Working with message Iogsl

5. Difficult problems can require the use of tracing, which exposes the low-level flow of control and
interactions between components. For help in understanding and using traces, see [Working with
fracel

6. For help in adding log and trace capability to your own application, see |“Log and trace with Java|
[logging” on page 19.|

7. For help in using settings or tools to help you diagnose the problem, see Working with
troubleshooting tools| Some of these tools are bundled with the product, and others are freely
downloadable.

8. To learn how to work with Diagnostic Providers, see Working with Diagnostic Providers|..

9. To find out how to look up documented problems, common mistakes, WebSphere Application Server
prerequisites, and other problem-determination information on the WebSphere Application Server
public Web site, or to obtain technical support from IBM, see [Obtaining help from IBM|

10. The(Troubleshoot IBM Developer Kit for Javal describes debugging techniques and the diagnostic
tools that are available to help you solve problems with Java. It also gives guidance on how to submit
problems to IBM.

11. For current information available from IBM Support on known problems and their resolution, see the
IBM Supporf page. For last minute updates, limitations, and known problems, refer to the Release
notes section.

12. IBM Support has documents that can save you time gathering information needed to resolve this
problem. Before opening a PMR, see the|Must éather_ documents page for information to gather to
send to IBM Support.

n

Troubleshooting class loaders

Class loaders find and load class files. For a deployed application to run properly, the class loaders that
affect the application and its modules must be configured so that the application can find the files and
resources that it needs. Diagnosing problems with class loaders can be complicated and time-consuming.
To diagnose and fix the problems more quickly, use the administrative console Class Loader Viewer to
examine class loaders and the classes loaded by each class loader.

This topic assumes that you have installed an application on a server supported by WebSphere
Application Server and you want to examine class loaders used by the application or its modules. The
modules can be Web modules (.war files) or enterprise bean (EJB) modules (. jar files). The Class Loader
Viewer enables you to examine class loaders in a runtime environment.
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This topic also assumes that you have enabled the class loader viewer service. Click Servers >
Application servers > server_name > Class Loader Viewer Service, enable the service and restart the
server.

The runtime environment of WebSphere Application Server uses the following class loaders to find and
load new classes for an application in the following order:

1. The bootstrap, extensions, and CLASSPATH class loaders created by the Java virtual machine
2. A WebSphere extensions class loader

3. One or more application module class loaders that load elements of enterprise applications running in
the server

4. Zero or more Web module class loaders

Java class loaders

WebSphere extensions

class loader
Application module class loader Application module class loader

Web module class loader Web module class loader

Each class loader is a child of the previous class loader. That is, the application module class loaders are
children of the WebSphere extensions class loader, which is a child of the CLASSPATH Java class loader.
Whenever a class needs to be loaded, the class loader usually delegates the request to its parent class
loader. If none of the parent class loaders can find the class, the original class loader attempts to load the
class. Requests can only go to a parent class loader; they cannot go to a child class loader. After a class
is loaded by a class loader, any new classes that it tries to load reuse the same class loader or go up the
precedence list until the class is found.

If the class loaders that load the artifacts of an application are not configured properly, the JVM might
throw a class loading exception when starting or running that application. [‘Class loading exceptions” on|
describes the types of exceptions caused by improperly configured class loaders and suggests
ways to use the Class Loader Viewer to correct configurations of class loaders. The types of exceptions
include:

« [ClassCastException|

« [ClassNotFoundException|

+ [NoClassDefFoundException|

« [UnsatisfiedLinkErrof

The steps that follow describe generally how to use the Class Loader Viewer to examine class loaders and
correct problems with application or class loader configurations.

» Examine a tree view that lists all installed applications and their modules. The modules can be Web
modules (.war files) or EJB modules (. jar files).

Click Troubleshooting > Class Loader Viewer to access the |Enterprise Applications Topology pagel
* Examine the class loader delegation hierarchy.

On the Enterprise Applications Topology page, select a module to access the|CIass Loader Viewed
The page lists the class loaders visible to Web and EJB modules in an installed enterprise
application. This page helps you to determine which class loaders loaded files of a module and to
diagnose problems with class loaders.
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The delegation hierarchy is determined by the class loader delegation mode, or class loader order,
specified for an application or Web module. The mode value can be either Classes loaded with parent
class loader first or Classes loaded with application class loader first. Refer to the

class loaders| step for more information.

Export information on class loaders.
1. On the|Class Loader Viewer page] click Export.

2. Select to open a browser or editor on the class loader information or to save the information to disk
in XML format.

3. Click OK, and specify any additional information requested by the system.
Display information about class loaders visible to the module in an HTML table format.

On the[Class Loader Viewer page} click Table View. The Table View page displays the following
information:

Class loader attribute |Description

Delegation Indicates whether the class loader delegates the loading of the module to its parent class
loader. A value of true implies that the class loader of the parent application is being used
(Parent first or Classes lToaded with parent class loader first). A value of false
implies that the module class loader is being used (Parent last or Classes Toaded with
application class loader first). Refer to the [Configure class loaderg step for more

information.
Classpath Lists the paths over which the class loader searches for classes and resources.
Classes Lists the names of classes loaded in the JVM by this class loader.

The Table View option does not return a value when out-of-memory errors are generated. The
out-of-memory errors might be related to a memory leak. To examine information about class loaders in
a table, resolve the out-of-memory problem, and then click Table View again.

Search class loaders.

On the Class Loader Viewer page, click Search to access the , on which you can search
class loaders for the following:

— Specific strings

— Specific . jar files

— The names of files in a specific directory

— The names of files loaded by a specific class loader

The search is case-sensitive. [‘Class loading exceptions” on page 92 describes several uses of the
Search page.

Configure class loaders. You can configure class loaders for the following:
— All applications installed on a specific server.

— A specific application

— A specific Web module

Note: For detailed information about server, application, and Web class loaders, see the chapter on
class loading in the Developing and deploying applications PDF book.

Class loader configuration determines which class loader loads the classes and resource files for an
application or Web module. Application and WAR module class loader configuration settings include
Class loader order and WAR class loader policy.

A Class loader order value can be either Classes Toaded with parent class Toader first or Classes
Toaded with application class loader first. The default is Classes Toaded with parent class
loader first. A class loader with the Classes loaded with parent class Toader first mode
delegates loading a class or resource to its immediate parent class loader before searching its
classpath.
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When troubleshooting class loading problems, you might need to override classes visible to a parent
class loader. To override such classes with those specific to an application, set the Class loader order
to Classes Toaded with application class loader first on the class loader that contains the
application classes on its classpath. An application can override classes visible to a parent class loader,
but doing so can result in a ClassCastException or UnsatisfiedLinkError if there is a mixed use of
overridden classes and non-overridden classes.

For example, under default class loader policies, a Web module has its own Web module (WAR) class
loader to load its artifacts, which are typically in the WEB-INF/classes and WEB-INF/1ib directories. An
application module class loader is the immediate parent of this WAR class loader. To ensure that the
Web module class loader searches these paths for a particular class or resource first, before delegating
the load operation to the application module class loader, set the Class loader order of the Web
module to Classes Toaded with application class loader first.

Class loader policies determine the structure of the application and WAR module class loaders. Under
the default policies, every running application EAR has its own application module class loader, and
every Web module has its own WAR module class loader. The default policies ensure J2EE compliance
regarding visibility and isolation among application artifacts. Changing the default policies is not
suggested when troubleshooting class loading problems.

If you continue to have class loader problems, refer to[‘Class loading exceptions’] and to the class loading
chapter of the Developing and deploying applications PDF book.

Class loading exceptions

What kind of class-loading error do you see when you develop an application or start an installed
application?

+ [‘ClassCastException’]

+ [“ClassNotFoundException” on page 93

+ [‘NoClassDefFoundException” on page 95|

» |“UnsatisfiedLinkError’ on page 95|

ClassCastException

A class cast exception results when the following conditions exist and can be corrected by the following
actions:

« [The type of the source object is not an instance of the target class (type).|

« [The class loader that loaded the source object (class) is different from the class loader that loaded the]
target class.|

« [The application fails to perform or improperly performs a narrow operation.|

The type of the source object is not an instance of the target class (type).
This is the typical class cast exception. You can diagnose whether the source object of a cast
statement is not an instance of the target class (type) by examining the class signature of the
source object class, then verifying that it does not contain the target class in its ancestry and the
source object class is different than the target class. You can obtain class information by inserting
a simple print statement in your code. For example:

System.out.printin( source.getClass().getName() + ":" + target.getClass().getName() );

Or use a javap command. For example:

javap java.util.HashMap
Compiled from "HashMap.java"
public class java.util.HashMap extends java.util.AbstractMap
implements java.util.Map,java.lang.Cloneable,java.io.Serializable {

The class loader that loaded the source object (class) is different from the class loader that loaded
the target class.
Assuming that the type of the source object is an instance of the target class, a class cast
exception occurs when the class loader that loaded the source object’s class is different that the
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class loader that loaded the target class. This condition might occur when the target class is

visible on the classpaths of more than one class loader in the WAS runtime environment. To

correct this problem, use the Search and Search by Class Name console pages used to diagnose

problems with class loaders:

1. Click Troubleshooting > Class Loader Viewer > module_name > Search to access the
[Search pagd

2. For Search String, type the name of the class that is loaded by two class loaders.

3. For Search Type, select Class/Package.

4. Click OK. The Search by Class Name page is displayed, listing all class loaders that load the
class.

If there is more than one class loader listed, then the target class was loaded by more than
one class loader. Because the source object is an instance of the target class, the class loader
that loaded the source object class is different from the class loader that loaded the target
class.

5. Return to the|Class Loader Viewer page|and examine the classpath to determine why two
different class loaders load the class.

6. Correct your code so that the class is visible only to the appropriate class loader.

The application fails to perform or improperly performs a narrow operation.
A class cast exception can occur because, when the application is resolving a remote enterprise
bean (EJB) object, the application code does not perform a narrow operation as required. The
application must perform a narrow operation after looking up a remote object. Examine the
application and determine whether it looks up a remote object and, if so, the result of the lookup is
submitted to a narrow method.

The narrow method must be invoked according to the EJB 2.0 programming model. In particular,
the target class submitted to the narrow method must be the exact, most derived interface of the
EJB. This also causes a class cast exception in the WAS runtime environment. Examine the
application and determine whether the target class submitted to the narrow method is a
super-interface of the EJB that is specified, not the exact EJB type; if so, modify the application to
invoke narrow with the exact EJB interface.

Lastly, if a class cast exception occurs during a narrow operation, verify that the narrow method is
being applied to the result of a remote EJB lookup, not to a local EJB. A narrow is not used for
local lookups. Examine the application or module deployment descriptor to ensure that the object
being narrowed is not a local object.

ClassNotFoundException

A class not found exception results when the following conditions exist and can be corrected by the
following actions:

« [The class is not visible on the logical classpath of the context class loader|

« [The application incorrectly uses a class loader AP

« [A dependent class is not visible.|

The class is not visible on the logical classpath of the context class loader.
The class not found is not in the logical class path of the class loader associated with the current
thread. The logical classpath is the accumulation of all classpaths searched when a load operation
is invoked on a class loader. To correct this problem, use the Search page to search by class
name and by Java archive (JAR) name:

1. Click Troubleshooting > Class Loader Viewer > module_name > Search to access the class

loader|Search page

2. For Search String, type the name of the class that is not found.
For Search Type, select Class/Package.

4. Click OK. The Search by Class Name page is displayed, listing all class loaders that load the
class.

w
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5. Examine the page to see if the class exists in the list.

6. If the class is not in the list, return to the Search page. For Search String, type the name of
the . jar file for the class; for Search Type, select JAR/Directory.

7. Click OK. The Search by Path page is displayed, listing all directories that hold the JAR file.

If the JAR file is not in the list, the class likely is not in the logical class path, not readable or an
alternate class is already loaded. Move the class to a location that enables it to be loaded.

The application incorrectly uses a class loader API.
An application can obtain an instance of a class loader and call either the loadClass method on
that class loader, or it can call Class.forName(class_name, initialize, class_loader) with that class
loader. The application may be incorrectly using the class loader application programming interface
(API). For example, the class name is incorrect, the class is not visible on the logical classpath of
that class loader, or the wrong class loader was engaged.

To correct this problem, determine whether the class exists and whether the application is properly
using the class loader API. Follow the steps in[The class is not visible on the logical classpath of|
fthe context class loader] to determine whether the class is loaded. If the class has not been
loaded, attempt to correct the application and see if the class loads. If the class is in the class
path with proper permission and is not being overridden by another factory class, examine the API
used to load the class.

1. Click Troubleshooting > Class Loader Viewer > module_name > Search to access the class
loader([Search page]

2. For Search String, type the name of the class.

For Search Type, select Class/Package.

4. Click OK. The Search by Class Name page is displayed, listing all class loaders that load the
class.

5. Examine the page to see if the class exists in the list.

6. If the class is in the list and a ClassNotFound exception was thrown, then the .jar file or class
is not in the correct context or a wrong API call in the current context was used.

If the class is not in the list, return to the Search page and do the following:

a. Search for the class that generated the exception; that is, the class calling Class.forName.

b. See which class loader loads the class.

c. Determine whether the class loader has access or can load the class not found by
evaluating the class path of the class loader.

w

A dependent class is not visible.
When a class loader clsldr loads a class cls, the Java virtual machine (JVM) invokes clsldr to load
the classes on which cls depends. Dependent classes must be visible on the logical classpath of
clsldr, otherwise an exception occurs. This condition typically occurs when users make
WebSphere Application Server classes visible to JVM, or make application classes visible to the
JVM or to the WebSphere extensions class loader. For example:
* Class A depends on Class B.
» Class A is visible to the WebSphere extensions class loader.
+ Class B is visible on the local classpath of a WAR module class loader, not the WebSphere

extensions class loader classpath.

When the JVM loads class A using the WebSphere extensions class loader, it then attempts to
load Class B using the same class loader and ultimately creates a class not found exception.

To correct this problem:

1. Make the application-specific classes visible to the appropriate application class loader.

2. Search for the class not found (Class B).

3. If Class B is in the proper location, [search for the class| that loads the dependent class (Class
A) in the Class Load Viewer.

4. |If the class is loaded and a ClassNotFound exception was thrown, then the . jar file or class is
not in proper context or the wrong API call in the current context was used.
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If no class was found, do the following:
a. Search for the class that generated the exception; that is, the class calling Class.forName.
b. See which class loader loads the class.
c. Determine whether the class loader has access or can load the class not found by
evaluating the class path of the class loader.
5. Ensure that the caller class (Class B) is visible to the JVM or WebSphere extensions class
loader.

NoClassDefFoundException

A no class definition found exception results when the following conditions exist and can be corrected by
the following actions:

The class is not in the logical class path.
Refer to [‘ClassNotFoundException” on page 93| for information.

The class cannot load.
There are various reasons for a class not loading. The reasons include: failure to load the
dependent class, the dependent class has a bad format, or the version number of a class.

UnsatisfiedLinkError

A linkage error results when the following conditions exist and can be corrected by the following actions:
+ [A user action caused the error]

+ [System.mapLibraryName returns the wrong library file)

+ [The native library is already loaded.|

+ [A dependent native library was used)

A user action caused the error.
Several user actions can result in a linkage error:
A library extension name is incorrect for the platform.
System.loadLibrary is passed an incorrect parameter.

The library is not visible.
As a best practice, use the JVM class loader to find or load native libraries. WebSphere
Application Server prints the Java library path (java.library.path) when starting up. If the
JVM class loader is intended to load the library, verify that the path containing the native
library file is in the Java library path. If not, append the path to the platform-specific native
library environment variable or to the java.library.path system property of the server
process definition.

In general, the Java virtual machine invokes findLibrary() on the class loader xxx that
loads the class that calls System.loadLibrary(). If xxx.findLibrary() fails, the Java virtual
machine attempts to find the library using the JVM class loader, which searches the JVM
library path. If the library cannot be found, the Java virtual machine creates an
UnsatisfiedLinkError exception.

Thus, if a WebSphere class loader is intended to find a native library myNativelib, the
library must be visible on the nativelibpath of the class loader that loads the class that
calls System.loadLibrary(myNativelLib). This practice is necessary or desirable in the
following situation:

» Shared libraries have a Native Library Path in their configuration. Because shared
libraries enable the versioning of application-specific libraries, consider specifying the
paths to any native libraries used by the shared library code in the shared library
configuration.
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Ensure that the correct WebSphere class loader loads the class that calls
System.loadLibrary() and that the native library is visible on the Native Library Path
setting.

The native library is already loaded.
This condition can result from either of the following errors:

User error

Check for multiple calls to System.loadLibrary and remove any extraneous calls.

Error when an application restarts
Invoke System.loadLibrary() within the static initialization of a class within a server-scoped
shared library:

1.

2.

4.
5.

Remove all instances of the System.loadLibrary(MyNativeLib) call from the application
source code.

Create a new class named LibLoader that calls System.loadLibrary(MyNativeLib)
within a static block. For example:

public class LibLoader {

static {System.loadLibrary(MyNativelib);}
public LibLoader();

}

Create a server-scoped shared library.

a. Create a shared library, set its scope to server, and name it MySharedLib.

b. Go to the settings page for the shared library.

c. Set Classpath to the path containing the class LibLoader.

d. Set Native Library Path to the path containing the native library MyNativeLib.

e. Create a class loader on the server hosting the application.

f. Associate MySharedLib to the new server class loader. Refer to step 2 in the
Associating shared libraries with servers section of the Administering applications
and their environment PDF book.

Save your changes.

Redeploy the application and rerun the scenario.

For more information about invoking, creating, and managing shared libraries, read
Managing shared libraries in the Administering applications and their environment PDF
book.

Classes within server-scoped libraries are loaded once for each server lifecycle, ensuring
that the native library required by the application is loaded once for each Java virtual
machine, regardless of the application’s life cycle.

A dependent native library was used.
Dependent native libraries must be found or loaded by the JVM class loader. That is, if a native
library NL is dependent on another native library, DNL, the JVM class loader must find DNL on the
Java library path. This is because the JVM runs native code when loading NL; when it encounters
the dependency on DNL, the JVM native code can call only to the JVM class loader to resolve the
dependency. A WebSphere class loader cannot load a dependent native library.

Modify the platform-specific environment variable defining the Java library path (LIBPATH) to
include the path containing the unresolved native library.

Class loader viewer service settings

Use this page to configure the server to start the class loader viewer service when the server starts. The
Class Loader Viewer helps you diagnose problems with class loaders.

To view this administrative console page, click Servers > Application servers > Class Loader Viewer

Service.
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Class loaders find and load class files. For a deployed application to run properly, the class loaders that
affect the application and its modules must be configured so that the application can find the files and
resources that it needs. Diagnosing problems with class loaders can be complicated and time-consuming.
To diagnose and fix the problems more quickly, enable the class loader viewer service on this page and
then use the console Class Loader Viewer to examine class loaders and the classes loaded by each class
loader. Click Troubleshooting > Class Loader Viewer to access the Class Loader Viewer in the console.

Enable service at server startup
Specifies whether or not the server attempts to start the class loader viewer service when the server
starts.

The default is not to start the class loader viewer service.

Enterprise application topology

Use this page to see where modules reside in a topology of enterprise applications. Knowing where a
module resides helps you to determine which class loader loaded a module and to diagnose problems with
class loaders.

To view this administrative console page, click Troubleshooting > Class Loader Viewer. This page lists
all installed applications and their modules in a tree view. The modules can be Web modules (.war files) or
enterprise bean (EJB) modules (. jar files).

When deploying an application to a server or starting an application, you might encounter problems related
to class loaders. Use the console pages accessed from this page to troubleshoot errors such as the
following:

» ClassCastException

» ClassNotFoundException

* NoClassDefFoundException

» UnsatisfiedLinkError

You can use the Class Loader Viewer console pages without having to restart or manipulate the
application.

Enterprise Applications Topology
Displays a tree hierarchy of applications installed on a server and lists the module files in the class paths
of the applications.

Expand the hierarchy for an application to see what Web modules (.war files) and EJB modules (.jar
files) are in the application class path.

Click on a module name to examine the class loaders of the module.

Class loader viewer settings

Use this page to examine the class loaders visible to a Web module (.war file) or enterprise bean (.ejb
file) in an installed enterprise application. This page helps you to determine which class loaders loaded
files of a module and to diagnose problems with class loaders.

To view this administrative console page, click Troubleshooting > Class Loader Viewer > module_name.

To learn more about classes used by the module and their class loaders, click a button:

Button Resulting action
Export Opens a dialog that enables you to view or save the Class Loader information on this page in an
XML file.
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Button Resulting action
Table View Displays the View page, which provides information about class loaders visible to the module in
an HTML table format for each class loader. Such information includes:
Delegation
Whether the class loader delegates a load operation to its immediate parent before
searching its local classpath for a class or resource
Classpath
The local classpath, which includes the paths over which the class loader searches for
classes and resources, excluding the classpaths of any parent class loaders.
Classes
The names of classes loaded by the class loader
Search Displays the Search page, on which you can search class loaders for the following:

» Specific strings

» Specific . jar files

» The names of files in a specific directory

* The names of files loaded by a specific class loader

Class Loader

Displays a tree hierarchy of class loaders that affect the loading of classes used by the Web or EJB

module.

Expand the hierarchy of class loaders to view the following:
» Class loader names

* Arrows that point upwards beside class loader names, indicating that requests can go to a parent class
loader only and not go to a child class loader

* The names of classes that are loaded by a class loader
* The paths of property files and . jar files used by the classes

The following class loaders might be in the hierarchy:

Class loader name Description

JDK Extension Loader The JDK extensions class loader is a composite class loader that is

comprised of the Java virtual machine (JVM) bootstrap class loader, the
JVM extensions class loader and the JVM system classloader, which load
the core SDK classes and resources as well as classes and resources
visible on the JVM classpath.

WAS Extension Class Loader The WAS Extension Class Loader loads the WebSphere Application Server

classes, standalone resource classes, custom service classes, and custom
registry classes. At bootstrap, this class loader uses the ws.ext.dirs system
property to determine the path that is used to load classes. Each directory
in the ws.ext.dirs class path and every .jar file or .zip file in these
directories is added to the class path used by this class loader.

WAS Compound Class Loader The WAS Compound Class Loaders load classes and resources of

application (EAR) modules, Web (WAR) modules, and server-associated
shared libraries. Under default class loader policies, an instance of a WAS
Compound Class Loader exists for each running EAR and WAR module
and for each class loader defined in the server configuration.

Click on Classes to view a list of classes loaded by a class loader.

The Class Loader Viewer service must be enabled to view the list of classes.
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Search settings

Use this page to search for information about class loaders visible to a Web module (.war file) or
enterprise bean (.ejb file) in an installed enterprise application. This page helps you diagnose problems
with class loaders.

To view this administrative console page, click Troubleshooting > Class Loader Viewer > module_name
> Search.

On the Search page, you can search class loaders for the following:
» Specific strings

» Specific . jar files

* The names of files in a specific directory

* The names of files loaded by a specific class loader

Search type
Specifies the type of items in which to search for the string.

Search type Instructions and resulting action

Class/Package In the Search term(s) field, type a class name or package name. After you select this search
type and click Go, the program searches class loaders for a class or package name. The
program displays a list of classes and packages that have the string in their name.

JAR/Directory In the Search term(s) field, type a . jar file name or directory name. After you select this
search type and click Go, the program searches class loaders for a . jar file or directory
name. The program displays a list of . jar files that have the string in their name and of all
files in directories that have the string in their name.

Search term(s)
Specifies the string to be found in the items searched.

The search is case-sensitive. If the search string is classname, the string ClassName is not found.

The search matches the entire string. If the search type is Jar/Directory and the search string is
C:/WebSphere/AppServerd0603.185/java/jre/1ib/ext/CmpCrmf. jar, the entire path of the JAR file is
matched. If the search type is Jar/Directory and the search string is Cmp, the string Cmp is not found.

The search supports limited regular expressions. It supports the wildcard characters asterisk (*), question
mark (?), and percent sign (%). The wildcard characters * and % match zero or more characters; ? matches
exactly one character.

Search string Resulting matches

*Cmp* ltems that have Cmp in their name

*Cmp*.jar ltems that have Cmp in their name and that end in . jar

%Cmp% ltems that have Cmp in their name

%Cmp%.jar ltems that have Cmp in their name and that end in . jar

*Cmp?rmf. jar ltems that have a name with any characters before Cmp, then any one character,
and then rmf.jar

The search supports full regular expressions if the value for the search string starts and ends with a
forward slash (/).

Search string Resulting matches

/.*Cmp.*/ ltems that contain any character before and after Cmp in their name
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Search string Resulting matches

/.*Cmp.*\.jar/ ltems that have Cmp in their name and that end in . jar

/.*Cmp?rmf\.jar/ ltems that have a name with any characters before Cmp, then any one character,
and then rmf.jar

/.+\d\.jar/ ltems with a name that ends in a number followed by . jar

Diagnosing problems with message logs

WebSphere Application Server can write system messages to several general purpose logs, including
JVM, process, and IBM service logs, which can be examined for problem determination.

The JVM logs are created by redirecting the System.out and System.err streams of the JVM to
independent log files. WebSphere Application Server writes formatted messages to the System.out stream.
In addition, applications and other code can write to these streams using the print() and printin()
methods defined by the streams. Some Developer Kit built-ins such as the printStackTrace() method on
the Throwable class can also write to these streams. Typically, the System.out log is used to monitor the
health of the running application server. The System.out log can be used for problem determination, but it
is recommended to use the IBM Service log and the advanced capabilities of the Log and Trace Analyzer
instead. The System.err log contains exception stack trace information that is useful when performing
problem analysis.

Important: This Log and Trace Analyzer tool is different from the Log and Trace Analyzer tool available on
the WebSphere® Application Server Toolkit CD-ROM. For information on the WebSphere® Application
Server Toolkit Log and Trace Analyzer, refer to the Detecting and analyzing runtime problems
documentation provided with the WebSphere® Application Server Toolkit.

Because each application server represents a JVM, there is one set of JVM logs for each application
server and all of its applications located by default in the following directory:

* profile_root/logs/server_name

In the case of a WebSphere Application Server Network Deployment configuration, JVM logs are also
created for the deployment manager and each node agent because they also represent JVMs.

The process logs are created by redirecting the STDOUT and STDERR streams of the process to independent
log files. Native code, including the Java virtual machine (JVM) itself, writes to these files. As a general
rule, WebSphere Application Server does not write to these files. However, these logs can contain
information relating to problems in native code or diagnostic information written by the JVM.

As with JVM logs, there is a set of process logs for each application server, since each JVM is an
operating system process, and in the case of a WebSphere Application Server Network Deployment
configuration, a set of process logs for the deployment manager and each node agent.

The IBM service log contains both the WebSphere Application Server messages that are written to the
System.out stream and some special messages that contain extended service information that is normally
not of interest, but can be important when analyzing problems. There is one service log for all WebSphere
Application Server JVMs on a node, including all application servers. The IBM Service log is maintained in
a binary format and requires a special tool to view. This viewer, the Log and Trace Analyzer, provides
additional diagnostic capabilities. In addition, the binary format provides capabilities that are utilized by IBM
support organizations.

In addition to these general purpose logs, WebSphere Application Server contains other specialized logs
that are specific to a particular component or activity. For example, the HTTP server plug-in maintains a
special log. Normally, these logs are not of interest, but you might be instructed to examine one or more of
these logs while performing specific problem determination procedures. For details on how and when to
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view the plug-in log, see the Accessing a Web resource through the application server and bypassing the
HTTP server subsection of the|A Web resource does not display|topic.

Sometimes server and application problems can be diagnosed by examining log output from the
WebSphere Application Server.

Determine which type of logs you would like to implement:

* YWM Iog§|
. :Process Iog§|

IBM service logs|

Viewing JVM logs
The Java virtual machine (JVM) logs are written as plain text files. Therefore there are no special
requirements to view these logs.

Use either of two techniques to view the JVM logs for an application server:
» Use the administrative console, which also supports viewing the JVM logs from a remote machine.
* Use a text editor on the machine where the logs are stored.

1. View the JVM logs from the administrative console.
a. Start the administrative console.

b. Click Troubleshooting > Logs and Trace in the console navigation tree. To view the logs for a
particular server, click on the server name to select it, then click JVM Logs.

c. Select the runtime tab.
d. Click View corresponding to the log you want to view.
2. View the JVM logs from the machine where they are stored.
a. Go to the machine where the logs are stored.
b. Navigate to the [profile_roo}/logs/server_name directory and select SystemOut.log or SystemErr.log.
c. Open the file in a text editor or drag and drop the file into an editing and viewing program.

JVM log interpretation

The JVM logs contain print data written by applications. The application can write this data directly in the
form of System.out.print(), System.err.print(), or other method calls. The application can also write
data indirectly by calling a JVM function, such as an Exception.printStackTrace(). In addition, the
System.out JVM log contains system messages written by the WebSphere Application Server.

You can format application data to look like WebSphere Application Server system messages by using the
Installed Application Output field of the JVM Logs properties panell or as plain text with no additional
formatting. WebSphere Application Server system messages are always formatted. Depending on how the
JVM log is configured, formatted messages can be written to the JVM logs in either basic or advanced
format.

Message formats

Formatted messages are written to the JVM logs in one of two formats:
Basic Format

The format used in earlier versions of WebSphere Application Server.
Advanced Format

Extends the basic format by adding information about an event, when possible.
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Basic and advanced format fields

Basic and Advanced Formats use many of the same fields and formatting techniques. The various fields
that may be found in these formats follow:
TimeStamp
The timestamp is formatted using the locale of the process where it is formatted. It includes a fully
qualified date (for example YYMMDD), 24 hour time with millisecond precision and a time zone.
Threadld
An 8 character hexadecimal value generated from the hash code of the thread that issued the
message.
ThreadName
The name of the Java thread that issued the message or trace event.
ShortName
The abbreviated name of the logging component that issued the message or trace event. This is
typically the class name for WebSphere Application Server internal components, but can be some
other identifier for user applications.
LongName
The full name of the logging component that issued the message or trace event. This is typically
the fully qualified class name for WebSphere Application Server internal components, but can be
some other identifier for user applications.
EventType
A one character field that indicates the type of the message or trace event. Message types are in
upper case. Possible values include:

F A Fatal message.
E An Error message.
w A Warning message.
A An Audit message.
| An Informational message.
C An Configuration message.
D A Detail message.
o A message that was written directly to System.out by the user application or internal
components.
R A message that was written directly to System.err by the user application or internal
components.
z A placeholder to indicate the type was not recognized.
ClassName
The class that issued the message or trace event.
MethodName

The method that issued the message or trace event.
Organization

The organization that owns the application that issued the message or trace event.
Product

The product that issued the message or trace event.
Component

The component within the product that issued the message or trace event.

Basic format
Message events displayed in basic format use the following format. The notation <name> indicates

mandatory fields that will always appear in the basic format message. The notation [name] indicates
optional or conditional fields that will be included if they can be determined.

<timestamp><threadId><shortName><eventType>[className] [methodName]<message>
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Advanced format

Message events displayed in advanced format use the following format. The notation <name> is used to
indicate mandatory fields that will always appear in the advanced format for message entries. The notation
[name] is used to indicate optional or conditional fields that will be included if they can be determined.

<timestamp><threadId><eventType><UOW><source=1ongName>[className]
[methodName] <Organization><Product><Component>
[thread=threadName]<message>

Configuring the JVM logs

Use the administrative console to configure the JVM logs for an application server. Configuration changes
for the JVM logs that are made to a running application server are not applied until the next restart of the
application server.

Start the administrative console

Click Troubleshooting > Logging and Tracing, then click server > JVM Logs.
Select the Configuration tab.

Scroll through the panel to display the attributes for the stream to configure.
Change the appropriate configuration attributes and click Apply.

6. Save your configuration changes.

o M~ wnh -

Java virtual machine (JVM) log settings
Use this page to view and modify the settings for the Java virtual machine (JVM) System.out and
System.err logs.

To view this administrative console page, click Troubleshooting > Logs and Trace >server name > JVM
Logs.

View and modify the settings for the Java Virtual Machine (JVM) System.out and System.err logs for this
managed process. The JVM logs are created by redirecting the System.out and System.err streams of the
JVM to independent log files. The System.out log is used to monitor the health of the running application
server. The System.err log contains exception stack trace information that is useful when performing
problem analysis. There is one set of JVM logs for each application server and all of its applications. JVM
logs are also created for the deployment manager and each node manager. Changes on the Configuration
panel will apply when the server is restarted. Changes on the Runtime panel will apply immediately.

File Name:
Specifies the name of one of the log file described on this page.

The first file name field specifies the name of the System.out log. The second file name field specifies the
name of the System.err file.

Press the View button on the Runtime tab to view the contents of a selected log file.

The file name specified for the System.out log or the System.err log must have one of the following

values:

filename
The name of a file in the file system. It is recommended that you use a fully qualified file name. If
the file name is not fully qualified, it is considered to be relative to the current working directory for
the server. Each stream must be configured with a dedicated file. For example, you cannot redirect
both System.out and System.err to the same physical file.
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If the directory containing the file already exists, the user ID under which the server is running
requires read/write access to the directory. If the directory does not exist, it will be created with the
proper permissions. The user id under which the server is running must have authority to create
the directory.

console
This is a special file name used to redirect the stream to the corresponding process stream. If this
value is specified for System.out, the file is redirected to stdout. If this value is specified for
System.err, the file is redirected to stderr.

none Discards all data written to the stream. Specifying none is equivalent to redirecting the stream to
dev/null on an operating system such as AIX of Linux.

The default path for filename is the value of the variable SERVER_LOG_ROOT. To see the value of the
SERVER_LOG_ROQT variable:

1. On the administrative console, select Environment > WebSphere Variables

2. Click on the Server radio button, and then click Apply. The value of the SERVER_LOG_ROOT
variable appears in the resulting list.

To change the value of SERVER_LOG_ROOT:

1. Select SERVER_LOG_ROOT

2. Enter a new path in the Value field

3. Click Apply

4. Save the configuration. You will have to restart the server for the change to take effect.

You can also change the location and name of the ${SERVER_LOG_ROOT}/SystemOut.log and
${SERVER_LOG_ROOT}/SystemErr.log files to any other absolute path and filename (for example,
/tmp/myLodfile.log).

File formatting:
Specifies the format to use in saving the System.out file.

Log file rotation: Use this set of configuration attributes to configure the System.out or System.err log
file to be self-managing.

A self-managing log file writes messages to a file until reaching either the time or size criterion. At the
specified time or when the file reaches the specified size, logging temporarily suspends while the log file
rolls over, which involves closing and renaming the saved file. The new saved file name is based on the
original name of the file plus a timestamp qualifier that indicates when the renaming occurs. Once the
renaming completes, a new, empty log file with the original name reopens and logging resumes. All
messages remain after the log file rollover, although a single message can split across the saved and the
current file.

You can only configure a log to be self-managing if the corresponding stream is redirected to a file.

File Size
Click this attribute for the log file to manage itself based on its file size. Automatic roll over occurs
when the file reaches the specified size you specify in the maximum size field.

Maximum Size
Specify the maximum size of the file in megabytes. When the file reaches this size, it rolls over.

This attribute is only valid if you click File size.

Time Click this attribute for the log file to manage itself based on the time of day. At the time specified in
the start time field, the file rolls over.

Start Time
Specify the hour of the day, from 1 to 24, when the periodic rollover algorithm starts for the first
time after an Application Server restart. The algorithm loads at Application Server startup. Once
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started at the (start time field) hour, the rollover algorithm rolls the file every (repeat time field)
hours. This rollover pattern continues without adjustment until the Application Server stops.

Note: The rollover always occurs at the beginning of the specified hour of the day. The first hour
of the day, which starts at 00:00:00 (midnight), is hour 1 and the last hour of the day, which
starts at 23:00:00, is hour 24. Therefore, if you want log files to roll over at midnight, set the
start time to 1.

Repeat time
Specifies the number of hours after which the log file rolls over. Valid values range from 1 to 24.

Configure a log file to roll over by time, by size, or by time and size. Click File Size and Time to roll the
file at the first matching criterion. For example, if the repeat time field is 5 hours and the maximum file size
is 2 MB, the file rolls every 5 hours, unless it reaches 2 MB before the interval elapses. After the size
rollover, the file continues to roll at each interval.

Maximum Number of Historical Log Files: Specifies the number of historical (rolled) files to keep. The
stream writes to the current file until it rolls. At rollover, the current file closes and is saved as a new name
consisting of the current name plus the rollover timestamp. The stream then reopens a new file with the
original name to continue writing. The number of historical files grows from zero to the value of the
maximum number of historical files field. The next rollover deletes the oldest historical file.

Installed Application Output: Specifies whether System.out or System.err print statements issued from
application code are logged and formatted.
Show application print statements
Click this field to show messages that applications write to the stream using print and printin
stream methods. WebSphere Application Server system messages always appear.
Format print statements
Click this field to format application print statement like WebSphere Application Server system
messages.

Process logs

WebSphere Application Server processes contain two output streams that are accessible to native code
running in the process. These streams are the stdout and stderr streams. Native code, including Java
virtual machines (JVM), might write data to these process streams. In addition, JVM provided System.out
and System.err streams can be configured to write their data to these streams also.

By default, the stdout and stderr streams are redirected to log files at application server startup, which
contain text written to the stdout and stderr streams by native modules (*SRVPGMs, .dlls, .exes, UNIX
libraries, and other modules). By default, these files are stored as logs/server_name/

native_stderr.log and logs/native_stdout.log.

Configuring the service log

By default, the service log is shared among all server processes for a node. The configuration values for
the service log are inherited by each server process from the node configuration. You can configure a
separate service log for each server process by overriding the configuration values at the server level.

1. Start the administrative console.

2. Click Troubleshooting > Logs and Trace > server_name > IBM Service Logs.

3. Select the Enable box to enable the service log, clear the check box to disable the log.
4. Set the name for the service log.

The default name is Iogs/activity.log. If the name is changed, the run time requires write
access to the new file, and the file must use the .log extension.

5. Set the maximum file size. Specifies the number of megabytes to which the file can grow. When the
file reaches this size, it wraps, replacing the oldest data with the newest data.
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6. Set the message filter level to the desired state.
7. Save the configuration.
8. Restart the server to apply the configuration changes.

IBM service log settings
To view this administrative console page, click Troubleshooting > Logs and Trace > server name > IBM
Service Logs.

Use this panel to configure the IBM service log, also known as the activity log. The IBM service log
contains both the WebSphere Application Server messages that are written to the System.out stream and
some special messages that contain extended service information that can be important when analyzing
problems. There is one service log for all WebSphere Application Server Java virtual machines (JVMs) on
a node, including all application servers and their node agent (if present). A separate activity log is created
for a deployment manager in its own logs directory. The IBM Service log is maintained in a binary format.
Use the Log and Trace Analyzer or Showlog tool to view the IBM service log.

Enable service log:

Specifies creation of a log file by the IBM Service log.

File Name:

Specifies the name of the file used by the IBM Service log.

Maximum File Size:

Specifies the maximum size in megabytes of the service log file. The default value is 2 megabytes.

When this size is reached, the service log wraps in place. Note that the service log does not roll over to a
new log file like the JVM logs.

Enable Correlation ID:
Specifies the generation of a correlation ID that is logged with each message.

You can use the correlation ID to correlate activity to a particular client request, or correlate activities on
multiple application servers.

Viewing the service log

Service logs are logs written in a binary format. You cannot view a service log directly using a text editor.
You should never directly edit the service log, as doing so will corrupt the log.

To move a service log from one machine to another, you must use a mechanism like FTP, which supports

binary file transfer. You can view a service log in two ways:

* It is recommended that you use the Log and Trace Analyzer tool to view the service log. This tool
provides interactive viewing and analysis capability that is helpful in identifying problems.

» If you are unable to use the Log and Trace Analyzer tool, use the Showlog tool to convert the contents
of the service log to a text format that you can then write to a file or dump to the command shell
window.

Run the showlog script to view the contents of the service log as described in the following procedure.
1. Open a shell window on the machine where the service log resides.

2. Change the directory to|app_server_rooflbin where |app_server_roof is the fully qualified path where
the WebSphere Application Server product is installed.

3. Run the showlog script.
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showlog
4. Run the following showlog script with no parameters to display usage instructions.
showlog
5. Format and write the service log contents to a file.
showlog service_log filename output_filename
If the service log is not in the default location, you must fully qualify the service log filename

Message reference

Messages logged by application server components and associated IBM products start with a unique
message identifier that indicates the component or application that issued the message.

You can log WebSphere Application Server system messages from a variety of sources, including
application server components and applications. The message identifier can be either 8 or 9 characters in
length and has the form:

CCCC1234X

where:

CCCC s a four character alphabetic component or application identifier.

1234 is a four character numeric identifier used to identify the specific message for that component.
X is an optional alphabetic severity indicator. (I=Informational, W=Warning, E=Error)

To view the messages generated by WebSphere Application Server components, select the Reference
view of the information center navigation and expand Troubleshooter > Messages.

CORBA minor codes

Applications that use CORBA services generate minor codes to indicate the underlying cause of a failure.
These codes are written to the exception stack. Look for "minor code” in the exception stack to locate
these exceptions.

Overview

Common Object Request Broker Architecture (CORBA) is an industry-wide standard for object-oriented
communication between processes, which is supported in several programming languages. Several
subcomponents of WebSphere Application Server use CORBA to communicate across processes.

When a CORBA process fails, that is a request from one process to another cannot be sent, completed, or
returned, a high-level exception is created, such as TransactionRolledBackException: CORBA
TRANSACTION_ROLLEDBACK.

Minor codes that are used by WebSphere Application Server components

Range Related subcomponent = Where to find details
0x49424300-0x494243FF Security “Security components troubleshooting tips” on page]
32
0x49421050-0x4942105F, ORB services “Object request broker troubleshooting tips” on|
0x49421070-0x4942107F page 37§
0x4f4d and above Standard CORBA [ttp:/Awww.omg.org|
exceptions
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Range Related subcomponent Where to find details

0x49421080-0x4942108F Naming services See the Reference: Generated APl documentation
reference section for information about the
ws.code.naming.src.com.ibm.
websphere.naming.WsnCorbaMinorCodes class.

0x49421080-0x4942108F Workload Management See the Reference: Generated APl documentation
reference section for information about the
com.ibm.websphere.wim.WsCorbaMinorCodes
class.

Configuring the hang detection policy

A common error in J2EE applications is a hung thread. A hung thread can result from a simple software
defect (such as an infinite loop) or a more complex cause (for example, a resource deadlock). System
resources, such as CPU time, might be consumed by this hung transaction when threads run unbounded
code paths, such as when the code is running in an infinite loop. Alternately, a system can become
unresponsive even though all resources are idle, as in a deadlock scenario. Unless an end user or a
monitoring tool reports the problem, the system may remain in this degraded state indefinitely.

The hang detection option for WebSphere Application Server is turned on by default. You can configure a
hang detection policy to accommodate your applications and environment so that potential hangs can be
reported, providing earlier detection of failing servers. When a hung thread is detected, WebSphere
Application Server notifies you so that you can troubleshoot the problem.

Using the hang detection policy, you can specify a time that is too long for a unit of work to complete. The
thread monitor checks all managed threads in the system (for example, Web container threads and object
request broker (ORB) threads) . Unmanaged threads, which are threads created by applications, are not
monitored. For more information read [‘Hung threads in J2EE applications” on page 109]

The thread hang detection option is enabled by default. To adjust the hang detection policy values, or to
disable hang detection completely:

1. From the administrative console, click Servers > Application Servers > server_name
2. Under Server Infrastructure, click Administration > Custom Properties

3. Click New.

4. Add the following properties:

Name: com.ibm.websphere.threadmonitor.interval

Value: The frequency (in seconds) at which managed threads in the selected
application server will be interrogated.

Default: 180 seconds (three minutes).

Name: com.ibm.websphere.threadmonitor.threshold

Value: The length of time (in seconds) in which a thread can be active
before it is considered hung. Any thread that is detected as
active for longer than this length of time is reported as hung.

Default: The default value is 600 seconds (ten minutes).

Name:com. ibm.websphere.threadmonitor.false.alarm.threshold

Value: The number of times (T) that false alarms can occur
before automatically increasing the threshold. It is possible that a
thread that is reported as hung eventually completes its work,
resulting in a false alarm. A Targe number of these events indicates
that the threshhold value is too small. The hang detection facility can
automatically respond to this situation: For every T false alarms, the
threshold T is increased by a factor of 1.5. Set the value to
zero (or less) to disable the automatic adjustment.

Default: 100
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To disable the hang detection option, set the com.ibm.websphere.threadmonitor.interval property to
less than or equal to zero.

Click Apply.

Click OK.

Save the changes and make sure a file synchronization is performed before restarting the servers.
Restart the Application Server for the changes to take effect.

©® N o o

Hung threads in J2EE applications

WebSphere Application Server monitors thread activity and performs diagnostic actions if one has become
inactive.

When WebSphere detects that a thread has been active longer than the time defined by the thread
monitor threshold, the application server takes the following actions:

* Logs a warning in the WebSphere Application Server log that indicates the name of the thread that is
hung and how long it has already been active. The following message is written to the log:
WSVRO605W: Thread threadname has been active for

hangtime and may be hung. There are totalthreads
threads in total in the server that may be hung.

where: threadname is the name that appears in a JVM thread dump, hangtime gives an approximation
of how long the thread has been active and fotalthreads gives an overall assessment of the system
threads.

* Issues a Java Management Extensions (JMX) notification. This notification enables third-party tools to
catch the event and take appropriate action, such as triggering a JVM thread dump of the server, or
issuing an electronic page or e-mail. The following JMX notification events are defined in the
com.ibm.websphere.management.NotificationConstants class:

— TYPE_THREAD_MONITOR_THREAD_HUNG This event is triggered by the detection of a
(potentially) hung thread.

— TYPE_THREAD_MONITOR_THREAD_CLEAR This event is triggered if a thread that was previously
reported as hung completes its work. Consult the section on false alarms for more information.

» Triggers changes in the performance monitoring infrastructure (PMI) data counters. These PMI data
counters are used by various tools, such as the Tivoli Performance Viewer, to provide a performance
analysis.

» Triggers changes in the performance monitoring infrastructure (PMI) data counters. These PMI data

counters are used by various tools, such as the Tivoli Performance Viewer (TPV), to provide a
performance analysis.

For additional information about performance monitoring and Tivoli Performance Viewer, see the chapter
Monitoring performance with Tivoli Performance Viewer (TPV) in the Tuning guide PDF book

False Alarms

If the work actually completes, a second set of messages, notifications and PMI events is produced to
identify the false alarm. The following message is written to the log:

WSVRO606W: Thread threadname was previously reported to be

hung but has completed. It was active for approximately hangtime.

There are totalthreads threads in total in the server that still
may be hung.

where threadname is the name that appears in a JVM thread dump, hangtime gives an approximation of
how long the thread has been active and totalthreads gives an overall assessment of the system threads.
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Automatic adjustment of the hang time threshold

If the thread monitor determines that too many false alarms are issued (determined by the number of pairs
of hang and clear messages), it can automatically adjust the threshold. When this adjustment occurs, the
following message is written to the log:

WSVRO607W: Too many thread hangs have been falsely reported. The hang
threshold is now being set to thresholdtime.

where: thresholdtime is the time (in seconds) in which a thread can be active before it is considered hung.

You can prevent WebSphere Application Server from automatically adjusting the hang time threshold. See
|“Configuring the hang detection policy” on page 108|

Hang detection policy of a running server

The hang detection policy affects how the application server responds to a thread that is not being
processed correctly.

You can adjust the thread monitor settings by using the wsadmin scripting interface. These changes take
effect immediately, but do not persist to the server configuration, and are lost when the server is restarted.
The following script provides an example of how to adjust the properties for the thread monitor using the
wsadmin tool:

# Read in the interval, threshold, false alarm from the command Tine

set interval [Tindex $argv 0]

set threshold [Tindex $argv 1]
set adjustment [lindex $argv 2]

# Get the object name of the server you want to change the values on
set server [$AdminControl completeObjectName "type=Server,*"]

# Read in the interval and print to the console
set i [$AdminControl getAttribute $server threadMonitorInterval]

# Read in the threshold and print to the console
set t [$AdminControl getAttribute $server threadMonitorThreshold]

# Read in the false alarm adjustment threshold and print to the console
set a [$AdminControl getAttribute $server threadMonitorAdjustmentThreshold]

# Set the new values using the command line parameters
$AdminControl setAttribute $server threadMonitorInterval ${interval}

$AdminControl setAttribute $server threadMonitorThreshold ${threshold}

$AdminControl setAttribute $server threadMonitorAdjustmentThreshold ${adjustment}

Working with trace

Use trace to obtain detailed information about running the WebSphere Application Server components,
including application servers, clients, and other processes in the environment.

Trace files show the time and sequence of methods called by WebSphere Application Server base
classes, and you can use these files to pinpoint the failure.

Collecting a trace is often requested by IBM technical support personnel. If you are not familiar with the
internal structure of WebSphere Application Server, the trace output might not be meaningful to you.

1. :Configure| an output destination to which trace data is sent.
2. :Enable trace| for the appropriate WebSphere Application Server or application components.
3. Run the application or operation to generate the trace data.
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4. [Analyze the trace data or forward it to the appropriate organization for analysis.

For current information available from IBM Support on known problems and their resolution, see the [BM]

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Enabling trace on client and standalone applications

When standalone client applications (such as Java applications which access enterprise beans hosted in
WebSphere Application Server) have problems interacting with WebSphere Application Server, it may be
useful to enable tracing for the application. Enabling trace for client programs will cause the WebSphere
Application Server classes used by those applications, such as naming-service client classes, to generate
trace information. A common troubleshooting technique is to enable tracing on both the application server
and client applications, and match records according to timestamp to try to understand where a problem is
occurring.

1. To enable trace for the WebSphere Application Server classes in a client application, add the system
properties shown in the following example to the startup script or command of the client application.
The location of the output and the classes and detail included in the trace follow the same rules as for
adding trace to WebSphere Application Servers. For example, trace the standalone client application
program named com.ibm.sample.MyClientProgram, you would enter the following command:
java -DtraceSettingsFile=MyTraceSettings.properties

-Djava.util.logging.manager=com.ibm.ws.bootstrap.WsLogManager
-Djava.util.logging.configureByServer=true com.ibm.samples.MyClientProgram

The file identified by filename must be a properties file placed in the classpath of the application client
or stand-alone process. An example file is provided in

« [profile_roofproperties/TraceSettings.properties

You cannot use the -DtraceSettingsFile=TraceSettings.properties property to enable tracing of the
ORB component for thin clients. ORB tracing output for thin clients can be directed by setting
com.ibm.CORBA.Debug.Output = debugOutputFilename parameter in the command line.

The java.util.logging.manager and java.util.logging.configureByServer system properties configure Java
logging to use a WebSphere Application Server-specific LogManager class and to use the
configuration from the file specified by the traceSettingsFile property. The default Java Logging
properties file, located in the Java Runtime Environment (JRE), will not be applied.

2. You can configure the MyTraceSettings.properties file to send trace output to a file using the
traceFileName property. Specify one of two options:

» The fully qualified name of an output file. For example, traceFileName=c:\\MyTraceFile.log. You must
specify this property to generate visible output.

» stdout. When specified, output is written to System.out.

3. You can also specify a trace string for writing messages with the Trace String property, Specify a
startup trace specification similar to that available on the server. For your convenience, you can enter
multiple individual trace strings into the trace settings file, one trace string per line.

Here are the results of using each optional property setting:

» Specify a valid setting for the traceFileName property without a trace string to write messages to the
specified file or System.out only.

» Specify a trace string without a traceFileName property value to generate no output.

» Specify both a valid traceFileName property and a trace string to write both message and trace entries
to the location specified in the traceFileName property.
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Tracing and logging configuration

You can configure tracing and logging settings to help diagnose problems or evaluate system
performance.

You can configure the application server to start in a trace-enabled state by setting the appropriate
configuration properties. You can only enable trace for an application client or standalone process at
process startup.

In WebSphere Application Server, V6 and later, a logging infrastructure, extending Java Logging, is used.
This results in the following changes to the configuration of the logging infrastructure in WebSphere
Application Server:

* Loggers defined in Java logging are equivalent to, and configured in the same way as, trace
components introduced in previous versions of WebSphere Application Server. Both are referred to as
"components.”

« Both Java logging levels and WebSphere Application Server levels can be used. The following is a
complete list of valid levels, ordered in ascending order of severity:

1. all

2. finest or debug
3. finer or entryExit
4. fine or event
5. detail

6. config

7. info

8. audit

9. warning

10. severe or error
11. fatal

12. off

» Setting the logging and tracing level for a component to all will enable all the logging for that
component. Setting the logging and tracing level for a component to off will disable all the logging for
that component.

* You can only configure a component to one level. However, configuring a component to a certain level
enables it to perform logging on the configured level and any higher severity level.

» Several levels have equivalent names: finest is equivalent to debug; finer is equivalent to entryExit; fine
is equivalent to event; severe is equivalent to error.

Java Logging does not distinguish between tracing and message logging. However, previous versions of
WebSphere Application Server have made a clear distinction between those kind of messages. In
WebSphere Application Server, V6 and later, the differences between tracing and message logging are as
follows:

» Tracing messages are messages with lower severity (for example, tracing messages are logged on
levels fine, finer, finest, debug, entryExit, or event).

» Tracing messages are generally not localized.
* When tracing is enabled, a much higher volume of messages will be produced.
» Tracing messages provide information for problem determination.

Trace and logging strings
In WebSphere Application Server, V5.1.1 and earlier, trace strings were used for configuring tracing only.
Starting in WebSphere Application Server, Version 6 and later, the "trace string” becomes a "logging

string”; it is used to configure both tracing and message logging.
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In WebSphere Application Server, V5.1.1 and earlier, the trace service for all WebSphere Application
Server components is disabled by default. To request a change to the current state of the trace service, a
trace string is passed to the trace service. This trace string encodes the information detailing which level of
trace to enable or disable and for which components.

In all versions of WebSphere Application Server, the tracing for all components is disabled by default. To
change to the current state of the tracing and message logging, a logging string must be constructed and
passed to the server. This logging string specifies what level of trace or logging to enable or disable for
specific components.

You can type in trace strings (or logging strings), or construct them using the administrative console. Trace
and logging strings must conform to a specific grammar.

For WebSphere Application Server, V5.1.1 and earlier, the specification of this grammar is as follows:
TRACESTRING=COMPONENT _TRACE_STRING[:COMPONENT TRACE_STRING]=*

COMPONENT_TRACE_STRING=COMPONENT_NAME=LEVEL=STATE[,LEVEL=STATE]*

LEVEL

all | entryExit | debug | event

STATE

enabled | disabled

COMPONENT_NAME = COMPONENT | GROUP

For WebSphere Application Server, V6 and later, the previous grammar is supported. However a new
grammar has been added to better represent the underlying infrastructure:

LOGGINGSTRING=COMPONENT LOGGING_STRING[:COMPONENT LOGGING_STRING]=*
COMPONENT_TRACE_STRING=COMPONENT_NAME=LEVEL

LEVEL = all | (finest | debug) | (finer | entryExit) | (fine | event )
| detail | config | info | audit | warning | (severe | error) | fatal | off

COMPONENT _NAME = COMPONENT | GROUP

The COMPONENT_NAME is the name of a component or group registered with the trace service logging
infrastructure. Typically, WebSphere Application Server components register using a fully qualified Java
class name, for example com.ibm.servlet.engine.ServletEngine. In addition, you can use a wildcard
character of asterisk (*) to terminate a component name and indicate multiple classes or packages. For
example, use a component name of com.ibm.servlet.” to specify all components whose names begin with
com.ibm.servlet. You can use a wildcard character of asterisk (*) at the end of the component or group
name to make the logging string applicable to all components or groups whose names start with specified
string. For example, a logging string specifying "com.ibm.servlet.*” as a component name will be applied
to all components whose names begin with com.ibm.servlet. When an asterisk (*) is used by itself in place
of the component name, the level the string specifies, will be applied to all components.

The following are examples of using an asterisk (*) in logging strings. Note that the asterisk (*) in the

logging string does not need to have a period (.) in front of it. The period (.) can be used anywhere in the

logging string.

* com.ibm.ejs.ras.*=all - enables tracing for all loggers with names starting with "com.ibm.ejs.ras.”. If
there is a logger named "com.ibm.ejs.ras” it will not have trace enabled.

* com.ibm.ejs.ras*=all - enables tracing for all loggers with names starting with "com.ibm.ejs.ras”, such
as com.ibm.ejs.ras, com.ibm.ejs.raslogger, com.ibm.ejs.ras.ManagerAdmin

Note:
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* In WebSphere Application Server, V5.1.1 and earlier, you could set the level to "all=disabled” to
disable tracing. This syntax, beginning with Version 6.0, will result in LEVEL=info; tracing will be
disabled, but logging will be enabled.

* The logging string is processed from left to right. During the processing, part of the logging string
might be modified or removed if the levels they configure are being overridden by another part of
the logging string.

* In WebSphere Application Server, V6 and later, "info” is the default level. If the specified
component is not present (*=xxx is not found), *=info is always implied. Any component that is
not matched by the trace string will have its level set to info.

» If the logging string does not start with a component logging string specifying a level for all
components, using the "*" in place of component name, one will be added, setting the default
level for all components.

* STATE = enabled | disabled is not needed in Version 6 and later. However, if used, it has the
following effect:

"enabled” sets the logging for the component specified to the level specified

"disabled” sets the logging for the component specified to one level above the level specified.
The following examples illustrate the effect that disabling has on the logging level:

Logging string Resulting logging level Notes

com.ibm.ejs.ras=debug=disabled com.ibm.ejs.ras=finer debug (version 5) = finest (version 6)

com.ibm.ejs.ras=all=disabled com.ibm.ejs.ras=info "all=disabled” will disable tracing;
logging is still enabled.

com.ibm.ejs.ras=fatal=disabled com.ibm.ejs.ras=off

com.ibm.ejs.ras=off=disabled com.ibm.ejs.ras=off off is the highest severity

Examples of legal trace strings include:

Version 5 syntax Version 6 syntax

com.ibm.ejs.ras.ManagerAdmin=debug=enabled com.ibm.ejs.ras.ManagerAdmin=finest

com.ibm.ejs.ras.ManagerAdmin=all=enabled,event=disabled | com.ibm.ejs.ras.ManagerAdmin=detail

com.ibm.ejs.ras.*=all=enabled com.ibm.ejs.ras.*=all

com.ibm.ejs.ras.*=all=enabled:com.ibm.ws.ras=debug= com.ibm.ejs.ras.*=all:com.ibm.ws.ras=finer
enabled,entryexit=enabled

Enabling trace at server startup

The diagnostic trace configuration settings for a server process determines the initial trace state for a
server process. The configuration settings are read at server startup and used to configure the trace
service. You can also change many of the trace service properties or settings while the server process is

running.
1. Start the administrative console.
2. Click Troubleshooting > Logging and Tracing in the console navigation tree, then click Server >
Diagnostic Trace.
3. Click Configuration.
4. Select the Enable Log check box to enable trace, clear the check box to disable trace.
5. Select whether to direct trace output to either a file or an in-memory circular buffer.

114  Troubleshooting and support




Note: Different components can produce different amounts of trace output per entry. Naming and
security tracing, for example, produces a much higher trace output than Web container tracing.
Consider the type of data being collected when you configure your memory allocation and
output settings.

6. If the in-memory circular buffer is selected for the trace output set the size of the buffer, specified in
thousands of entries. This is the maximum number of entries that will be retained in the buffer at any
given time.

7. If afile is selected for trace output, set the maximum size in megabytes to which the file should be
allowed to grow. When the file reaches this size, the existing file will be closed, renamed, and a new
file with the original name reopened. The new name of the file will be based upon the original name
with a timestamp qualifier added to the name. In addition, specify the number of history files to keep.

8. Select the desired format for the generated trace.
9. Save the changed configuration.
10. To enter a trace string to set the trace specification to the desired state:
a. Click Troubleshooting > Logging and Tracing in the console navigation tree.
b. Select a server name.
c. Click Change Log Level Details.
d

If All Components has been enabled, you might want to turn it off, and then enable specific
components.

e. Click a component or group name. For more information see ['Log level settings” on page 62| If the
selected server is not running, you will not be able to see individual component in graphic mode.

f. Enter a trace string in the trace string box.
g. Select Apply, then OK.
11. Allow enough time for the nodes to synchronize, and then start the server.

Enabling trace on a running server

You can modify the trace service state that determines which components are being actively traced for a
running server by using the following procedure.

1. Start the administrative console.

2. Click Troubleshooting > Logs and Trace in the console navigation tree, then click server >
Diagnostic Trace.

3. Select the Runtime tab.

4. Select the Save runtime changes to configuration as well check box if you want to write your
changes back to the server configuration.

5. Change the existing trace state by changing the trace specification to the desired state.
6. Configure the trace output if a change from the existing one is desired.
7. Click Apply.

Managing the application server trace service

You can manage the trace service for a server process while the server is stopped and while it is running.
You can specify which components to trace, where to send trace output, the characteristics of the trace
output device, and which format to generate trace output in.

Modify the trace settings to help with diagnosing problems or tuning performance within certain
applications. To manage the trace service for a server process:

1. Start the administrative console.

2. Click Troubleshooting > Logging and Tracing in the console navigation tree, then click server >
Diagnostic Trace

3. If the server is running, select the Runtime tab.
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4. For a running server, check the Save trace check box to write your changes back to the server
configuration. If Save trace is not selected, the changes you make will apply only for the life of the
server process that is currently running.

5. Perform the desired operation:
a. Enter the file name and click Dump to dump the in-memory circular buffer.

b. To change the trace destination from a file to the in-memory circular buffer or to a different file, or
to change from the in memory circular buffer to a file, select the appropriate radio buttons, then
click Apply.

Note: Different components can produce different amounts of trace output per entry. Naming and
security tracing, for example, produces a much higher trace output than Web container
tracing. Consider the type of data being collected when you configure your memory
allocation and output settings.

c. To change the format in which trace output is generated, select the appropriate value from the
drop-down list.

Interpreting trace output

Trace output allows administrators to examine processes in the application server and diagnose various
issues.

On an application server, trace output can be directed either to a file or to an in-memory circular buffer. If
trace output is directed to the in-memory circular buffer, it must be dumped to a file before it can be
viewed.

On an application client or stand-alone process, trace output can be directed either to a file or to the
process console window.

In all cases, trace output is generated as plain text in either basic, advanced or log analyzer format as
specified by the user. The basic and advanced formats for trace output are similar to the basic and
advanced formats that are available for the JVM message logs.

Basic and advanced format fields

Basic and Advanced Formats use many of the same fields and formatting techniques. The fields that can

be used in these formats include:

TimeStamp
The timestamp is formatted using the locale of the process where it is formatted. It includes a fully
qualified date (YYMMDD), 24 hour time with millisecond precision and the time zone.

Threadld
An 8 character hexadecimal value generated from the hash code of the thread that issued the
trace event.

ThreadName
The name of the Java thread that issued the message or trace event.

ShortName
The abbreviated name of the logging component that issued the trace event. This is typically the
class name for WebSphere Application Server internal components, but may be some other
identifier for user applications.

LongName
The full name of the logging component that issued the trace event. This is typically the fully
qualified class name for WebSphere Application Server internal components, but may be some
other identifier for user applications.

EventType
A one character field that indicates the type of the trace event. Trace types are in lower case.
Possible values include:
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> a trace entry of type method entry.

< a trace entry of type method exit.

1 a trace entry of type fine or event.

2 a trace entry of type finer.

3 a trace entry of type finest, debug or dump.

Y4 a placeholder to indicate that the trace type was not recognized.
ClassName

The class that issued the message or trace event.
MethodName

The method that issued the message or trace event.
Organization

The organization that owns the application that issued the message or trace event.
Product

The product that issued the message or trace event.
Component

The component within the product that issued the message or trace event.

Basic format

Trace events displayed in basic format use the following format:

<timestamp><threadId><shortName><eventType>[className] [methodName]<textmessage>
[parameter 1]
[parameter 2]

Advanced formats

Trace events displayed in advanced format use the following format:

<timestamp><threadId><eventType><UOW><source=1ongName>[className] [methodName]
<Organization><Product><Component>[thread=threadName]
<textMessage>[parameter l=parameterValue] [parameter 2=parameterValue]

Log analyzer trace format

Preserves trace information in the same format as produced by Showlog tool.

Diagnostic trace service settings
To view this page, click the following paths:
« Troubleshooting > Logs and Trace > server > Diagnostic trace

Enable Log
Enables the log service.

If this option is not selected, the following configuration properties are not passed to the application server
trace service at server startup.

Trace Output
Specifies where trace output should be written. The trace output can be written directly to an output file, or
stored in memory and written to a file on demand using the Dump button found on the run-time page.

Different components can produce different amounts of trace output per entry. Naming and security
tracing, for example, produces a much higher trace output than Web container tracing. Consider the type
of data being collected when you configure your memory allocation and output settings.

Memory Buffer
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Specifies that the trace output should be written to an in-memory circular buffer. If you select this option
you must specify the following parameters:

* Maximum Buffer Size

— Specifies the number of entries, in thousands, that can be cached in the buffer. When this number is
exceeded, older entries are overwritten by new entries.

* Dump File Name

— The name of the file to which the memory buffer will be written when it is dumped. This option is only
available from the Runtime tab.

File

Specifies to write the trace output to a self-managing log file. The self-managing log file writes messages
to the file until the specified maximum file size is reached. When the file reaches the specified size,
logging is temporarily suspended and the log file is closed and renamed. The new name is based on the
original name of the file, plus a timestamp qualifier that indicates when the renaming occurred. Once the
renaming is complete, a new, empty log file with the original name is reopened, and logging resumes. No
messages are lost as a result of the rollover, although a single message may be split across the two files.
If you select this option you must specify the following parameters:

* Maximum File Size

— Specifies the maximum size, in megabytes, to which the output file is allowed to grow. This attribute
is only valid if the File Size attribute is selected. When the file reaches this size, it is rolled over as
described above.

* Maximum Number of Historical Files
— Specifies the maximum number of rolled over files to keep.
* File Name
— Specifies the name of the file to which the trace output is written.

Trace Output Format
Specifies the format of the trace output.

You can specify one of three levels for trace output:
» Basic (Compatible)

— Preserves only basic trace information. Select this option to minimize the amount of space taken up
by the trace output.

* Advanced

— Preserves more specific trace information. Select this option to see detailed trace information for use
in troubleshooting and problem determination.

* Log analyzer trace format
— Preserves trace information in the same format as produced by Showlog tool.

Runtime tab
Specifies the format of the trace output.

Save changes to configuration

Save changes made on the runtime tab to the trace configuration as well. Select this box to copy run-time
trace changes to the trace configuration settings as well. Saving these changes to the trace configuration
will cause the changes to persist even if the application is restarted.

Trace Output
Specifies where trace output should be written. The trace output can be written directly to an output file, or
stored in memory and written to a file on demand using the Dump button found on the run-time page.
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Memory Buffer

Specifies that the trace output should be written to an in-memory circular buffer. If you select this option
you must specify the following parameters:

¢ Maximum Buffer Size

— Specifies the number of entries, in thousands, that can be cached in the buffer. When this number is
exceeded, older entries are overwritten by new entries.

* Dump File Name

— The name of the file to which the memory buffer will be written when it is dumped. This option is only
available from the Runtime tab.

File

Specifies to write the trace output to a self-managing log file. The self-managing log file writes messages
to the file until the specified maximum file size is reached. When the file reaches the specified size,
logging is temporarily suspended and the log file is closed and renamed. The new name is based on the
original name of the file, plus a timestamp qualifier that indicates when the renaming occurred. Once the
renaming is complete, a new, empty log file with the original name is reopened, and logging resumes. No
messages are lost as a result of the rollover, although a single message may be split across the two files.
If you select this option you must specify the following parameters:

* Maximum File Size

— Specifies the maximum size, in megabytes, to which the output file is allowed to grow. This attribute
is only valid if the File Size attribute is selected. When the file reaches this size, it is rolled over as
described above.

* Maximum Number of Historical Files
— Specifies the maximum number of rolled over files to keep.
* File Name
— Specifies the name of the file to which the trace output is written.
* File Name
— View the file that is specified by the File Name parameter. This does not apply your configuration.

Select a server to configure logging and tracing
Use this page to select the server for which you want to configure logging and trace settings.

Application Servers

This page lists application servers in the cell and the nodes holding the application servers. If you are
using the Network Deployment product, this panel also shows the status of the application servers. The
status indicates whether a server is running, stopped, or encountering problems.

When you select an application server, a panel is displayed that will allow you to choose which log or trace
task to configure for that application server.

To view this administrative console page, click Troubleshooting > Logs and Trace

Name
Specifies the logical name of the server.

Node
Specifies the name of the node for the application server.

Version
Specifies the version for the application server.
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Status
Indicates whether the application server is started or stopped. (Network Deployment only)

Note that if the status is Unavailable, the node agent is not running in that node and you must restart the
node agent before you can start the server.

Log and trace settings
Use this page to view and configure logging and trace settings for the server.

To view this administrative console page, click the following paths:
* Troubleshooting > Logs and Trace > server_name

Diagnostic Trace

The diagnostic trace configuration settings for a server process determine the initial trace state for a server
process. The configuration settings are read at server startup and used to configure the trace service. You
can also change many of the trace service properties or settings while the server process is running.

Java virtual machine (JVM) Logs

The JVM logs are created by redirecting the System.out and System.err streams of the JVM to
independent log files. WebSphere Application Server writes formatted messages to the System.out stream.
In addition, applications and other code can write to these streams using the print() and printin() methods
defined by the streams.

Process Logs

WebSphere Application Server processes contain two output streams that are accessible to native code
running in the process. These streams are the stdout and stderr streams. Native code, including Java
virtual machines (JVM), might write data to these process streams. In addition, JVM provided System.out
and System.err streams can be configured to write their data to these streams also.

IBM Service Logs

The IBM service log contains both the WebSphere Application Server messages that are written to the
System.out stream and some special messages that contain extended service information that is normally
not of interest, but can be important when analyzing problems. There is one service log for all WebSphere
Application Server JVMs on a node, including all application servers. The IBM Service log is maintained in
a binary format and requires a special tool to view. This viewer, the Log and Trace Analyzer, provides
additional diagnostic capabilities. In addition, the binary format provides capabilities that are utilized by IBM
support organizations.

Change Log Level Details

Enter a log detail level that specifies the components, packages, or groups to trace. The log detail level
string must conform to the specific grammar described in this topic. You can enter the log detail level string
directly, or generate it using the graphical trace interface.

Working with troubleshooting tools

WebSphere Application Server includes a number of troubleshooting tools that are designed to help you
isolate the source of problems. Many of these tools are designed to generate information to be used by
IBM Support, and their output might not be understandable by the customer.

This section only discusses tools that are bundled with the WebSphere Application Server product. A wide
range of tools which address a variety of problems is available from the WebSphere Application Servel
[Technical Support Web site]

1. Select the appropriate tool for the task. For more information on the capacities of the supplied
troubleshooting tools, see the relevant articles in this section.

2. Run the tool as described in the relevant article.
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3. Contact IBM Support for assistance in deciphering the output of the tool. For current information
available from IBM Support on known problems and their resolution, see the IBM Supporf page. I1BM
Support has documents that can save you time gathering information needed to resolve this problem.
For the last minute updates, limitations, and known problems, see the . Before opening
a PMR, see the [Must gathel] page.

4. Use the |IBM Support Assistant| to help find and use various IBM Support resources, such as updated
documentation and problem determination tools.

Gathering information with the Collector tool

The collector tool gathers information about your WebSphere Application Server installation and packages
it in a Java archive (JAR) file that you can send to IBM Customer Support to assist in determining and
analyzing your problem. Information in the JAR file includes logs, property files, configuration files,
operating system and Java data, and the presence and level of each software prerequisite.

There are two ways to run the collector tool. Run the collector tool to collect summary data or to traverse
the system to gather relevant files and command results. The collector tool produces a Java archive (JAR)
file of information needed to determine and solve a problem. The collector summary option produces a
lightweight collection of version and other information that is useful when first reporting the problem to IBM
Support.

There are two phases of using the collector tool. The first phase runs the collector tool on your
WebSphere Application Server product and produces a Java archive (JAR) file . The IBM Support team
performs the second phase, which is analyzing the Java archive (JAR) file that the collector program
produces.

The collector program runs to completion as it creates the JAR file, despite any errors that it might find.
Errors might include missing files or commands. The collector tool collects as much data in the JAR file as
possible.

Collector tool

The collector tool gathers extensive information about your WebSphere Application Server installation and
packages it in a Java archive (JAR) file that you can send to IBM Customer Support to assist in
determining and analyzing your problem.

Information in the JAR file includes logs, property files, configuration files, operating system and Java data,
and the absence or level of each software prerequisite. The collector program runs to completion despite
any errors that it might find. Errors might include missing files or commands. The collector tool collects as
much data in the JAR file as possible.

See [‘Running the collector tool”| for the steps for running the collector program.

You can also [run the collector summary option|to create a lightweight version of the information in a text
file and on the console. The lightweight information is useful for getting started in communicating your
problem to IBM Support.

Running the collector tool:

Use the collector tool to gather information about your system and one or more profiles. The sort of
information that you gather is not something that most people use. In fact, the collector tool packages its
output into a JAR file. People normally use the collector tool when directed to do so by IBM Support, when
gathering information to send to IBM as part of reporting a problem. IBM includes the collector tool in the
product code, along with other tools that help capture the information that you must provide when reporting
a problem. The collector tool is part of a strategy of making problem reporting as easy and complete as
possible.
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Run the collector tool from the root user or from the administrator user (Windows systems) to access
system files that contain information about kernel settings, installed packages, and other vital data.

The collector tool is a Java application that requires a Java Runtime Environment (JRE) to run.

The tool is within the installation root directory for WebSphere Application Server. But you run the tool from
a working directory that you create outside of the installation root directory. This procedure describes both
of those steps and all of the other steps for using the tool and reporting the results from running the tool.

The tool collects information about the default profile if you do not use the optional parameter to identify
another profile.

1. Log on to the system as root or a member of the administrator group on a Windows platform.
2. Make a working directory where you can start the collector program.
3. Run the STRQSH command from the CL command line to prepare to run the collector program.
4. Make the working directory the current directory.
Run the following command from Qshell:
cd workingDirectory

The collector program writes its output JAR file to the current directory. The program also creates and
deletes a number of temporary files in the current directory. Creating a work directory to run the
collector program avoids naming collisions and makes cleanup easier. You cannot run the collector tool
in a directory under the installation root directory for WebSphere Application Server.

5. Run the collector program by entering the fully qualified command from the command line of the
working directory.

Run the following command from Qshell:

bop_server_rootbin/collector

Use the command with no additional parameter to gather one copy of the profile data and data from
each server in the node, and to store the data in a single JAR output file.

Use the following command to gather data from a specific profile that might not be the default profile:
Run the following command from Qshell:

bin/coHector -profileName profile_name

Use the following command to gather data from a specific server that might be giving you problems:
Run the following command from Qshell:

[pp_server_root)/bin/collector -servername server_name

Combine the two parameters to identify a particular server in a particular profile.

Set the path to locate the proper command file in the [app_server_rooffbin directory if you do not want
to issue a fully qualified command.

WebSphere Application Server
The collector program creates the Collector.log log file and an output JAR file in the current directory.

The name of the JAR file is composed of the host name, cell name, node name, and profile name:

host_name-cell_name-node_name-profile_name.JAR

The Collector.log log file is one of the files collected in the host_name-cell_name-node_name-
profile_name.JAR file.

Send the host_name-cell_name-node_name-profile_name.JAR file to IBM Support for analysis.
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Analyzing collector tool output

The first step in using the collector tool on your WebSphere Application Server product is to run the tool to
[oroduce a Java archive (JAR) file as outpuf. The second step in using the collector tool is to analyze its
output. The preferred method of performing this analysis is to send the JAR file to IBM Support for
analysis. However, you can use this topic to understand the content of the JAR file if you perform your
own analysis.

You can view the files contained in the JAR file without extracting the files from the JAR file. However, it is
easier to extract all files and view the contents of each file individually. To extract the files, use one of the
following commands:

* jar -xvf WASenv.jar

* unzip WASenv.jar

Wasenv.jar stands for the name of the JAR file that the collector tool creates.

The JAR file contains:

» A collector tool log file, collector.log

» Copies of stored WebSphere Application Server files and their full paths that are located under directory
root in the JAR file

» Java information in a directory named Java

* A JAR file manifest

Tips and suggestions
* Unzip the JAR file to an empty directory for easy access to the gathered files and for simplified cleanup.
* Check the collector.1og file for errors:
— Some errors might be normal or expected. For example, when the collector attempts to gather files
or directories that do not exist for your specific installation, it logs an error about the missing files.
— A non-zero return code means that a command that the collector tool attempted to run does not
exist. This might be expected in some cases. If this type of error occurs repeatedly, there might
actually be a problem.

Collector summary
WebSphere Application Server products include an enhancement to the collector tool beginning with
Version 5.0.2, known as the collector summary option.

The collector summary option helps you communicate with WebSphere Application Server technical staff
at IBM Support. Run the collector tool with the -Summary option to produce a lightweight text file and
console version of some of the information in the Java archive (JAR) file that the tool produces without the
-Summary parameter. You can use the collector summary option to retrieve basic configuration and
prerequisite software level information when starting a conversation with IBM Support.

The collector summary option produces version information for the WebSphere Application Server product
and the operating system as well as other information. It stores the information in the
Collector_Summary.txt file and writes it to the console. You can use the information to answer initial
questions from IBM Support or you can send the Collector_Summary.txt file directly to IBM Support.

When running the collector tool on WebSphere Application Server for i5/0S, an additional file named
WAS_Collection_timestamp.html is created in the logs directory of the profile where the collector tool runs.
If you do not specify the -profileName option, the profile is the default profile. The HTML file is sent to IBM
Support when you initiate a PMR.

[Run the collector command to create the JAR filg| if IBM Support needs more information to solve your
problem.
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To run the collector summary option, start from a temporary directory outside of the WebSphere
Application Server product installation root directory and enter one of the following commands:

¢ |app server root|/bin/collector -Summary [-profileName profileName]
The -profileName option specifies the profile to summarize.

Configuring first failure data capture log file purges

The first failure data capture (FFDC) log file saves information that is generated from a processing failure.
These files are deleted after a maximum number of days has passed. The captured data is saved in a log
file for analyzing the problem.

The first failure data capture (FFDC) feature preserves the information that is generated from a processing
failure and returns control to the affected engines. The captured data is saved in a log file for analyzing
the problem. FFDC is intended primarily for use by IBM Service. FFDC instantly collects events and errors
that occur during the WebSphere Application Server runtime. The information is captured as it occurs and
is written to a log file that can be analyzed by an IBM Service representative. The data is uniquely
identified for the servant region that produced the exception.

The FFDC configuration properties files are located in the properties directory under the WebSphere
Application Server product installation. There are three properties files, but only the ffdcRun.properties file
should be modified. You can set the ExceptionFileMaximumAge property to configure the amount of days
between purging the FFDC log files. The value of the ExceptionFileMaximumAge property must be a
positive number. The FFDC feature does not affect the performance of the WebSphere Application Server
product.

Perform the following steps to configure the number of days between the FFDC log file purges. The value

is in days.

1. Change the value for the ExceptionFileMaximumAge property to the number of days between the
FFDC log file purges. The value of the ExceptionFileMaximumAge property must be a positive number.
The default is seven days. For example, ExceptionFileMaximumAge = 3 sets the default time to three
days. The FFDC log file is purged after three days.

2. Save the ffdcRun.properties file and exit.

The FFDC file management function removes the FFDC log files that have reached the maximum age and
generates a message in the SystemOut.log file.

Getting IBM Support Assistant

IBM® Support Assistant helps you find and use various IBM Support resources, such as updated
documentation and problem determination tools.

IBM Support Assistant is available on the WebSphere Application Server Supplements CD and on the IBM
site at |http://www-306.ibm.com/software/support/isa} IBM Support Assistant offers the following
components to help you with software questions:

» A search component, which helps you access pertinent Support information in multiple locations.

* A support links component, which provides a convenient location to access various Web resources such
as IBM product sites, IBM support sites, and links to IBM news groups.

* A service component, which helps you submit an enhanced problem report that includes key system
data to IBM. The data collector of the service component supports problem-specific data collection.

» A pluggable tools framework, with which you can download and use problem determination and other
support tools.

1. Install the tool. Use the Launchpad from the WebSphere Application Server Supplements CD. If you
cannot use the Launchpad, you can still install IBM Support Assistant by running the appropriate
installation executable file that is located on the CD.
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2. Start the tool. The IBM Support Assistant is a Web application that is displayed in the default
system-configured Web browser.

To learn more about how to use IBM Support Assistant, click the Help link in the IBM Support Assistant
window.

Use the Updater tab within IBM Support Assistant to check for updates and pluggable tools, such as
Memory Dump Diagnostic for Java™, that might apply to your product.

Diagnosing out-of-memory errors and Java heap memory leaks

Memory Dump Diagnostic for Java is an offline tool for diagnosing root causes behind memory leaks in the
Java heap. The tool analyzes common formats of memory dumps (heap dumps) from the Java virtual
machine (JVM) in which the WebSphere® Application Server runs. The analysis of memory dumps is
targeted toward identifying data structures within the Java heap that might be root causes of memory
leaks. The analysis also identifies a summarized set of object groups that contribute significantly to the
Java heap footprint of the application. The tool is capable of analyzing very large memory dumps from
production-environment application servers that exhibit out-of-memory issues.

This tool works with the memory dumps that are generated from WebSphere Application Server, not from
the Memory Dump Diagnostic for Java tool. The following dump formats are supported:

* |IBM Portable Heap Dump (.phd), for WebSphere Application Server versions 5.1.x and later on most
platforms

+ IBM Text, for WebSphere Application Server versions 4.x and 5.0.x on most platforms

Memory leaks can occur in Java applications when object references are unintentionally held onto after the
references are no longer needed. This problem prevents the Java garbage collection process from freeing
memory, even though the Java language has a built-in garbage collection mechanism that frees the
programmer from explicit object deallocation responsibilities. Memory leaks are hard to diagnose in large
complex Java applications, because of the large number of objects in the Java heap and because of the
complex relationships between these objects.

Two types of analysis mechanisms are available: single-dump analysis and the comparative analysis of
two dumps. The tool lists suspected data structures and data types and displays contents of the memory
dump in an interactive browser-based Web application. The tool shows footprint analysis results in a
graphical layout of significant sets of data types that have similar ownership structures. The tool shows the
contents of the memory dump in an interactive tree view for browsing and in two table views of objects
and data types, respectively. The tree view enables you to look for all incoming and outgoing references
for each object and to see the location of a container object within each data structure with a suspected
memory leak.

Analyzing memory dumps in an offline fashion provides a low-overhead mechanism for identifying root
causes behind memory leaks. This mechanism is particularly suitable for large applications that are
running in production or in stress-test environments, where memory leaks are often detected first.

1. Install IBM Support Assistant on a computer that is separate from the application server installation to
be analyzed. Use a non-production computer with at least 5 gigabytes (GB) of free disk space, at least
1.5 GB of RAM, and an Intel® processor that runs at 2 GHz or faster, preferably on the Linux®
platform.

2. Enable verbose garbage collection on the application server installation to be analyzed.

Verbose garbage collection information helps to rule out basic configuration issues and memory-leak
issues from fragmentation or native memory leaks. For more information about how to enable verbose
garbage collection on IBM platforms, see[IBM developer kits: Diagnosis documentation|

3. Optional: Enable lightweight memory-leak detection in WebSphere Application Server.

Chapter 6. Diagnosing problems (using diagnosis tools) 125


http://www-128.ibm.com/developerworks/java/jdk/diagnosis/

Enabling lightweight memory-leak detection can help with early detection of abnormal memory usage
behavior and for automatically triggering heap dumps.

4. Enable the JVM heap dump feature for WebSphere Application Server.

Refer to the documentation that is supplied with the tool when you start from IBM Support Assistant.
5. When the heap dump is available, run the Memory Dump Diagnostic for Java tool.

a. [Start IBM Support Assistant]

b. In IBM Support Assistant, select the Tools tab.

c. On the left side, click WebSphere 6.1.

d. On the right side, click Memory Dump Diagnostic for Java.

The possible root causes of memory leaks are identified.

Memory leaks in the Java heap produce java.lang.OutOfMemoryError exceptions in log files. However, not
all out-of-memory errors are caused by Java heap memory leaks. Out-of-memory errors can also be
caused by the following conditions:

« Java heap fragmentation. This fragmentation occurs when no contiguous chunk of free Java heap
space is available from which to allocate Java objects. Various causes for this problem exist, including
the presence of pinned or dosed objects or because of the repeated allocation of large objects.

+ Memory leaks in native heap. This problem occurs when a native component, like DB2® connections, is
leaking.

For both of these conditions, the out-of-memory error can occur in spite of large amounts of free Java
heap space. Consequently, the Memory Dump Diagnostic for Java tool might not be effective in
determining root causes in these cases.

Troubleshooting help from IBM

If you are not able to resolve a WebSphere Application Server problem by following the steps described in
the Troubleshooting guide, by looking up error messages in the message reference, or looking for related
documentation on the online help, contact IBM Technical Support.

Purchase of WebSphere Application Server entitles you to one year of telephone support under the
Passport Advantage program. For details on the Passport Advantage program, visit [http://www.lotus.com/
lservices/passport.nsf/WebDocs/Passport_Advantage_Home|

The number for Passport Advantage members to call for WebSphere Application Server support is
1-800-237-5511. Please have the following information available when you call:

* Your Contract or Passport Advantage number.

* Your WebSphere Application Server version and revision level, plus any installed fixes.

* Your operating system name and version.

* Your database type and version.

» Basic topology data: how many machines are running how many application servers, and so on.
* Any error or warning messages related to your problem.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Support page.

Tracing

WebSphere Application Server support engineers might ask you to enable tracing on a particular
component of the product to diagnose a difficult problem.
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Consulting

For complex issues such as high availability and integration with legacy systems, education, and help in
getting started quickly with the WebSphere product family, consider using IBM consulting services. To learn
about these services, browse the Web site |http://www-1.ibm.com/services/fullservice.html|

Diagnosing and fixing problems: Resources for learning

In addition to the information center, there are several Web-based resources for researching and resolving
problems related to the WebSphere Application Server.

The WebSphere Application Server support page

The official site for providing tools and sharing knowledge about WebSphere Application Server problems

is the WebSphere Application Server support page: [http://www.ibm.com/software/webservers/appserv/

|support.htm| Among the features it provides are:

* A search field for searching the entire support site for documentation and fixes related to a specific
exception, error message, or other problem. Use this search function before contacting IBM Support
directly.

» Solve a problem links take you to specific problems and resolutions documented by WebSphere
Application Server technical support personnel.

» The Download links provide free WebSphere Application Server maintenance upgrades and problem
determination tools.

The fix packs and refresh packs for the WebSphere Application Server for i5/0OS products are also
provided in the group PTF for the WebSphere Application Server product. The WebSphere Application
Server group PTF also includes other i5/0S group PTFs which are necessary for running your
application servers. For more information see the [PTFs page]

— fixes are software patches which address specific WebSphere Application Server defects. Selecting a
specific defect from the list in the Fixes by version page takes you to a description of what problem
the fix addresses.

— Fix packs are bundles of multiple fixes, tested together and released as a maintenance upgrade to
WebSphere Application Server. Refresh packs are fix packs that also contain new function. If you
select a fix pack from this page, you are taken to a page describing the target platform, WebSphere
Application Server prerequisite level, and other related information. Selecting the fix list link on that
page displays a list of the fixes which the fix pack includes. If you intend to install a fix which is part
of a fix pack, it is usually better to upgrade to the complete fix pack rather than to just install the
individual fix.

Accessing WebSphere Application Server support page resources

Some resources on the WebSphere Application Server support page are marked with a key icon. To
access these resources, you must supply a user ID and password, or register if do not already have an ID.
When registering, you are asked for your contract number, which is supplied as part of a WebSphere
Application Server purchase.

WebSphere Developer Domain

The Developer Domains are IBM-supported sites for enabling developers to learn about IBM software
products and how to use them. They contain resources such as articles, tutorials, and links to newsgroups
and user groups. You can reach the WebSphere Developer Domain at |http://www7b.software.ibm.com/1

The IBM Support page

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |Must gatherl documents for information to gather to send to IBM Support.
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Debugging Service details

Use this page to view and modify the settings used by the Debugging Service.

To view this administrative console page, click Servers > Application Servers > server name >
Debugging Service.

The steps below describe how to enable a debug session on WebSphere Application Server. Debugging
can prove useful when your program behaves differently on the application server than on your local
system.

Enable service at server startup
Specifies whether the server will attempt to start the Debug service when the server starts.

JVM debug port

Specifies the port that the Java virtual machine will listen on for debug connections.

JVM debug arguments
Specifies the debugging argument string used to start the JVM in debug mode.

Debug class filters

Specifies an array of classes to ignore during debugging. When running in step-by-step mode, the
debugger will not stop in classes that match a filter entry.

Configuration problem settings

Use this page to identify and view problems that exist in the current configuration.

To view this administrative console page, click Troubleshooting > Configuration Problems in the
console navigation tree.

To view a configuration problem, click Configuration Validation in the console navigation tree, then select
the type of configuration you want to view.

Configuration document validation
Use these fields to specify the level of validation to perform on configuration documents.

Maximum
Selecting Maximum: Validate all documents turns on validation for all documents, regardless of
whether or not they are extracted, and regardless of the relationships between the documents.

High Selecting High: Validate extracted, parent, and sibling documents turns on validation for
extracted documents and their parent documents, and turns on validation for the sibling
documents of the documents which have been extracted. For example, if High validation is
selected, and if the server.xml document is extracted, when performing validation, validation is
performed on the three documents: server.xml, node.xml, and cell.xml. and on the two sibling
documents variables.xml and resources.xml within the server1 directory.

Medium
Selecting Medium: Validate extracted and parent documents turns on validation for the
documents which have been extracted by the user interface, and also turns on validation of the
parent documents of the documents which have been extracted. For example, using the partial
directory structure from above, if Medium validation is selected, and if the server.xml document is
extracted, when performing validation, validation is performed on all three of the documents
server.xml, node.xml, and cell.xml.
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Low Selecting Low: Validate extracted documents turns on validation for just those documents which
have been extracted by the user interface.

None Selecting None disables validation. No configuration documents are validated.

Enable Cross validation

Enables cross validation of configuration documents. Enabling cross validation enables comparison of
configuration documents for conflicting settings.

Configuration Problems

Displays current configuration problem error messages. Click a message for detailed information about the
problem.

Scope
Sorts the configuration problem list by the configuration file where each error occurs. Click a message for
detailed information about the problem.

Message
Displays the message returned from the validator.

Explanation
A brief explanation of the problem.

User action
Specifies the recommended action to correct the problem.

Target Object

Identifies the configuration object where the validation error occurred.

Severity
Indicates the severity of the configuration error. There are three possible values for severity.

Error This means that there is a problem with the configuration that might cause partial or complete
failure of server function. This is the most severe warning.

Warning
This means that there is a problem with the configuration that might cause a failure of server
function, or that might cause the server to function in an unexpected manner.

Information
A setting of the configuration that is unexpected and noteworthy, which requires customer
notification. Information is used when the configuration has a value which is probably okay, but
should be double checked by the administrator. This is the least crucial level of severity.

Local URI

Specifies the local URI of the configuration file where the error occurred.

Full URI

Specifies the full URI of the configuration file where the error occurred.

Validator classname
The classname of the validator reporting the problem.
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Runtime events

Use the Runtime event pages of the administrative console to view the events published by application
server classes.

To view these administrative console pages, click Troubleshooting. Expand Runtime Messages and click
either Runtime Error, Runtime Warning, or Runtime Information.

Separate pages show error events, warning events, and informational events. Each page displays events
in the same format.

You can adjust the number of messages that appear on the page in the Preferences settings.

Fields on the page include:

Timestamp
When the event occurred.

Message originator
Internal application server class that published the event.

Message
Identifier and short description of the event.

Click a message to view event details.

Message details

Use the Message Details panel of the administrative console to view detailed information about errors,
warnings, and informational messages.

To view these administrative console pages, click Troubleshooting. Expand Runtime Messages and click
either Runtime Error, Runtime Warning, or Runtime Information. Click a message to display this panel.
Each message has the following general property fields:

Message
The message ID and text.

Message type
Error, Warning, or Information.

Explanation
A description of the message.

User action
What you should do about the message.

Message originator
The name of the product class that originated the message.

Souce object type
The name of the component that originated the message.

Timestamp
The date and time that the message originated.

Thread ID
The thread identifier.

Node name
The name of the node of the application server that originated the message.
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Server name
The name of the application server process that originated the message.

Diagnostic Provider ID
The Diagnostic Provider ID of the component that originated the message. Click on Configuration
Data, State Data, or Tests to run the corresponding diagnostic action against the originating
component. A Diagnostic Provider ID will not be supplied with all messages.

Showlog commands for Common Base Events

The showlog command converts the service log from binary format into plain text.
Purpose

These showlog commands to produce output in Common Base Event XML format.
* showlog -format CBE-XML-1.0.1 filename

where:

filename
Is the service log file name.

For examples of showlog scripts, see |Showlog Script.

Working with Diagnostic Providers

Diagnostic Providers enable you to query the startup configuration, current configuration, and current state
of a diagnostic domain. In addition, Diagnostic Providers can also provide access to any self diagnostic
tests that are available from a diagnostic domain.

WebSphere Application Server provides a set of facilities to accomplish this. The Diagnostic Provider Utility
is a simple front end in the administration console that presents the available set of Diagnostic Providers
and enables you to work with them.

[Learn about Diagnostic Providers|

Diagnostic Providers

WebSphere Application Server components can be considered as being divisible into diagnostic domains.
A diagnostic domain refers to a set of classes within the component that share a set of diagnostics. Some
larger components might have multiple diagnostic domains. For example, the Connection Manager
logically consists of multiple data sources and connection factories that each have separate diagnostic
domains
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This image shows the relationships between the parts that make up the Diagnostic Provider (DP) utility.
Diagnostic Provider MBeans

A single diagnostic domain receives its diagnostic services from a Diagnostic Provider MBean. The

Diagnostic Provider MBean enables you to query the startup configuration, current configuration, and

current state of the diagnostic domain. In addition, Diagnostic Provider MBeans can also provide access to

any self diagnostic tests that are available from the diagnostic domain. Some characteristics of Diagnostic

Provider MBeans include:

» Diagnostic Provider MBeans are Java Management Extensions (JMX) MBeans

» Diagnostic Provider MBeans all implement a DiagnosticProvider interface which includes methods for
configuration dumps, state dumps, and self diagnostic tests

» Diagnostic Provider MBeans provide a way to expose information about running components so
administrators can more easily debug problems related to those components. As with other MBeans
running in WebSphere Application Server, they can be accessed from JMX client code, or through the
wsadmin tool.

Diagnostic Provider Infrastructure

Diagnostic Provider MBeans are efficient at delivering Java object representations of configuration, state,
and self test information. This is good for when programs interact. For human users to access the
information, WebSphere Application Server provides a set of facilities to extend the value of Diagnostic
Provider MBeans.

The Diagnostic Service MBean
provides methods to convert Diagnostic Provider MBean output into human readable formats. The
Diagnostic Service MBean also provides some methods to facilitate looking up the Diagnostic
Provider MBeans on the same server as the Diagnostic Service MBean. For administrators that
want to access diagnostic data from a command line, the wsadmin tool can be used directly with
the Diagnostic Service MBean to get formatted results
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The Diagnostic Provider utility
a set of panels included in the WebSphere Application Server administration console through
which administrators can interact with Diagnostic Provider MBeans. The Diagnostic Provider utility
is a simple front end in the administration console that presents the available set of Diagnostic
Provider MBeans present on each managed server, and provides a means to execute and view
the results of configuration dumps, state dumps, and diagnostic self tests.

The purpose of Diagnostic Providers

Diagnostic Providers give you more information for quickly discovering and diagnosing system problems.
The following scenario contrasts the experience of a n administrator working with a component that does
not have a Diagnostic Provider to one that does.

When the administrator works with a component that is without a Diagnostic Provider, the events are as

follows:

1. Alog entry indicates that a particular component is experiencing a problem.

2. The system administrator sees the log entry through the runtime messages panel.

3. The system administrator cannot tell what is wrong, so calls IBM support for assistance, with a
potentially ill-defined problem.

When the administrator works with a component with a Diagnostic Provider, and the Diagnostic Provider

ID is registered with the component’s logger, the situation changes as follows:

1. Alog entry that contains a Diagnostic Provider ID (DPID) indicates that something has gone wrong in a
specific component.

2. The system administrator sees the log entry through the runtime messages panel.

3. The administrator clicks a button on the runtime message panel to execute a state dump or a
configuration dump, or to be taken to the list of component self tests.

4. From the self test, the administrator is warned that the component is configured in a way that could
lead to poor performance or failures.

Furthermore, when the administrator works with a component with a Diagnostic Provider, and the

Diagnostic Provider ID is not registered with the component’s logger, the situation might unfold like this:

1. Alog entry which doesn’t contain a DPID indicates that something has gone wrong in a component.

2. The system administrator sees the log entry through the runtime messages panel.

3. The system administrator uses the administrative console to navigate through the available set of
Diagnostic Providers and selects one that sounds appropriate.

4. He runs a configuration dump, a state dump, or a self diagnostic test against the Diagnostic Provider
to collect information about the component.

5. From the state dump, the administrator is able to notice that the component state is not what would be
expected for its workload.

6. The administrator works with the test team to determine which of the flows is causing the state of the
component to diverge from what is expected (as evidenced by repeated execution of the state dump).

Diagnostic Provider IDs

A Diagnostic Provider ID (DPID) is the unique address of a Diagnostic Provider MBean. Components that
have associated Diagnostic Provider MBeans can include the DPID in their log entries. Diagnostic Provider
IDs are implemented in WebSphere Application Server as Java Management Extensions (JMX) MBean
ObjectNames, and can be used at JMX MBean servers to look up Diagnostic Provider MBeans.

back to the Diagnostic Provider related to the component. A|method|is provided to associate Diagnostic
Provider IDs with Loggers (from the java.util.logging logging API).

By including the String representation of the DPID in each logged message, the message can be tracked
h
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The diagram above shows how the use of DPIDs in log entries enables callbacks to the component that

originally created the log entry.

1. Shows the component logging with a DPID included in the log entry.

2. The administrator examines the log entry through the Runtime Messages Utility and notices that the
entry has a link to a Diagnostic Provider.

3. The administrator uses the link to gain access to the relevant MBean in the Diagnostic Provider Utility .

4. The Diagnostic Provider Utility contacts the Diagnostic Provider MBean to ask for more information.

5. The request for more information is sent back to the source of the original log entry.

6. The response from the Diagnostic Provider is provided in the administration console.

Diagnostic Provider configuration dumps, state dumps, and self tests

The Diagnostic Provider (DP) infrastructure allows for a software component or stack product in the
WebSphere Application Server space to expose key information about its configuration, current state, and
current ability to perform operations. The methods that expose this information might be driven as a result
of a message put out by the component (by a logger which automatically includes the Diagnostic Provider
ID in each message), or might be driven as a result of an overall system health-check when an
administrator or automated tool is monitoring the system.

Configuration dumps

A Configuration dump is an operation you can perform on a Diagnostic Provider to list the startup or
current values of the configuration attributes for the DP. The name for each data item in this dump should
reflect its disposition. That is, each item should be called startup-xxx or current-xxx to show whether this is
a startup or current value. The collection of attributes returned from this operation can be thought of as the
payload of the configuration dump. More information about payloads can be found in [‘Diagnostic Provider|
[method implementation” on page 140

You can find several ways to filter the output of a configuration dump in |“Diagnostic Provider registered|
lattributes and registered tests” on page 135

State dumps

A State dump is similar to a configuration dump, but it differs in two key areas. First, a state dump displays
current information about the operation of a component. An example is a connection pool. A configuration
dump can show DataSource name, the minConnections (configured or current), the maxConnections, the
DataBase name, and so on. A state dump is more likely to show the current connections in use, the high
concurrent use count, the number of times the pool has been expanded, the average time between
requesting a connection and returning it, and so forth.

134  Troubleshooting and support



State dumps can be impacted by the values in the State Collection Specification. This is a dynamic
specification that controls additional data collection that the component can do at runtime. If additional data
is being collected, then a State dump might display more information. The same filters and payload
information that apply to Configuration dumps (see [‘Diagnostic Provider registered attributes and|
[registered tests”) apply to State dumps.

Self Diagnostic tests

Self diagnostic tests are non-invasive operations that a Diagnostic Provider exposes. Non-invasive means
that if they modify anything for the test, the conclusion of the test reverses the modification. These tests
give an administrator the option to test simple functions of a component to see if it is able to perform them.

The filters for a self diagnostic test apply to the test itself, not to the output of the test. A typical use of Self
Diagnostic tests could be for a pool manager of some sort to pull an object out of the pool and return it to
the pool to verify that this operation can still be performed, and with acceptable performance.

Diagnostic Provider registered attributes and registered tests

Each Diagnostic Provider (DP) provides a list of state dump attributes, configuration dump attributes, self
tests, and self test attributes. The tests are operations that the DP can perform. The attributes are pieces
of information that are available for collection from a Configuration dump, a State dump, or a specific Self
Diagnostic test.

Each attribute can be seen as a piece of information with a label on it. Each attribute is also considered to
be either registered or not registered. A registered attribute is one that should be available from one
release of WebSphere Application Server to the next. A nonregistered attribute might not be available in its
current form in future releases of the product (no commitment has been made).

When performing a Configuration dump, a State dump, or a Self Diagnostic test, an administrator or
automatic tooling can request only registered values, or all values, depending on the needs of the
administrator or tool. Note that the option of filtering results is only available through the Diagnostic
Provider's Java Management Extension (JMX) MBean interface, which you can access programmatically
or through the wsadmin tool.

Diagnostic Provider registered attributes and registered tests detail: This article includes a
discussion of the DiagnosticProviderRegistration Extensible Markup Language (XML) file and how it is
used in conjunction with the method signatures to filter the results of calling the various methods.

The DiagnosticProviderRegistration XML file

This XML defines the configuration information, state information, and self diagnostic tests exposed by the
component. In the configuration and state information, the key working unit is referred to as the attribute.
Specification of an attribute is as follows:
<attribute>
<jd><Regular Expression representing the attribute name></id>
<descriptionKey><MsgKey into a ResourceBundle for localization of the label></descriptionKey>
<registered>true</registered>
</attribute>

The parts are as follows:

ID: The attribute’s name. This name can be expressed with wildcard characters conforming to regular
expression syntax. The registered attribute ID is used in the following places:
» Within Diagnostic Provider configuration dump and state dump methods to determine which
attributes to return.
* In the administration console to match description keys to attributes returned from a request to
a Diagnostic Provider for a configuration dump, state dump, or self diagnostic operation.
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As an example, if a configuration dump returns an attribute with ID cachedServlet-MyServlet-
servletPath to the administration console, the administration console could use the descriptionKey
corresponding to the attribute registered as <id>cachedServlet-.*-servletPath</id> when
selecting what description text to put next to this attribute’s name and return values.

descriptionKey:
This is a key into a resourceBundle for localization.

registered:
This is a boolean qualifying whether this attribute will be available from one release of the software
to the next. If registered is true, then this attribute should be available in the next release. If
registered is false, then there is no guarantee that this attribute will continue to exist. Automation
should use some caution when handling non-registered attributes.

Specification of a selfDiagnosticTest is as follows:

<test>
<id><Regular Expression for the name of the test></id>
<descriptionKey><MsgKey into a ResourceBundle for localization of the label></descriptionKey>
<attribute><One or more attributes which will be output from this test></attribute>
</test>

The parts are as follows:

ID: Similar to the ID for the attribute, but in this case, describing the test to be performed instead of
the attribute to be returned.

descriptionKey:
This is a key into a resourceBundle for localization.

Method interfaces

public DiagnosticEvent [] configDump(String aAttributeld, boolean aRegisteredOnly);
public DiagnosticEvent [] stateDump(String aAttributeld, boolean aRegisteredOnly);

These methods invoke the configuration or state dump on the component, and specify a regular
expression filter for the attributes to return as well as filtering the output to include all matching attributes,
or only those attributes which are registered. This enables the administrator or automated software driving
the method to specify a subset of the overall fields (especially important if many attributes are exposed or
if the State Collection Specification increases the amount of data available). The following helper methods
are available to assist with filtering the output.

To take a list of Attributes that are available to return, and filter them:

public static AttributeInfo [] queryMatchingDPInfoAttributes(String aAttributeld,
AttributeInfo [] inAttrs, String [] namesToCheck, boolean aRegisteredOnly) {

To take a single Attribute that is available to return, and filter it:

public static AttributeInfo queryMatchingDPInfoAttributes(String aAttributeld,
AttributeInfo [] inAttrs, String nameToCheck, boolean aRegisteredOnly) {

To go through a populated set of Attribute Information and remove unneeded parts:
public static void filterEventPayload(String aAttributeld, HashMap paylLoad) {

For details on these messages, please review the API documentation for the DiagnosticProviderHelper
class. The basic concept is that, once the component knows what attributes are able to be returned, the
helper method will determine which of them should be returned based on the regular expression logic and
registration boolean.

The selfDiagnostic Method interface here is similar to that of Configdump and Statedump:
public DiagnosticEvent[] selfDiagnostic(String aTestId, boolean aRegisteredOnly)
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The difference is that the first parameter is a regular expression filter for which test to run.

Diagnostic Provider names

In addition to the Diagnostic Provider ID (DPID), each component that implements the Diagnostic Provider
interface must have a Diagnostic Provider Name. While the DPID must be unique within the entire
WebSphere Application Server domain, the Diagnostic Provider Name need only be unique within the Java
Virtual Machine (JVM).

Unlike the Diagnostic Provider ID, which tends to be long and not human-friendly, the Diagnostic Provider
Name should be shorter and easier to read. In addition, by convention it should end in DP. The Diagnostic
Service MBean (see |“The simpler interfaces provided by the Diagnostic Service MBean”[) can drive
methods on a Diagnostic Provider using its name.

The simpler interfaces provided by the Diagnostic Service MBean

All services for a Diagnostic Provider (DP) are also available through a Java Management Extensions
(JMX) interface known as the Diagnostic Service interface. The Diagnostic Service interface enables
administrators to drive methods against DPs using the Diagnostic Provider Name or Diagnostic Provider
ID. When formatted output is requested of the Diagnostic Service, it is localized to the client Locale. This
makes the Diagnostic Service MBean ideal for clients using an interface where consuming complex Java
objects, such as those returned from the Diagnostic Provider MBeans, is not feasible. An example of such
an interface is the wsadmin tool.

The simpler interfaces provided by the Diagnostic Service MBean detail: The Diagnostic Service
interface provides four signatures for each of the key methods available on the Diagnostic Providers
(configDump, stateDump, and selfDiagnostic) objects. Because these method signatures look so similar,
this example shows it all through the configDump methods. The four Diagnostic Service methods that map
to configDump on a Diagnostic Provider are:
public DiagnosticEvent [] configDump(String aDPName, String aAttributeIdSpec, boolean aRegisteredOnly)
public DiagnosticEvent [] configDumpById(String aDPid, String aAttributeldSpec, boolean aRegisteredOnly)
public String [] configDumpFormatted(String aDPName, String aAttributeldSpec,

boolean aRegisteredOnly, Locale alocale)

public String [] configDumpFormattedById(String aDPid, String aAttributeldSpec,
boolean aRegisteredOnly, Locale alocale) {

The first two return exactly what the Diagnostic Provider does. The second two methods act as a
pass-through to the actual Diagnostic Provider, but they take the array of Diagnostic Events that the
Diagnostic Provider returns, and convert it into a more easily consumable String array. In addition, these
methods handle localizing the output to the appropriate Locale. Important to note is that the same method
can be driven using the Diagnostic Provider ID, or the Diagnostic Provider Name.

Creating a Diagnostic Provider

To complete this task you must have programming knowledge of your system and the proper authorities to
perform the following steps.

The steps that follow outline a general process for creating Diagnostic Providers (DP).

1. Determine your diagnostic domain. Look for configuration MBeans that control a similar domain in the
same component. Extending an existing configuration MBean with a DP interface avoids proliferation of
new MBeans and has the benefit that mapping from a diagnostic MBean to a configuration MBean
requires no additional information.

2. Determine what configuration attributes you want to expose. Include information that is used to
configure your component from the configuration MBeans.

3. Determine what state attributes you want to expose. Anything you might want to know about the state
of your component for troubleshooting can go here.

4. Determine what self diagnostic tests you will expose.
5. Determine what test attributes you will return for each self diagnostic.
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[Create your DP registration Extensible Markup Language (XML) file |
Create your DP implementation.

a. To see an example, refer to [‘Implementing a Diagnostic Provider’ on page 139|and keep in mind
that most things that a Diagnostic Provider should do are already done for you in the
DiagnosticProviderHelper class.

b. To ensure that you do not collect unwanted data, add hooks in your component code where you
need to collect state data using the DiagnosticConfig object.

¢. Add hooks in your component code where you need to store or be able to access configuration
data.

Add code to register your DP implementation. Typically, the best place to do this is where your
component is initialized.

Add Diagnostic Provider IDs (DPID) to your logged messages. Registering a DPID with a logger
makes that information available in any messages logged with this logger. This enables fast paths in
the DP utility to function on this particular Diagnostic Provider.

a. Register your DPID with your loggers (for any of your loggers that you only want to associate a
single DPID with).

b. When you use multiple DPIDs with the same Logger, you can (instead of registering a single DPID
with a Logger) add DPIDs to individual logging calls in the parm[0] position. Do not put {0} in the
corresponding localized messages. It is bad practice to print the DPID in your messages as this
would be inconsistent with messages from loggers with statically assigned DPIDs.

Conventions for Diagnostic Provider Extensible Markup Language
Some conventions to follow for Diagnostic Provider (DP) Extensible Markup Language (XML) declarations.

These guidelines are to help keep your use of Diagnostic Providers (DP) consistent.

Include the Document type definition (DTD) for your Diagnostic Provider at the top of every DP
declaration Extensible Markup Language (XML) file.

Start all names and name segments with lower case. Use camel case for attribute names. That is,
capitalize every initial letter in the name, except the first. For example, traceCollectionSpec.

Indicate hierarchy with dashes. Dashes work better than dots because attribute names are regular
expressions. For example, traceService-traceCollectionSpec.

Indicate string dynamic parts to attribute names using an asterisk (*). For example,
vhosts-.*-webgroups-.*-webapps-.*-listeners-filterInvocationListeners

which would match vhosts-someHost-webgroups-someGroup-webapps-someApp-listeners-
filterinvocationListeners

Indicate numeric dynamic parts to attribute names using [0-9]*. For example,
vhosts-index-[0-9] *

which would match webcontainer-vhosts-index-123

If you have a general purpose self diagnostic test that can be run without significant performance cost,
name it general.

Some tips for configDump implementation

configDump should contain information used to define the component’s environment. Some examples
are:

— configuration data set by Java Management Extensions (JMX)
— configuration from system properties, xml files, and property files

— configuration information hard-wired and unchanging in code (such as, if a resource adapter
implements interface X, or has some static final field Y, then those could indicate aspects of
configuration and be included in the configDump).
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« configDump should not contain dynamically registered attributes, such as:
— a list of registered loggers (this belongs in stateDump)
— a list of servlets in an application (this belongs in stateDump).

» configDump should be separated into 2 sections -- startup and current.
— All configDump attributes must start with either startup- or current-.

— The startup section details the component’s environment at startup time. Startup configDump
attributes start with startup- .

— The current section details the component’s environment at the moment the configDump is
requested. Current configDump attributes start with current-.

Best practices for configDump
» Group related attributes using an attribute hierarchy (such as, for two attributes about the tracelLog:
startup-traceLog-rolloverSize=20, startup-traceLog-maxNumberOfBackupFiles=1)

» For information in the current attribute list that refers to the same thing as a startup attribute, the names
of both current and startup attributes should match.

« If an attribute has no use after startup, only show it in the startup section (for example, a configuration
attribute that contains a file name from which startup data is read).

Tips for choosing a Diagnostic Provider name
To ensure consistency when choosing Diagnostic Provider names to use with your components, you
should consider the guidelines that follow.

Diagnostic Provider name guidelines:

» Names must be unique within a Java Virtual Machine (JVM). One Diagnostic Provider name goes
uniquely with one Diagnostic Provider ID within a server.

+ If necessary, names can contain a dynamic element to help with uniqueness. Of course, the dynamic
element should have meaning to the administrator.

» Although not a hard limit, the static part of names should be 16 characters or less.

» The static part of names must follow the class name convention. Start with a capital letter, no spaces,
and capitalize each word in the name.

» The static part of names must end with DP.

» Valid names contain a static part only, or a static part followed by a dash (-), followed by a dynamic
part. Some valid examples:
— ConnMgrDP-instance_specific_stuff

WebContainerDP

AdvisorDP

NodeAgentDP

Implementing a Diagnostic Provider

This task presumes that you have a programming knowledge of the creation of MBeans. For more
information about the interaction of MBeans with WebSphere Application Server, refer to topic, Creating
and registering standard, dynamic, and open custom MBeans in the Administering applications and their
environment PDF book.

The steps that follow outline a general process for implementing a Diagnostic Provider (DP).

1. Modify the MBean descriptor Extensible Markup Language (XML). To implement a Diagnostic Provider,
you must have an MBean, and the MBean should include this statement in its descriptor XML as a
direct child of the MBean element:

<parentType type="DiagnosticProvider"/>
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This defines the operations, attributes, and aggregators necessary for an MBean to be a Diagnostic
Provider. If you do not need to have this DP exist in z/OS Controllers, then this XML inclusion handles
all zZ/OS specifics for your MBean.

2. Modify the MBean Implementation. Your MBean should already have a class which instantiates it and
registers it with the Java Management Extensions (JMX) server.

The first difference here is that you must define a property in the Properties class that is passed to the
registration (and becomes part of the ObjectName). The property is diagnosticProvider=true and it
can be added with a line of code such as:

MyProps.setProperty(DiagnosticProvider.DIAGNOSTIC_PROVIDER KEY, DiagnosticProvider.DIAGNOSTIC PROVIDER VALUE) ;

The second difference is that this class should register this Diagnostic Provider with the Diagnostic
Service. A helper method is available to do this:

DiagnosticProviderHelper.registerMBeanWithDiagnosticService(DiagnosticProviderPName, DiagnosticProviderId) ;

Obviously this must be done after the registration when the ObjectName can be retrieved into the
DiagnosticProviderld string.

3. Implement the |[Diagnostic Provider methods|

Diagnostic Provider method implementation: To create a Diagnostic Provider (DP), you must have an
MBean, and your MBean should include the following methods in its deployment Extensible Markup
Language (XML) file. This can be accomplished by adding the parentType directive to your existing XML
file (see [lImplementing a Diagnostic Provider’ on page 139), or by including the operations directly into
your deployment XML file. The definitions needed are included in [‘Diagnostic Provider registered attributes|
land registered tests” on page 135.| This defines the operations, attributes, and aggregators necessary for
an MBean to be a Diagnostic Provider. The next step is for the MBean to actually implement these
methods. The methods to implement include:

+ [“getRegisteredDiagnostics’|

+ [“getDiagnosticProviderName” on page 141|

+ [‘getDiagnosticProviderlD” on page 141|

+ [“‘configDump” on page 141|

+ [“stateDump” on page 141|

+ [“selfDiagnostic” on page 142|

+ [“localize” on page 142

getRegisteredDiagnostics

This method exposes the registration information for this Diagnostic Provider. It is commonly used by the
DP Utility in the administration console to gather information about Diagnostic Providers that are to be
displayed in the console. This method returns a DiagnosticProviderinfo object that is usually attained by
passing the appropriate XML to a DiagnosticProviderHelper helper class. Here is an example:
public DiagnosticProviderInfo getRegisteredDiagnostics() {

InputStream regIS= Thread.currentThread().getContextClassLoader().getResourceAsStream(

"com/ibm/ws/xxx/SampleDP2DiagnosticProvider.xml");
dpInfo = DiagnosticProviderHelper.loadRegistry(regIS, sDPName) ;

if (dpInfo == null) {
sSampleDP2MBeanLogger.logp(Level .WARNING, sThisClass, "getRegisteredDiagnostics",
"RasDiag.DPInfo.NoGotz") ;
}

return dpInfo ;
}

Notice that the XML is packaged and available in the classpath of the current classloader. The
‘Registration XML” on page 143 contains crucial information that the Diagnostic Provider uses to ['Populate]
the payload” on page 143 and|“localize” on page 142| results.
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getDiagnosticProviderName

This is usually a pretty simple return of a constant as the following example shows

public String getDiagnosticProviderName() {
return sDPName;

}
getDiagnosticProviderlD

This is usually a pretty simple return of a Java Management Extensions (JMX) object ID that MBeans can
pull out of the base class method. For example:
public String getDiagnosticProviderId() {

return getObjectName().toString() ;
}

configDump

The configDump method enables the Diagnostic Provider to expose the configuration data that was in
place when this Diagnostic Provider started (or the current values of them). The DiagnosticEvent objects
that this method returns include a|“Payload” on page 142|that contains the core data. The following is an
excerpt from a configDump method:

public DiagnosticEvent [] configDump(String aAttributeldSpec, boolean aRegisteredOnly) {
HashMap cdHash = new HashMap(64) ;

/1

[‘Populate the payload” on page 143| DiagnosticEvent [] diagnosticEvent = new DiagnosticEvent[1] ;
diagnosticEvent[0] = DiagnosticEventFactory.createConfigDump(getObjectName().toString(),
"ThisClassName”, "configDump”, cdHash) ; return diagnosticEvent ; }

This returns an array of DiagnosticEvent objects. Normally, configDump and stateDump return only one
object. However, the method accepts an array because on z/OS systems a server can have multiple
servants, and aggregation of the output from the servants is stored in the array.

stateDump

The stateDump method enables the Diagnostic Provider to expose the current state data, or data about
the current operating conditions of the Diagnostic Provider. The data made available can be anything likely
to assist a customer, an IBM support person, or automated tooling in analyzing the health of the
component and problem determination if there is an issue. The amount of data available is impacted by
the [State Collection Specification|in effect at the time. If the current State Collection Specification involves
the collection of additional data by the Diagnostic Provider, then this additional data can be exposed in the
stateDump. The DiagnosticEvent objects that this method returns include a[‘Payload” on page 142| that
contains the core data. The following is an excerpt from a stateDump method:

public DiagnosticEvent [] stateDump(String aAttributeldSpec, boolean aRegisteredOnly)
HashMap sdHash = new HashMap(64) ;

//

|“Populate the payload” on page 143| DiagnosticEvent [] diagnosticEvent = new DiagnosticEvent[1] ;
diagnosticEvent[0] = DiagnosticEventFactory.createStateDump(getObjectName().toString(),

non

"ThisClassName”, "stateDump”, sdHash) ; return diagnosticEvent ; }

This returns an array of DiagnosticEvent objects. Normally, configDump and stateDump return only one
object. However, the method accepts an array because on z/OS systems a server can have multiple
servants, and aggregation of the output from the servants is stored in the array.
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selfDiagnostic

The selfDiagnostic method enables the Diagnostic Provider to perform certain predefined activities to test
key functionalities of your system. These tests should not have a lasting effect on the system. For
example, if the test is to create a TCP/IP connection to a remote host, the test should also break that
connection before returning its results so that the state of the component is unchanged by the test. The
information returned by the test is determined by the attributes included in the test section of the XML file.
The following is an excerpt from a selfDiagnostic method:
public DiagnosticEvent [] selfDiagnostic(String aAttributeldSpec, boolean aRegisteredOnly) {

TestInfo [] testInfo = dpInfo.selfDiagnosticInfo.testInfo ; // Retrieve the test registry information

Pattern testChecker = Pattern.compile(aAttributeIdSpec) ; // Compile test regexp parm for faster checking

ArrayList delList = new ArrayList(8) ; // Allocate expandable list of DiagnosticEvents

for (int i = 0; i < testInfo.length; i++) {

if (testChecker.matcher(testInfo[i].id).matches()) {
HashMap deHash = new HashMap(32) ;

/1

[‘Populate the payload” on page 143
deList.add(DiagnosticEventFactory.createDiagnosticEvent(getObjectName().toString(),
DiagnosticEvent.EVENT_TYPE_SELF_DIAGNOSTIC, DiagnosticEvent.LEVEL_INFO, "ThisClassName”,
"selfDiagnostic”, dplnfo.resourceBundleName, "RasDiag.SDP2.createDE3", // MsgKey for localization //
Parms to incorporate in msg new Object [] { "OneParm”, "TwoParm”, "RedParm”, "BlueParm”}, deHash)) ;
} } DiagnosticEvent [] diagnosticEvent = new DiagnosticEvent[deList.size()] ; diagnosticEvent =
(DiagnosticEvent [])deList.toArray(diagnosticEvent) ; return diagnosticEvent ; }

This returns an array of DiagnosticEvent objects. In this example, one DiagnosticEvent was created
from each test that matched the parameter regular expression. The Diagnostic Provider is not required to
produce only one per test. The generation of is similar to that of configDump and stateDump.
Aggregation on multiple z/OS servants for an individual server concatenates the arrays from each servant.

localize

The DiagnosticEvents that methods return contain payload HashMaps that contain MessageKeys and
ResourceBundles. The final consumer of these events is often not on the server, and thus may not have
the appropriate classpath to resolve this. For this purpose, a callback to the Diagnostic Provider to localize
the variables is done. A helper method, however, makes it a simple method to write, as this example
demonstrates:
public String [] localize(String [] aKeys, Locale alocale) {

return DiagnosticProviderHelper.localize(dpInfo.resourceBundleName, aKeys, alocale) ;

}

Note that the dplnfo (DiagnosticProviderinfo) object is needed as this object includes a reference to the
ResourceBundle.

Payload

A recurring theme in these methods is the ability to include a payload in return objects. This is a set of
name=value pairs that include the information being exposed by the method. Diagnostic Events returned
from a configDump, stateDump, or selfDiagnostic test are relatively complex Java objects. The majority of
the information that is returned is contained in the DiagnosticData portion of the DiagnosticEvent object.
Each attribute returned by the Diagnostic Provider is stored in an entry in a HashMap. There can be
cascading HashMaps within a single DiagnosticEvent object (if breaking the data down into subGroups
makes sense). Each HashMap entry contains either a reference to a child HashMap, or a
DiagnosticTypedValue (which contains the value, the type of data, and a MsgKey for localization of the
label or /name). The values to be returned should be filtered with:

* The type of method (that is, configDump, stateDump, or selfDiagnostic)
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* The AttributeldSpec sent in to filter the values
* The current State Collection Specification (which can impact the amount of data available).

Populate the payload

The APl documentation for DiagnosticProviderHelper.queryMatchingDPInfoAttributes explains how to do
the filtering before retrieving the data. In some cases, it is easier and helps performance for a Diagnostic
Provider to retrieve all data into the Payload and then filter the HashMap after the fact. The
post-population filtering can be done with the method DiagnosticProviderHelper.filterEventPayload. For
information on use of the JavaBean type approach, see the APl documentation for the
AttributeBeaninfo.populateMap method.

Registration XML

Registration XML enables much of the information needed by the Diagnostic Provider to be externalized. It
also provides a means of commonizing localization and consumption of the tests (thus aiding automation).
An excerpt of this XML from a sample Diagnostic Provider follows:

<IDOCTYPE diagnosticProvider PUBLIC "RasDiag" "/DiagnosticProvider.dtd">

<diagnosticProvider>
<resourceBundleName> com.ibm.ws.rasdiag.resources.RasDiagSample</resourceBundleName>
<state>
<attribute>
<id>Leg-Foot</id>
<descriptionKey>SampleDiagnostic.LegFoot.descriptionKey</descriptionKey>
<registered>true</registered>
</attribute>
<attribute>
<id>Leg-Ankle</id>
<descriptionKey>SampleDiagnostic.LegAnkle.descriptionKey</descriptionKey>
<registered>true</registered>
</attribute>
</state>
<config>
<attribute>
<id>Arm-Hand-Size</id>
<descriptionKey>SampleDiagnostic.HandSize.descriptionKey</descriptionKey>
<registered>true</registered>
</attribute>
<attribute>
<id>Leg-Foot-Size</id>
<descriptionKey>SampleDiagnostic.FootSize.descriptionKey</descriptionKey>
<registered>true</registered>
</attribute>
</config>
<selfDiagnostic>
<test>
<id>Kick</id>
<descriptionKey>SampleDiagnostic.Kick.descriptionKey</descriptionKey>
<attribute>
<id>Kick-Pain</id>
<descriptionKey>SampleDiagnostic.KickPain.descriptionKey</descriptionKey>
</attribute>
<attribute>
<id>Kick-Length</id>
<descriptionKey>SampleDiagnostic.KickLength.descriptionKey</descriptionKey>
</attribute>
</test>
<test>
<id>Throw</id>
<descriptionKey>SampleDiagnostic.Throw.descriptionKey</descriptionKey>
<attribute>
<id>Throw-Pain</id>
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<descriptionKey>SampleDiagnostic.ThrowPain.descriptionKey</descriptionKey>
<registered>true</registered>
</attribute>
<attribute>
<id>Throw-Length</id>
<descriptionKey>SampleDiagnostic.ThrowLength.descriptionKey</descriptionKey>
<registered>true</registered>
</attribute>
</test>
</selfDiagnostic>
</diagnosticProvider>

For understanding the storage of this information into a DiagnosticProviderinfo object, see the API
documentation for DiagnosticProviderinfo. For conceptual information about the purpose of the registration
XML, see |“Diagnostic Provider registered attributes and registered tests” on page 135.|

Diagnostic Provider XML example:

Here is an example of the Diagnostic Provider Extensible Markup Language (XML).

version="6.0"
platform="common"
aggregationHandlerClass="com.ibm.ws.management.component.DiagnosticProviderAggregator"
description="DiagnosticProvider portion of Mbean for inclusion into MBeans implementing this interface">
<attribute
description="DiagnosticProviderName (not dependent on runtime, but subset of ObjectName"
getMethod="getDiagnosticProviderName" name="diagnosticProviderName"
type="java.lang.String" proxyInvokeType="unicall" proxySetterInvokeType="multicall"/>
<operation
description="Get the DiagnosticProvider ID"
impact="INFO" name="getDiagnosticProviderId" role="operation"
targetObjectType="objectReference" type="java.lang.String" proxyInvokeType="unicall">
<signature/>
</operation>
<operation
description="Return the registry information based on type (config/state/selfDiag)."
impact="INFO" name="getRegisteredDiagnostics" role="operation"
targetObjectType="objectReference"
type="com.ibm.wsspi.rasdiag.diagnosticProviderRegistration.DiagnosticProviderInfo"
proxyInvokeType="unicall">
<signature/>
</operation>
<operation
description="Dump the configuration information associated with managed resource."
impact="INFO" name="configDump" role="operation"
targetObjectType="objectReference" type="[Lcom.ibm.wsspi.rasdiag.DiagnosticEvent;"
proxyInvokeType="multicall">
<signature>
<parameter description="Attribute ID to use"
name="attributeld" type="java.lang.String"/>
<parameter description="Report on just registered info, or all info"
name="registeredOnly" type="boolean"/>
</signature>
</operation>
<operation
description="Dump state information for the managed resource."
impact="INFO" name="stateDump" role="operation"
targetObjectType="objectReference" type="[Lcom.ibm.wsspi.rasdiag.DiagnosticEvent;"
proxyInvokeType="multicall">
<signature>
<parameter description="Attribute ID to use"
name="attributeld" type="java.lang.String"/>
<parameter description="Report on just registered info, or all info"
name="registeredOnly" type="boolean"/>
</signature>
</operation>
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<operation
description="Perform diagnostics on the managed resource driven by current diagnostic mode setting."
impact="ACTION" name="selfDiagnostic" role="operation"
targetObjectType="objectReference" type="[Lcom.ibm.wsspi.rasdiag.DiagnosticEvent;"
proxyInvokeType="multicall">
<signature>
<parameter description="Test ID to use"
name="testId" type="java.lang.String"/>
<parameter description="Report on just registered info, or all info"
name="registeredOnly" type="boolean"/>
</signature>
</operation>
<operation
description="1ocalize messages for console display"
impact="INFQO" name="1localize" role="operation"
targetObjectType="objectReference" type="[Ljava.lang.String;"
proxyInvokeType="unicall">
<signature>
<parameter description="Message Keys" name="msgKeys" type="[Ljava.lang.String;"/>
<parameter description="Locale to use for output" name="locale" type="java.util.Locale"/>
</signature>
</operation>

Creating a Diagnostic Provider registration XML file
Programming knowledge of your system and the proper authorities to perform the following steps.

The steps that follow outline a general process for creating a Diagnostic Provider (DP) registration
Extensible Markup Language (XML) file. The registration XML is used to provide information about the
exposed configuration, state, and self diagnostic attributes and tests to the Diagnostic Provider utility. It is
also used to populate objects needed later in the process, to assist in filtering, and to assist in localization.

1. Start with the DP document type definition (DTD). If you are using the helper methods (see the step
called Create your DP implementation in ‘Creating a Diagnostic Provider’ on page 137), you can use
this DOCTYPE line to pick up the common DTD:

<IDOCTYPE diagnosticProvider PUBLIC "RasDiag" "/DiagnosticProvider.dtd">

If you are extending an existing MBean with an existing XML configuration, you might need either to
add the DP XML to an existing DTD, or omit the DP XML entirely. If you omit the DP XML, you will not
be able to validate that your XML file is well formed.

2. Follow the conventions described in [‘Conventions for Diagnostic Provider Extensible Markup]|
[Language” on page 138[to help keep your XML consistent with other components. You can find an
example of a small DP registration XML file in [‘Diagnostic Provider method implementation” on pagel

Associating a Diagnostic Provider ID with a logger

Components whose diagnostics are managed through a Diagnostic Provider MBean should include the
Diagnostic Provider ID (DPID) in all logged messages. In some cases a single logger always logs with the
same DPID. In those cases, it is appropriate to statically associate the DPID with the logger. In other
cases, a logger might log on behalf of various diagnostic domains. For example, although every data
source has a separate Diagnostic Provider MBean, they all share the same logger. In those cases, the
DPID can be dynamically supplied on each logging call.

Static Assignment
The method below statically assigns a DPID to a logger.

Associate a DPID with a logger:

Logger logger = Logger.getLogger("com.ibm.ws.MyClass");
DiagnosticProviderHelper.addDiagnosticProviderIDtoLogger(logger, dpid);
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Dynamic Assignment

DPIDs can be associated with a single log request by including them as the first message parameter,
prefixed with DPID:. To associate a DPID with a single log request using a logger:

Object[] parms = new Object[] { "DPID:" + dpid };
Togger.logp(classname, methodname, "MSGOOO1", parms);

Note that in the dynamic case, the DPID does not need to actually show up in the formatted message.
The two examples below illustrate:
(in resource bundle)

// by not including {0} first parm is not printed in the message.
MSGOOO1=This message does not include the DPID.

// note - it is not recommended to print the DPID in your message.
MSGOOO2=This message includes the DPID...it's value is {0}.

It is recommended that messages not include the DPID in the formatted message. As shown above, this is
done by not including {0} in the message value in the resource bundle.

Using Diagnostic Providers from wsadmin scripts

In addition to enabling Diagnostic Providers (DP) from the administration console, you can also use them
through scripts from the Wsadmin tool. The procedure for doing so follows. For more detailed information
about the Wsadmin tool see the scripting tool chapter in the Administering applications and their
environment PDF book

1. List the MBeans that implement the Diagnostic Provider (DP) interface. Enter

$AdminControl queryNames diagnosticProvider=true,*

And you will see an output that displays all of the Diagnostic Providers in a format like this:

"WebSphere:name=Default Datasource,process=serverl,platform=dynamicproxy,node=
camelhair,JDBCProvider=Derby JDBC Provider,

diagnosticProvider=true,j2eeType=JDBCDataSource,J2EEServer=serverl,Server=serverl,
version=6.1.0.0,type=DataSource,

mbeanIdentifier=cells/camelhairCell/nodes/camelhair/servers/serverl/resources.xml#
DataSource_ 1131113688564,

JDBCResource=Derby JDBC Provider,cell=camelhairCell"

"WebSphere:name=DefaultEJBTimerDataSource,process=serverl,platform=dynamicproxy,
node=camelhair,

JDBCProvider=Derby JDBC Provider (XA),diagnosticProvider=true,j2eeType=
JDBCDataSource,J2EEServer=serverl,Server=serverl,version=6.1.0.0,type=DataSource,
mbeanIdentifier=cells/camelhairCell/nodes/camelhair/servers/serverl/
resources.xml#DataSource_1000001,

JDBCResource=Derby JDBC Provider (XA),cell=camelhairCell"

WebSphere:name=WebcontainerDiagnosticProvider,process=serverl,platform=
dynamicproxy,node=camelhair,diagnosticProvider=true,

version=6.1.0.0,type=WebcontainerEventProvider,mbeanIdentifier=null,
cell=camelhairCell

2. Capture the ObjectName of your Diagnostic Provider in a variable. This enables you to reference your
Diagnostic Provider more easily, especially in a script. For example, instead of typing all of those lines,
if you want to work with the WebContainer Diagnostic Provider, for example, you can do the following:

» set DP [lindex [$AdminControl queryNames
name=WebcontainerDiagnosticProvider,diagnosticProvider=true,*] 0]

This ObjectName stored in the DP variable can be used on the methods, or you can use the
Diagnostic Provider name as text or a variable.

* Now that you have the ObjectName in a variable, you can get the Diagnostic Provider name in a
variable with the command:

set DPNm [$AdminControl invoke $DS getDiagnosticProviderNameById $DP]
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This provides the result:
WebContainerDP
Now the DiagnosticProvider (WebContainer) is addressable by its objectname in variable DP, or by

its DiagnosticProvider name in variable DPNm. If you would prefer, you can hard-code the DPName
WebContainerDP as it is short enough.

3. Save the ObjectName of the DiagnosticService MBean to a variable. For wsadmin, WebSphere
Application Server provides this MBean so that the output of the Diagnostic Provider is more easily
consumable. Enter
set DS [Tindex [$AdminControl queryNames name=DiagnosticService,*] 0]

4. Run a configDump. You can run a configDump and capture all attributes with the command:
$AdminControl invoke $DS configDumpFormattedById [list $DP .x true null]

This lists the values that the Diagnostic Provider used at start up (and possible current values). An
excerpt of the configDump output follows.

Item Concatenated Name Value

customProperties = Null

defaultVirtualHostName = default_host

jvmProps = Null

localeProps = Null

servletCachingEnabled = false

aliases = *:9080;*:80;*:9443;

5. Filter the output of your configDump. You can use configDumpFormatted (leaving off the Byld) and
switch $DP for $DPNm or the string WebContainerDP. This example uses $DPNm on this slightly
modified version whereby it only picks up attributes dealing with automation:
$AdminControl invoke $DS configDumpFormatted [Tist $DPNm .*auto.* true null]

This results in just those attributes that contain auto in them. Full (but strict) regular expression syntax
is allowed:

Item Concatenated Name Value

autoLoadFiltersEnabled = false

autoRequestEncoding = false

autoResponseEncoding = false

autoLoadFiltersEnabled = false

autoRequestEncoding = false

autoResponseEncoding = false

The syntax is the same for stateDumps and selfDiagnostics

Viewing the run time configuration of a component using Diagnostic
Providers
You must have sufficient authority to run the action.

You can use the panel associated with this task to navigate to the configuration data that can be used to
check the health of a server runtime component. Runtime components that have associated diagnostic
configuration data can include their Diagnostic Provider ID (DPID) in their log entries. If you know the
DPID, you can enter it directly in the quick link text box. Otherwise, navigate to the desired process by
using the tree view displayed at the bottom of the panel, as shown in the steps below.

1.

Start the administration console.
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From the task bar on the left side of the console, select Troubleshooting.
From the task bar on the left side of the console, select Diagnostic Provider.
From the task bar on the left side of the console, select Configuration data.

Either directly enter a Diagnostic Provider ID in the Quick link using diagnostic provider ID text box,
or select a process (cluster / node / server) from the available processes displayed at the bottom of the
panel under the section title Server selection topology.

6. From the list of available diagnostic providers for the selected process, choose the desired diagnostic
provider name. The configuration data for that diagnostic provider appears.

oo

Configuration data quick link or server selection
Use this panel to select a Diagnostic Provider server for viewing run time configuration data.

To view this administrative console page, click Troubleshooting > Diagnostic Provider > Configuration
data

Quick link using Diagnostic Provider ID: From the Configuration data panel, enter a Diagnostic
Provider ID to go directly to the page for the configuration data for the Diagnostic Provider for the specific
server.

Server selection topology:
Use these folders to select server or cluster for viewing the configuration data for a Diagnostic Provider.
If you choose a cluster, whatever action you choose is performed on each server in the cluster.

The enterprise applications section shows you the servers that a particular application is running on. If you
select a server from this list, the action is performed on that server, not specifically that application.

Diagnostic Providers (selection)
Use this panel to select a Diagnostic Provider from the selected server or cluster.

The list will contain only Diagnostic Providers registered on the selected server or cluster. Not all
Diagnostic Providers register with every server in the cell.

You can follow several navigation paths to view this administrative console page. For example, click
Troubleshooting > Diagnostic Provider > Tests > select a server or cluster name.

Name:
Choose a diagnostic provider from this list.

The path you chose to get to this panel determines which panel displays next.

 |If you chose Troubleshooting > Diagnostic Provider > Tests, you see a panel that lists all of the
available tests to run on the Diagnostic Provider.

» If you chose Troubleshooting > Diagnostic Provider > State data, you see a panel that shows the
collected state data for the Diagnostic Provider.

 If you chose Troubleshooting > Diagnostic Provider > Configuration data, you see a panel that shows
the configuration data for the Diagnostic Provider.

Configuration data

Use this panel to view the current configuration data for a Diagnostic Provider on a selected server or
cluster. Not necessarily every piece of configuration data appears, but data that can be helpful in problem
determination is shown.
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You can follow several navigation paths to view this administrative console page. For example, click
Troubleshooting > Diagnostic Provider > Configuration data > select a server or cluster name > select
a Diagnostic Provider from the list.

The attributes show information that has been configured for the Diagnostic Provider. You can use the
Save button to save the information to a file.

Note: Results from a configuration dump contain names that start with either startup or current. The
startup entries represent data that was read in by the component at server startup time. The current
entries contain data that is current — meaning the value of the attributes in use by the runtime at the
time the configuration dump was requested.

Node:

This is the node name from where the configuration data was collected.
Server:

This is the server name from where the configuration data was collected.

Name:

This is the name of the attribute for the configuration data.
Value:

This is the value of the configuration data.

Description:

This is a description of the configuration data.

Viewing the run time state data or configuring the state data collection
specifications for a Diagnostic Provider
You must have sufficient authority to execute the action.

You can use the panel associated with this task in two ways. You can navigate to the state data that can
be used to check the health of a server runtime component, or you can configure the state data to be
collected for a server. In the server selection topology section, use the view state data radio button to go
to the list of registered diagnostic providers. Use the change state data collection specification radio button
to modify the state collection specification for the runtime components for a server. Runtime components
that have associated diagnostic state data can include their Diagnostic Provider ID (DPID) in their log
entries. If you know the DPID, you can enter it directly in the quick link text box.

1. Start the administration console.
Select Troubleshooting.

Select Diagnostic Provider.
Select State data.

Select the View state data radio button to simply look at the state data, or select the Change state
data collection specification radio button to change the configuration.

6. Either directly enter a Diagnostic Provider ID in the Quick link using diagnostic provider ID text box,
or select a process (cluster / node / server) from the available processes displayed at the bottom of the
panel.

* If you chose the View state data radio button, a panel listing the available Diagnostic Providers
appears. Choose one of the providers by clicking on it. A panel displaying the state data appears.

ok 0N
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» If you chose the Change state data collection specification radio button, a panel appears that
contains a list of the available Diagnostic Providers and a text entry block. The state collection
specification for the selected process is managed from this panel. Select one of the available
providers by using the checkbox next to it.

Diagnostic Provider State Collection Specification

In normal operation, most components should work optimally and not store any operational data that is not
needed. There are times, however, when an administrator or automated tool may want a component to
collect more information than normal to help in problem determination. This data could then be exposed
through a State dump. The State Collection specification was created as a syntax for indicating what
additional data the diagnostic providers in the system should retain.

For the syntax of the aCollectionSpec string, refer to the DiagnosticConfigHome AP| documentation. It is
basically a semicolon (;) separated list of collection specification clauses which are of the form:

<DiagnosticProviderName regexp>:<Attributeld regexp>=[0]1]

Where the DiagnosticProviderName regular expression will make this clause apply to any Diagnostic
Provider Name that matches that regular expression. The Attributeld regexp and the boolean value (0 for
off, and 1 for on) are stored in the DiagnosticConfig object that each Diagnostic Provider uses. Turning on
or off, and processing the clauses left to right allows relatively complex specification. Any specification that
is not explicitly turned on is considered to be off. This format is explained further in the following
examples.

To turn on tracing for all attributes in the MyDP Diagnostic Provider:
MyDP: .*=1

To turn on tracing for all attributes of all Diagnostic Providers (this will probably impact system
performance):

xoox=]

To turn on all tracing for all attributes of all Diagnostic Providers beginning with ConnMgr (for example,
Data Sources):

ConnMgr.*:.*=1

This specification turns on special collection attributes in the MyDP Diagnostic Provider that begin with the
string PoolInfo. If, however, the attribute begins with Poolinfo.Db2Pool, then the collection is off (because
it is read left to right).

MyDP:PoolInfo.*=1;MyDP:PoolInfo.Db2Pool.*=0

It should be noted that State dumps can return important information even in the case where there is no
State Collection Specification turned on for a Diagnostic Provider. Diagnostic Providers frequently have to
keep some state information in order to operate. Anything in this category is available in a State dump
even if there is no special data collection going on. Using the State Collection Specification may increase
the amount of data available.

State Data Quick Link or Server Selection

Use this panel to select a server or cluster to either view collected state data, or to configure state data to
collect for a Diagnostic Provider.

To view this administrative console page, click Troubleshooting > Diagnostic Provider > State data

Quick link using Diagnostic Provider ID:

Enter a Diagnostic Provider ID to go directly to the view page for the collected state data for the
Diagnostic Provider.
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Server selection topology:

Use these radio buttons and folders to select a specific server or cluster for viewing of state data or
configuring the specification of state data.

If you choose a cluster, whatever action you choose is performed on each server in the cluster.

The enterprise applications section shows you the servers that a particular application is running on. If you
select a server from this list, the action is performed on that server, not specifically that application.

View state data
Select this radio button to view the state data for a Diagnostic Provider. Then select the cell or
cluster you want to work with.

Change state data collection settings
Select this radio button to configure the state collection specification for a Diagnostic Provider.
Then select the cluster or managed server you want to work with.

State data
Use this panel to view the current state data for a Diagnostic Provider on a selected server or cluster.

To view this administrative console page, click Troubleshooting > Diagnostic Provider > State data >
select the View state data radio button and then select a server or cluster name > select a Diagnostic
Provider from the list.

The attributes show information that has been collected as part of the enabled state collection specification
for the Diagnostic Provider. You can use the save... button to save the information to a file

Node:

This is the node name from where the state data was collected.

Server:

This is the server name from where the state data was collected.

Name:

This is the name of the state collection specification used to collect the state data.
Value:

This is the value of the state collection specification used to collect the state data.
Description:

This is a description of the state collection specification used to collect the state data.

Detailed state specification
Use this panel to view the attributes and descriptions of the Diagnostic Provider that you have selected.

To add attributes, select the checkbox next to your chosen diagnostic provider, then select the Add to
specification button.

To remove a diagnostic provider's sub-component attribute from the state specification, select the
sub-component attribute in the displayed list and then select the Remove from specification button.
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When you are done adding or removing a diagnostic provider's sub-component attributes, select the Done
button.

To view this administrative console page, click Troubleshooting > Diagnostic Provider > State data
>select the View state data radio button and then select a server or cluster name > select a Diagnostic
Provider from the list.

Attribute:
This is the individual state collection specification available for the Diagnostic Provider.
Description:

This is the description of the individual state collection specification item.

Change state specification
Use this panel to add a Diagnostic Provider and its attributes to the specification for collecting state data.

To add a diagnostic provider (DP) and all of its attributes, select the checkbox next to your chosen DP,
then click on the Add to specification button. To add only some of the DP’s attributes, click on the DP
name itself in the list, and a new panel where you can perform this task appears.

To put the state specification into affect, select the Apply or OK button.
To reset the specification to its original state, use the Reset button.

To manually enter a state specification, update the text area with the state specification and use the
Update button.

To view this administrative console page, click Troubleshooting > Diagnostic Provider > State data >
select the Change state data collection specification radio button and then select a server or cluster name
> select a Diagnostic Provider from the list.

Name:

This is a list of available Diagnostic Providers for the server selected.

Modifying the State Collection Specification from wsadmin scripts

In doing problem determination, you might want to begin collecting additional data during normal
processing. This can be accomplished by modifying the State Collection Specification dynamically. This
section illustrates how to do that through the Wsadmin tool. This technique can be used to turn on traces,
as well as to turn off traces. Depending on the usage pattern of the component, the impact should take
affect shortly after it is set. For more information on this tool, see the chapter, Wsadmin tool in the
Administering applications and their environment PDF book.

1. Capture the DiagnosticService ObjectName into a variable. Enter
set DS [Tindex [$AdminControl queryNames name=DiagnosticService,*] 0]
2. Use this variable to drive the method to set the specification. Enter

$AdminControl invoke $DS setStateCollectionSpec "SampleDiagnosticProvider:player.*=1;
SampleDiagnosticProvider:defense.*=1"

The specification is of the form DiagnosticProviderName:Attributeld=0I1... (with a semicolon at the

end, multiple sub-specifications can be entered similar to the TraceSpec). The
DiagnosticProviderName and Attributeld can be proper regular expressions.

152  Troubleshooting and support



Running a self diagnostic on a Diagnostic Provider
You must have sufficient authority to execute the action.

You can access a list of predefined diagnostic tests that you can use to check the status of a server
runtime component. Runtime components that have associated diagnostic tests can include their
Diagnostic Provide ID (DPID) in their log entries. If you know the DPID, you can enter it directly in the
quick link text box. Otherwise, navigate to the desired process by using the tree view displayed at the
bottom of the panel.

1. Start the administration console.
Select Troubleshooting.

Select Diagnostic Provider.
Select Tests .

Either directly enter a Diagnostic Provider ID in the Quick link using diagnostic provider ID text box,
or select a process (cluster / node / server) from the available processes displayed in the Server
selection topology section.

6. Select the desired self diagnostic test.
7. Read the output messages from the self diagnostic test.

8. Select a self diagnostic test message by clicking on it. The console displays a panel with the attributes
related to the message you chose.

ok 0N

Tests Quick Link or Server Selection
Use this panel to select a Diagnostic Provider server for diagnostic tests.

To view this administrative console page, click Troubleshooting > Diagnostic Provider > Tests.
Quick link using Diagnostic Provider ID:

Enter a Diagnostic Provider ID to go directly to the view page for the collected state data for the
Diagnostic Provider.

Server selection topology:
Use these folders to select server or cluster for viewing the available tests for a Diagnostic Provider.
If you choose a cluster, whatever action you choose is performed on each server in the cluster.

The enterprise applications section shows you the servers that a particular application is running on. If you
select a server from this list, the action is performed on that server, not specifically that application.

Test selection
Use this panel to select one of the tests that are available for the chosen Diagnostic Provider on the
chosen server or cluster.

You can follow several navigation paths to view this administrative console page. For example, click
Troubleshooting > Diagnostic Provider > Tests > select a server or cluster name > select a Diagnostic
Provider from the list.

Test identification:

Choosing a test ID causes the test to run. Results of the test are shown on the Test Results panel.

Test description:

A description of the test available to run on the Diagnostic Provider.
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Test Results
Use this panel to see the results from the server or cluster members for the selected test.

You can follow several navigation paths to view this administrative console page. For example, click
Troubleshooting > Diagnostic Provider > Tests > select a cluster name > select a Diagnostic Provider
from the list > select a Test identification from the list.

Multiple results can be returned from a test from each server. The results are sorted by Node, then by
Server, then by Severity. You can page through the messages that are returned.

Server:

The name of the server where the test result came back from.
Node:

The name of the node where the test result came back from.
Severity:

The severity of the result from the test run.

Message:

A description of the test result.

The entries in this column are linked to another panel. If you click on a message, you can see additional
attributes associated with the message.

Test result details
Use this panel to see additional attributes for the selected test result.

To view this administrative console page, click Troubleshooting > Diagnostic Provider > Tests > select
a cluster name > select a Diagnostic Provider from the list > select a Test identification from the list >
select a message.

The attributes show information that helped to diagnose the condition described in the message. You can
use the Save button to save to a file the attributes and the messages to which they correspond.

Name:

The name of the test.

Value:

This is the value of the test result.
Description:

This is a description of the test.
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Chapter 7. Web applications

Web module or application server stops processing requests

Use this information to help determine why a Web module or application server has stopped processing
new requests.

If an application server’s process spontaneously closes, or its Web modules stop responding to new

requests:

* Isolate the problem by installing Web modules on different servers, if possible.

*  You can use the Tivoli performance viewer to determine which resources have reached their maximum
capacity, such as Java heap memory (indicating a possible memory leak) and database connections. If
a particular resource appears to have reached its maximum capacity, review the application code for a
possible cause:

If database connections are used and never freed, ensure that application code performs a close()
on any opened Connection object within a finally{} block.

If there is a steady increase in servlet engine threads in use, review application synchronized code
blocks for possible deadlock conditions.

If there is a steady increase in a JVM heap size, review application code for memory leak
opportunities, such as static (class-level) collections, that can cause objects to never get
garbage-collected.

See the Tuning guide PDF for more information about this tool.

* As an alternative to using the performance viewer to detect memory leak problems, enable verbose
garbage collection on the application server. This feature adds detailed statements to the JVM error log
file of the application server about the amount of available and in-use memory. To set up verbose
garbage collection:

1.

2.
3.

Select Servers > Application Servers > server_name >Java and Process Management >
Process Definition > Java Virtual Machine, and enable Verbose Garbage Collection.

Stop and restart the application server.

Periodically, or after the application server stops, browse the log file for garbage collection
statements. Look for statements beginning with "allocation failure”. The string indicates that a need
for memory allocation has triggered a JVM garbage collection (freeing of unused memory).
Allocation failures themselves are normal and not necessarily indicative of a problem. The allocation
failure statement is followed by statements showing how many bytes are needed and how many are
allocated.

If there is a steady increase in the total amount of free and used memory (the JVM keeps allocating
more memory for itself), or if the JVM becomes unable to allocate as much memory as it needs
(indicated by the bytes needed statement), there might be a memory leak.

» Force an application to create a thread dump (or javacore). Here is the process for forcing a thread
dump, which is different from the process in earlier releases of the product:

1.

2.

3.

Using the wsadmin command prompt, get a handle to the problem application server:

wsadmin>set jvm [§AdminControl completeObjectName type=JVM,process=serverl,=*]
Generate the thread dump:

wsadmin>$AdminControl invoke $jvm dumpThreads

Look for an outpuit file in the [profile_rooflogs directory with a name like
javacore.jobnum.jobuser.jobname.timestamp.ixt.

* Browse the thread dump for clues:

The thread dump shows information on the current Java heap size, and the minimum and maximum
heap size settings. Look for an excessive current heap size.

The thread dump contains a snapshot of each thread in the process, starting in the section labeled
"Thread Information.”

- Look for threads that are waiting on locks held by other threads.
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- Look for multiple threads in the same Java application code source location. Multiple threads from
the same location might indicate a deadlock condition (multiple threads waiting on a monitor) or an
infinite loop, and help identify the application code with the problem.

It is normal for certain components in the WebSphere Application Server runtime to have certain

types of threads in the same Java code source location. These components include the Web
container, the EJB container and the ORB thread pool.

IBM Support has documents and tools that can save you time gathering information needed to resolve
problems as described in ['Troubleshooting help from IBM” on page 126.|Before opening a problem report,
see the Support page:

http://www.ibm.com/servers/eserver/support/iseries/software/v5r3/index.htmI|

Errors starting an application

Use this information for troubleshooting problems that occur when starting an application.

What kind of error do you see when you start an application?

« [‘HTTP server and Application Server are working separately, but requests are not passing from HTTP|
server to Application Server]

+ [“File serving problems” on page 157

+ [“Graphics do not appear in the JSP file or servlet output” on page 157|

+ [“SRVEO0026E: [Servlet Error]-[Unable to compile class for JSP file” on page 158

+ [“After modifying and saving a JSP file, the change does not show up in the browser (the old JSP file]
displays)” on page 159|

+ [‘Message like "Message: /jspname.jsp(9,0) Include: Mandatory attribute page missing” appears when|
attempting to browse JSP file” on page 159

+ [“The Java source generated from a JSP file is not retained in the temp directory (only the class file is|
found)” on page 159

+ [The JSP Batch Compiler fails with the message "Enterprise Application [application name you typed in]
not found.”” on page 159

+ [“There is a translation problem with non-English browser input’ on page 160|

+ [“Scroll bars do not appear around items in the browser window” on page 160

* [“Error "Page cannot be displayed... server not found or DNS error” appears when attempting to browse
a JavaServer Pages (JSP) file using Internet Explorer’ on page 160

HTTP server and Application Server are working separately, but requests are not
passing from HTTP server to Application Server

If your HTTP server appears to be functioning correctly, and the Application Server also works on its own,
but browser requests sent to the HTTP server for pages are not being served, a problem exists in the
WebSphere Application Server plug-in.

In this case:

1. Determine whether the HTTP server is attempting to serve the requested resource itself, rather than
forwarding it to the WebSphere Application Server.
a. Browse the HTTP server access log (IHS install root/logs/access.log for IBM HTTP Server). It
might indicate that it could not find the file in its own document root directory.
b. Browse the plug-in log file as described below.

2. Browse the plugin_install_root/10gs/web_server_name/http_plugin.log file for clues to the problem.
Make sure the timestamps with the most recent plug-in information stanza, which is printed out when
the plug-in is loaded, correspond to the time the Web server started.

3. Turn on plug-in tracing by setting the LogLevel attribute in the pTugin-cfg.xml file to Trace and
reloading the request. Browse the plugin_install_root/10gs/Web_server_name/http_plugin.log file.
You should be able to see the plug-in attempting to match the request URI with the various URI
definitions for the routes in the plugin-cfg.xml. Check which rules the plug-in is not matching against
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and then figure out if you need to add additional ones. If you just recently installed the application you
might need to manually regenerate the plug-in configuration to pick up the new URIs related to the
new application.

For further details on troubleshooting plug-in-related problems, see Webserver plug-in troubleshooting tips
located in the Administering applications and their environment PDF book.

File serving problems

If text output appears on your JSP- or servlet-supported Web page, but image files do not:
» Verify that your files are in the right place: the document root directory of your Web application

WebSphere Application Server follows the J2EE standard, which means that the document root is the
Web_module_name.war directory of your deployed Web application.

Typically this directory will be found in the profile_root/installedApps/nodename/appname.ear directory or
profile_root/installedApps/nodename/appnameNetwork.ear directory.

If the files are in a subdirectory of the document root, verify that the reference to the file reflects that.

That is, if the invoices.html file is stored in Windows directory Web_module_name.war\invoices, then

links from other pages in the Web application to display it should read "invoices\invoices.htm1”, not
"invoices.html”.

Verify that your Web application is configured to enable file serving (in other words, that it is enabled to

display static resources like image and .html files):

1. View the file serving property of the hosting Web module by browsing the source .war file in an
assembly tool. If necessary, update the property and redeploy the module. For more information
about the assembly tool, refer to the assembly tools section of the Developing and deploying
applications PDF book.

2. Edit the fileServingEnabled property in the deployed Web application ibm-web-ext.xmi
configuration file.

The file typically is found in the profile root|//config/cells/nodename or nodenameNetwork/
applications/application_name/deployments/application name/Web_module name/web-inf
directory.

Graphics do not appear in the JSP file or serviet output

If text output appears on your JSP- or -servlet-supported Web page, but image files do not:

Verify that your graphic files are in the right place: the document root directory of your Web
application. WebSphere Application Server Version 5 follows the J2EE standard, which means that the
document root is the Web_module_name.war directory of your deployed Web application.

Typically, this directory is found in the [profile_roo}installedApps/nodenamelappname.ear directory or
installedApps/nodenamel appnameNetwork.ear directory.

If the graphics files are in a subdirectory of the document root, verify that the reference to the graphic
reflects that; for example, if the banner.gif file is stored in Windows directory Web_module_name.war/
images, the tag to display it should read: <img SRC="images/banner.gif">, not <img SRC="banner.gif">.
Verify that your Web application is configured to enable file serving (that is, display of static resources
like image and .html files).

1. View the file serving property of the hosting Web module by browsing the source .war file in an
assembly tool. If necessary, update the property and redeploy the module. For more information
about the assembily tool, refer to the assembly tools section of the Developing and deploying
applications PDF book.

2. Edit the fileServingEnabled property in the deployed Web application ibm-web-ext.xmi
configuration file.

The file typically is found in the /config/ce] 1s/nodename or nodenameNetwork/
applications/application_name/deployments/application name/Web_module_name/web-inf
directory.
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3. After completing the previous step:
— In the administrative console, expand the Environment tree control .
— Click Update WebSphere Plugin.
— Stop and restart the HTTP server and retry the Web request.

SRVEO0026E: [Serviet Error]-[Unable to compile class for JSP file

If this error appears in a browser when trying to access a new or modified .jsp file for the first time, the
most likely cause is that the JSP file Java source failed (was incorrect) during the javac compilation phase.

Check the [SystemEtr.log file| for a compiler error message, such as:

C:\WASROOT\temp\ ... test.war\_myJsp.java:14: \Duplicate variable declaration: int myInt was int myInt
int myInt = 122;

String myString = "number is 122";

static int myStaticInt=22;

int myInt=121;

Fix the problem in the JSP source file, save the source and request the JSP file again.

If this error occurs when trying to serve a JSP file that was copied from another system where it ran
successfully, then there is something different about the new server environment that prevents the JSP file
from running. Browse the text of the error for a statement like:

Undefined variable or class name: MyClass

This error indicates that a supporting class or jar file is not copied to the target server, or is not on the
class path. Find the MyClass.class file, and place it on the Web module WEB-INF/classes directory, or
place its containing .jar file in the Web module WEB-INF/lib directory.

Verify that the URL used to access the resource is correct by doing the following:

» For a JSP file, html file, or image file: http://host_name/Web_module_context_root/subdir under doc
root, if any/filename.ext. The document root for a Web application is the application_name .WAR
directory of the installed application.

— For example, to access the mydsp.jsp file, located in c:\\WebSphere\ApplicationServeninstalledApps\
myEntApp.ear\myWebApp.waninvoices on myhost.mydomain.com, and assuming the context root for
the myWebApp Web module is myApp, the URL is http://myhost.mydomain.com/myApp/invoices/
myJsp.Jjsp.

— JSP serving is enabled by default. File serving for HTML and image files must be enabled as a
property of the Web module, in an assembly tool, or by setting the fileServingEnabled property to
true in the ibm-web-ext.xmi file of the installed Web application and restarting the application. For
more information about the assembly tool, refer to the assembly tools section of the Developing and
deploying applications PDF book.

» For servlets served by class name, the URL is http://hostname/Web_module _context_root/servlet/
packageName. className.

For example, to access myCom.myServlet.class, located in profile_root/installedApps/myEntApp.ear/
myWebApp.war/WEB-INF/classes, and assuming the context root for the myWebApp module is
"myApp”, the URL would be http://myhost.mydomain.com/myApp/serviet/myCom.MyServiet.

» Serving servlets by class name must be enabled as a property of the Web module, and is enabled by
default. File serving for HTML and image files must be enabled as a property of the Web application, in
an assembly tool, or by setting the fileServingEnabled property to true in the ibm-web-ext.xmi file of
the installed Web application and restarting the application. For more information about the assembly
tool, refer to the assembly tools section of the Developing and deploying applications PDF book.

Correct the URL in the "from” HTML file, servlet or JSP file. An HREF with no leading slash (/) inherits the
calling resource context. For example:
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e an HREF in http://[hostname] /myapp/serviet/MyServiet to "ServletB” resolves to
"http://hostname/myapp/serviet/ServietB”

e an HREF in http://[hostname] /myapp/serviet/MyServiet to "serviet/ServietB” resolves to
"http://hostname/myapp/serviet/serviet/ServietB” (an error)

e an HREF in http://[hostname] /myapp/serviet/MyServiet to "/ServietB” resolves to
"http://hostname/ServietB” (an error, if ServletB requires the same context root as MyServlet)

After modifying and saving a JSP file, the change does not show up in the
browser (the old JSP file displays)

It is probable that the Web application is not configured for servlet reloading, or the reload interval is too
high.

To correct this problem, in an assembly tool, check the Reloading Enabled flag and the Reload Interval
value in the IBM Extensions for the Web module in question. Enable reloading, or if it is already enabled,
then set the Reload Interval lower. For more information about the assembly tool, refer to the assembly
tools section of the Developing and deploying applications PDF book.

Message like "Message: /jspname.jsp(9,0) Include: Mandatory attribute page
missing” appears when attempting to browse JSP file

It is probable that the JSP file failed during the translation to Java phase. Specifically, a JSP directive, in
this case an Include statement, was incorrect or referred to a file that could not be found.

To correct this problem, fix the problem in the JSP source, save the source and request the JSP file again.

The Java source generated from a JSP file is not retained in the temp directory
(only the class file is found)

It is probable that the JSP processor is not configured to keep generated Java source.

In an assembly tool, check the JSP Attributes under Assembly Property Extensions for the Web
module in question. Make sure the keepgenerated attribute is there and is set to true. If not, set this
attribute and restart the Web application. To see the results of this operation, delete the class file from the
temp directory to force the JSP processor to translate the JSP source into Java source again. For more
information about the assembly tool, refer to the assembly tools section of the Developing and deploying
applications PDF book.

The JSP Batch Compiler fails with the message "Enterprise Application
[application name you typed in] not found.”

It is probable that the full enterprise application path and name, starting with the .ear subdirectory that
resides in the applications directory is expected as an argument to the JspBatchCompiler tool, not just
the display name.

The directory path is conﬁg/ce] 1s/node_nameNetwork/applications.

For example:

» "JspBatchCompiler -enterpriseapp.name sampleApp.ear/deployments/sampleApp” is correct, as
opposed to

» "JspBatchCompiler -enterpriseapp.name sampleApp”, which is incorrect.
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There is a translation problem with non-English browser input

If non-English-character-set browser input cannot be translated after being read by a servlet or JSP file,
ensure that the request parameters are encoded according to the expected character set before reading.
For example, if the site is Chinese, the target . jsp file should have a line:

req.setCharacterEncoding("gb2312");
before any req.getParameter method calls.

This problem affects servlets and jsp files ported from earlier versions of WebSphere Application Server,
which converted characters automatically based upon the locale of the WebSphere Application Server.

Scroll bars do not appear around items in the browser window

In some browsers, tree or list type items that extend beyond their allotted windows do not have scroll bars
to permit viewing of the entire list.

To correct this problem, right-click on the browser window and click Reload from the menu.

Error "Page cannot be displayed... server not found or DNS error” appears when
attempting to browse a JavaServer Pages (JSP) file using Internet Explorer

This error can occur when an HTTP timeout causes the servant to be brought down and restarted. To
correct this problem, increase the ConnectionlOTimeOut value:

1. From the administrative console, select System administration > Deployment manager >
Administration Services > Custom Properties

2. Select ConnectionlOTimeOut.
3. Increase the ConnectionlOTimeOut value.
4. Click OK.

A Web resource does not display

If you are not able to display a resource in your browser, follow these steps:

1. Verify that your HTTP server is healthy by accessing the URL http://server_name from a browser and
seeing whether the Welcome page appears. This action indicates whether the HTTP server is up and
running, regardless of the state of WebSphere Application Server.

2. If the HTTP server Welcome page does not appear, that is, if you get a browser message like page
cannot be displayed or something similar, try to |[diagnose your Web server problem|

3. If the HTTP server appears to function, the Application Server might not be serving the target resource.
Try laccessing the resource directly through the Application Server instead of through the HTTP server|

If you cannot access the resource directly through the Application Server, |Verify that the URL used to|
laccess the resource is correct.|

If the URL is incorrect and it is created as a link from another JSP file, servlet, or HTML file, try
correcting it in the browser URL field and reloading, to confirm that the problem is a malformed URL.
[Correct the URL in the "from” HTML file, servlet or JSP filg|

If the URL appears to be correct, but you cannot access the resource directly through the Application

Server, verify the health of the hosting Application Server and Web module:

a. View the hosting Application Server and Web module in the administrative console to verify that
they are up and running.

b. Copy a simple HTML or JSP file (such as Simpledsp.jsp in the WebSphere Application Server
directory structure) to your Web module document root, and try to access it. If successful, the
problem is with your resource.
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View the [JVM log] of your Application Server to find out why your resource cannot be found or
served .

4. If you can access the resource directly through the Application Server, but not through an HTTP server,
the problem lies with the -- the component that communicates between the HTTP server
and the WebSphere Application Server.

5. If the JSP file and the servlet output are served, but not static resources such as .html and image
files, see the steps for [enabling file serving

6. If some kinds of resources display correctly, but you cannot display a servlet by its class name:

» Verify that the servlet is in a directory in the Web module class path, such as in the
/Web_module_name.war/WEB-INF/classes directory.

» Verify that you specify the full class name of the servlet, including its package name, in the URL.

» Verify that "/servlet” precedes the class name in the URL. For example, if the root context of a
Web module is "myapp”, and the servlet is com.mycom.welcomeServlet, then the URL reads:

http://hostname/myapp/serviet/com.mycom.welcomeServiet

» Verify that serving the servlets by class name is enabled for the hosting Web module by opening the
source Web module in an assembly tool and browsing the serve serviets by classname setting in
the IBM Extensions property page. If necessary, enable this flag and redeploy the Web module. For
more information about the assembly tool, refer to the assembly tools section of the Developing and
deploying applications PDF book.

» For servlets or other resources served by mapped URLs, the URL is http://hostname/Web module
context root'mappedURL.

If none of these steps fixes your problem, see if the problem has been identified and documented by
looking atl|available online support (hints and tips, technotes, and fixes)l If you do not find your problem
listed there, see [Troubleshooting help from IBM” on page 126.|

Diagnosing Web server problems

If you are unable to view the welcome page of your HTTP server, determine if the server is operating
properly.

On Windows systems, look in the Services panel for the service corresponding to your HTTP server, and
verify that the state is Started. If not, start it. If the service does not start, try starting it manually from the
command prompt. If you are using IBM HTTP Server, the command is IHS install dir\apache .

On UNIX systems, execute the ps -ef | grep httpd command. There should be several processes running
with a name of "httpd”. If not, start your HTTP server manually. If you are using IBM HTTP Server, the
command is IHS install_dir/bin/apachect] start.

If the HTTP server does not start:

» Examine the HTTP server error log for clues.

» Try restoring the HTTP server to its configuration prior to installing WebSphere Application Server and
restarting it. If you are using IBM HTTP Server:
— Rename the file IHS_install_diAhttpd.conf.
— Copy the httpd.conf.default file to the httpd.conf directory.
— If Apache is running, stop and restart it.

* For the Sun ONE (iPlanet) Web server, restore the obj.conf configuration file for Sun ONE V4.1 and
both obj.conf and magnus.conf files for Sun ONE V6.0 and later.

» For the Microsoft Internet Information Server (IIS), remove the WebSphere Application Server plug-in
through the 1IS administrative GUI.

If restoring the HTTP server default configuration file works, manually review the configuration file that has
WebSphere Application Server updates to verify directory and file names for WebSphere Application
Server files. If you cannot manually correct the configuration, you can uninstall and reinstall WebSphere
Application Server to create a clean HTTP configuration file.
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If restoring the default configuration file does not help, contact technical support for the Web server you
are using. If you are using IBM HTTP Server with WebSphere Application Server, check [available online]
support (hints and tips, technotes, and fixes)| If you do not find your problem listed there, see
“Troubleshooting help from IBM” on page 126]

Accessing a Web resource through the application server and bypassing the HTTP
server

Starting with WebSphere Application Server Version 4.0, you can bypass the HTTP server and access a
Web resource through the application server. It is not recommended to serve a production Web site in this
way, but it provides a good diagnostic tool when it is not clear whether a problem resides in the HTTP
server, WebSphere Application Server, or the HTTP plug-in.

To access a Web resource through the Application Server:
1. Determine the port of the HTTP service in the target application server.

a. In the WebSphere administrative console, click Servers>Manage Application Servers.

b. Select the target server, then under Additional Properties click Web Container.

c. Under the Additional Properties of the Web container, click HTTP Transports. You see the ports
listed for virtual hosts served by the application server.

d. There can be more than one port listed. In the default application server (server1), for example,
9060 is the port reserved for administrative requests, 9443 and 9043 are used for SSL-encrypted
requests. To test the sample "snoop” servlet, for example, use the default application port 9080,
unless it changes.

2. Use the HTTP transport port number of the application server to access the resource from a browser.

For example, if the port is 9080, the URL is http://hostname:9080/myAppContext/myJSP.jsp.

3. If you are still unable to access the resource, verify that the HTTP transport port is in the "Host Alias”
list:

a. Click Application Servers > Your_ApplicationServer > Web Container > HTTP Transports to
check the Default virtual host and the HTTP transport ports used by this application server.

b. Click Environment > Manage Virtual Hosts > default host > Host Aliases to check if the HTTP
transport port exists. Add an entry if necessary. For example, if the HTTP port for your application
is server is 9080, add a host alias of *:9082.

JavaServer Pages troubleshooting tips

Use this tips to troubleshoot problems with JavaServer Pages.
JavaServer Pages source code shown by the Web server

If you share the document root of the WebSphere Application Server with the Web server document root,
a security exposure can result as the Web server might display the JavaServer Pages (JSP) source file as
plain text.

Problem

You can use the WebSphere Web server plug-in set of rules to determine whether a given request will be
handled by the WebSphere Application Server. When an incoming request fails to match those rules, the
Web server plug-in returns control to the Web server so that the Web server can fulfill the request. In this
case, the unknown host header causes the Web server plug-in to return control to the Web server
because the rules do not indicate that the WebSphere Application Server should handle it. Therefore, the
Web server looks for the request in the Web server document root. Since the JSP source file is stored in
the document root of the Web server, the Web server finds the file and displays it as plain text.

Suggested solution
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Move the WebSphere Application Server JSP source file outside of the Web server document root. Then,
when this request comes in with the unknown host header, the plug-in returns control to the Web server

and the JSP source file is not found in the document root. Therefore, the Web server returns a 404 File

Not Found error rather than the JSP source file.

Problems displaying double-byte character set (DBCS) characters when using the
@include directive

JavaServer Pages files that use the @include directive might experience problems when displaying
double-byte character set (DBCS) characters. Some applications that are migrated to WebSphere
Application Server Version 6.0 and above might need to be modified to comply with the JSP 2.0
specification as a result of backwards compatibility issues. The JSP 2.0 specification requires that each
statically included resource must set a page encoding or content type because the character encoding for
each file is determined separately, even if one file includes another using the include directive.

Problems using the JavaServer Pages (JSP) engine

If you are having difficulty using the JavaServer Pages (JSP) engine, try these steps:
1. Determine whether other resources such as .html files or servlets are being requested and displayed
correctly. If they are not, the problem probably lies at a deeper level, such as with the HTTP server.
2. If other resources are being displayed correctly, determine whether the JSP processor has started
normally:
* Browse the of the server hosting the JSP files you are trying to access. The following
messages indicate that the JSP processor has started normally:
Extension Processor [class com.ibm.ws.jsp.webcontainerext.JSPExtensionProcessor]
was initialized successfully.

Extension Processor [class com.ibm.ws.jsp.webcontainerext.JSPExtensionProcessor]
has been associated with patterns [*.jsp *.jspx *.jsw *.jsv ].

If the JSP processor fails to load, you will see a message such as

No Extension Processor found for handling JSPs.
JSP Processor not defined. Skipping : jspfilename.

in the root_dir/1ogs/server_name/SystemOut.1og file
3. If the JSP engine has started normally, the problem may be with the JSP file itself.
* The JSP may have invalid JSP syntax and could not be processed by the JSP Processor. Examine
the root_dir/logs/server_name/SystemOut.1og file of the target application for invalid JSP directive
syntax messages. Errors similar to the following in a browser indicate this kind of problem:

Message: /filename.jsp(2,1)JSPGOO76E: Missing required attribute page for jsp
element jsp:include

This example indicates that line 2, column 1 of the named JavaServer Pages file is missing a
mandatory attribute for the jsp:include action. Similar messages are displayed for other syntax
errors.

» Examine the target application server’s SystemErr.1og files for problems with invalid Java syntax.
Errors similar to Message: Unable to compile class for JSP in a browser indicate this kind of
problem.

The error message output from the Javac compiler will be found in the SystemErr.Tog. It might look
like:
JSPGOO91E: An error occurred at Tine: 2 in the file: /myJdsp.jsp
JSPGOO93E: Generated servlet error: c:\WASROOT\temp\ ...
test.war\_myJsp.java:16: myInt is already defined in com.ibm.ws.jsp20. myJsp
int myInt = 122; String myString = "number is 122"; static int myStaticInt=22;
int myInt=121;
~ 1 error

Correct the error in the JSP file and retry the file.
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« Examine the target application server’s server log files files for problems with invalid Java syntax.
Errors similar to Message: Unable to compile class for JSP in a browser indicate this kind of
problem.

The error message output from the Javac compiler will be found in the SystemErr.log. It might look
like:
JSPGOO91E: An error occurred at Tine: 2 in the file: /mydsp.jsp
JSPGOO93E: Generated servlet error: c:\WASROOT\temp\ ...
test.war\_myJsp.java:16: myInt is already defined in com.ibm.ws.jsp20._myJsp
int myInt = 122; String myString = "number is 122"; static int myStaticInt=22;
int myInt=121;
~ 1 error

Correct the error in the JSP file and retry the file.

JavaServer Pages fail to compile when using precompile

Symptom JavaServer Pages fail to compile during deployment through the administrative console
when precompile is selected.

SystemErr R com.ibm.websphere.management.exception.AdminException:
ADMAQGO21E: Error in compiling jsps - xyz.war (rc=1)

Problem JavaServer Pages fail to compile during deployment through the administrative console
when precompile is selected when there is a dependency on another Java archive
(JAR) file that is not available on any class path.

Suggested solution You may use wsadmin scripting to precompile JSP files during enterprise application
deployment. However if you want to use the administrative console, then compile all
JSP files before packaging the application.

1. Add the dependent JAR to the deployment manager in a cell environment.

a. Click System Administration > Deployment manager > Java and Process
Management > Process Definition > Java Virtual Machine in the console
navigation.

b. Add fully qualified dependent JAR in class path field.
c. Click OK.
d. Restart deployment manager.

2. Add the dependent JAR to the application server.

a. Click Servers > Application servers > server1 > Java and Process
Management > Process Definition > Java Virtual Machine in the console
navigation.

b. Add fully qualified dependent JAR in class path field.
c. Click OK.
Restart application server.

JSPGO0089E: Mismatch found between page directive encoding Shift_JIS and xml
prolog encoding UTF-8

Symptom The following error appears:
JSP Processing Error

HTTP Error Code: 500

Error Message: /test.jsp(2,1) /test.jsp(2,1) JSPGOO89E: Mismatch found between
page directive encoding Shift_JIS and xml prolog encoding UTF-8

Problem The pageEncoding attribute in the jsp:directive.page element is not UTF-8.
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Suggested solution JavaServer Pages must specify a prolog that matches the encoding specified in the
page directive. For example,
<?xml version="1.0" encoding="Shift_JIS"?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.0">
<jsp:directive.page language="java" contentType="text/html";
charset=Shift_JIS" pageEncoding="Shift JIS"/>
<jsp:text>XXXXXjsp:text>XXXXX>
</jsp:root>

For additional information, see section JSP.4.1, Page Character Encoding, in the
JavaServer Pages specification and section 4.3.3 and appendix F.1 of the Extensible
Markup Language (XML) specification

If none of these steps solves the problem, check to see if the problem is identified and documented using
the links in|Diagnosing and fixing problems: Resources for Iearningl If you do not see a problem that
resembles yours, or if the information provided does not solve your problem, |contact IBM supportl for
further assistance.

For current information available from IBM Support on known problems and their resolution, see the
page. The IBM Support page contains documents that can save you time gathering information
needed to resolve this problem.

Web container troubleshooting tips

If you are having problems starting a Web module, or accessing resources within a particular Web module:
+ View the[JVM logs| and [process logs|for the application server which hosts the problem Web modules,
and look for messages in the JVM output file which indicate that the web module has started
successfully. You should see messages similar to the following:
WebContainer A SRVEO161I: IBM WebSphere Application Server - Web Container.
Copyright IBM Corp. 1998-2002

WebContainer A SRVEQ169I: Loading Web Module: [module_name]
ApplicationMg A WSVRO221I: Application started: [application_name]

HttpTransport A SRVEQ171I: Transport http is Tistening on port [port_number]
[server_name] open for e-business in /1ogs/[ser‘ver‘_name] /SystemOut.Tlog

» For specific problems that can cause servlets, HTML files, and JavaServer Pages (JSP) files not to be
served, see |Web resource (JSP file, servlet, HTML file, image) does not display.

+ For a detailed trace of the run-time behavior of the Web container, |enable trace| for the component
com.ibm.ws.webcontainer using com.ibm.ws.webcontainer.*=all:com.ibm.ws.wswebcontainer.*=all.

If application server related calls fail during Servlet.init method, you can either:

* Initialize the servlet manually by making a single request to that servlet in your browser when the server
is ready for e-business instead of starting the servlet upon startup or

* You can choose not to make application server related calls in the servlet’s init method.

If the property to start servlets during application server startup is enabled, part of its startup process calls
the Servlet.init method on its servlets when you start the Web container. Therefore, when the Web
container is starts and calls the init method, other components such as Naming and Work Load
Management may not be fully started yet. As a result, application server related calls may not work since
all of the application server components may not be ready yet. Once the application server is 'ready for
e-business’, it is completely ready.

If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the|avai|ab|e online support (hints and tips, tech notes, and fixes)|. If you don’t find your
problem listed there [contact IBM support}

Chapter 7. Web applicatons 165


http://www.ibm.com/support/search.wss?rs=180&tc=SSEQTP&tc1=SSCC2GL
http://www.ibm.com/support/search.wss?rs=180&tc=SSEQTP&tc1=SSCC2GL

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.

Before opening a PMR, see the [IBM Supporf page.

Troubleshooting tips for Web application deployment

Deployment of a Web application is successful if you can access the application by typing a Uniform
Resource Locator (URL) in a browser, or if you can access the application by following a link.

If you cannot access your application, follow these steps to eliminate some common errors that can occur
during migration or deployment.

Web module does not run in WebSphere Application Server Version 5.x or 6.x

Symptom Your Web module does not run when you migrate it to Version 5.x or 6.x

Problem In Version 4.x, the classpath setting that affected visibility was Module Visibility Mode.
In Versions 5.x and 6.x, you must use class loader policies to set visibility.

Recommended response Reassemble an existing module, or change the visibility settings in the class loader
policies.

See|Class loaders|and [Class loading| for more information.

Welcome page is not visible.

Symptom You cannot access an application with a Web path of:
/webapp/myapp
Problem The default welcome page for a Web application is assumed to be index.html. You

cannot access the default page of the myapp application unless it is named index.htmi.

Recommended response To identify a different welcome page, modify the properties of the Web module during
assembly, see the topic, Assembling Web applications for more information in the
Developing and deploying applications PDF book.

HTML files are not found.

Symptom Your Web application ran successfully on prior versions, but now you encounter errors
that the welcome page (typically index.html), or referenced HTML files are not found:

Error 404: File not found: Banner.html
Error 404: File not found: HomeContent.html
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Problem For security and consistency reasons, Web application URLs are now case-sensitive on
all operating systems.

Suppose the content of the index page is as follows:

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 5.0 Frameset//EN">

<HTML>

<TITLE>

Insurance Home Page

</TITLE>
<frameset rows="18,80">
<frame src="Banner.html" name="BannerFrame" SCROLLING=NO>
<frame src="HomeContent.html" name="HomeContentFrame">
</frameset>

</HTML>

However the actual file names in the \WebSphere\AppServer\installedApps\...
directory where the application is deployed are:
banner.html
homecontent.html

Recommended response To correct this problem, modify the index.html file to change the names Banner.html|
and HomeContent.html to banner.html and homecontent.html to match the names of
the files in the deployed application.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Support] page.

HTTP session manager troubleshooting tips

This article provides troubleshooting tips for problems creating or using HTTP sessions with your Web
application hosted by WebSphere Application Server.

Here are some steps to take:
- See HTTP session aren’t getting created or are getting dropped|to see if your specific problem is
discussed.
* View thveor the application server which hosts the problem application:
first, look at messages written while each application is starting. They will be written between the
foIIowmg two messages:

Starting application: application

Application started: application

— Within this block, look for any errors or exceptions containing a package name of
com.ibm.ws.webcontainer.httpsession. If none are found, this is an indication that the session
manager started successfully.

— Error "SRVEOO054E: An error occurred while loading session context and Web application”
indicates that SessionManager didn’t start properly for a given application.

— Look within the logs for any Session Manager related messages. These messages will be in the
format SESNxxxxE and SESNxxxxW for errors and warnings, respectively, where xxxx is a number
identifying the precise error. Look up the extended error definitions in the Session Manager message
table.

» See the Best practices for using HTTP Sessions section in the Developing and deploying applications

PDF books for more details.

* To dynamically view the number of sessions as a Web application is running, enable performance
monitoring for HTTP sessions. This will give you an indication as to whether sessions are actually being
created.
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» To learn how to view the HTTP session counters as the application runs, read the Monitoring
performance with Tivoli Performance Viewer chapter of the Administering applications and their
environment PDF book.

» Alternatively, a special servlet can be invoked that displays the current configuration and statistics
related to session tracking. This servlet has all the counters that are in performance monitor tool and
has some additional counters.

— Servlet name: com.ibm.ws.webcontainer.httpsession.IBMTrackerDebug.

— It can be invoked from any Web module which is enabled to serve by class name. For example,
using default_app, http://localhost:9080/serviet/
com.ibm.ws.webcontainer.httpsession.IBMTrackerDebug.

— If you are viewing the module via the serve-by-class-name feature, be aware that it may be viewable
by anyone who can view the application. You may wish to map a specific, secured URL to the servlet
instead and disable the serve-servlets-by-classname feature.

. for the HTTP Session Manager component:

— Use the trace specification com.ibm.ws.webcontainer.httpsession.*=all=enabled. Follow the
instructions for dumping and browsing the trace output to narrow the origin of the problem.

— If you are using persistent sessions based on memory replication, also enable trace for
com.ibm.ws.drs.*.

« If you are using database-based persistent sessions, look for problems related to the data source
the Session Manager relies on to keep session state information. For details on diagnosing database
related problems see the Errors accessing a datasource or connection pool in the Administering
applications and their environment PDF book

Error message SRVEOO79E Servlet host not found after you define a port

Error message SRVEOQ79E can occur after you define the port in WebContainer > HTTP Transports for a
server, indicating that you do not have the port defined in your virtual host definitions. To define the port,

1. On the administrative console, go to Environment > Virtual Hosts > default_host> Host Aliases> New
2. Define the new port on host "*"

The application server gets EC3 - 04130007 ABENDs

To prevent an EC3 - 04130007 abend from occuring on the application server, change the HTTP Output
timeout value. The custom property ConnectionResponseTimeout specifies the maximum number of
seconds the HTTP port for an individual server can wait when trying to read or write data. For instructions
on how to set ConnectionResponseTimeout, see HTTP transport custom properties section of the
Administering applications and their environment PDF book.

If none of these steps fixes your problem, check to see if the problem has been identified and documented
by looking at the [available online support (hints and tips, technotes, and fixes)| If you don’t find your
problem listed there |contact IBM support]

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Problems creating or using HTTP sessions

This article provides troubleshooting information related to creating or using Hypertext Transfer Protocol
(HTTP) sessions.
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To view and update the session manager settings discussed here, use the administrative console. Select
the application server that hosts the problem application, then under Additional properties, select Web
Container, then Session manager.

What kind of problem are you having?

« |HTTP Sessions are not getting created, or are lost between requests |

» |HTTP Sessions are not persistent (session data lost when application server restarts, or not shared
across cluster).|

« [Session is shared across multiple browsers on same client machine|

* [Session is not getting invalidated immediately after specified session timeout interval.l

» [Unwanted sessions are being created by JavaServer Pages.|

+ [Session data intended for one client is seen by another client.|

* |A ClassCastException error occurs during failover of a session that contains an Enterprise JavaBeans|
(EJB) reference.|

If your problem is not described here, or none of these steps fixes the problem:

+ Review ['HTTP session manager troubleshooting tips” on page 167| for general steps on debugging
session-manager related problems.

* Review Task overview: Managing HTTP sessions in the Administering applications and their
environment PDF book for information on how to configure the session manager, and best practices for
using it.

+ Check to see if the problem has been identified and documented by looking at the
[support (hints and tips, technotes, and fixes).

+ If you don’t find your problem listed there [contact IBM support|

HTTP sessions are not getting created, or are lost between requests

By default, the session manager uses cookies to store the session ID on the client between requests.

Unless you intend to avoid cookie-based session tracking, ensure that cookies are flowing between

WebSphere Application Server and the browser:

* Make sure the Enable cookies check box is checked under the Session tracking Mechanism
property.

» Make sure cookies are enabled on the browser you are testing from or from which your users are
accessing the application.

* Check the Cookie domain specified on the SessionManager (to view the or update the cookie settings,
in the Session tracking mechanism->enable cookies property, click Modify).

— For example, if the cookie domain is set as ".myCom.com”, resources should be accessed using that
domain name. Example: http://www.myCom.com/myapp/serviet/sessionservlet.

— If the domain property is set, make sure it begins with a dot (.). Certain versions of Netscape do not
accept cookies if domain name doesn’t start with a dot. Internet Explorer honors the domain with or
without a dot. For example, if the domain name is set to mycom.com, change it to .mycom.com so
that both Netscape and Internet Explorer honor the cookie.

Note: When the servers are on different hosts, ensure that session cookies flow to all the servers by
configuring a front-end router such as a Web server with the plug-in or setting the Cookie
domain.

» Check the Cookie path specified on the SessionManager. Check whether the problem URL is
hierarchically below the Cookie path specified. If not correct the Cookie path.

» |f the Cookie maximum age property is set, ensure that the client (browser) machine’s date and time is
the same as the server’s, including the time zone. If the client and the server time difference is over the
"Cookie maximum age” then every access would be a new session, since the cookie will "expire” after
the access.

+ If you have multiple Web modules within an enterprise application that track sessions:

— If you want to have different session settings among Web modules in an enterprise application,
ensure that each Web module specifies a different cookie name or path, or
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— If Web modules within an enterprise application use a common cookie name and path, ensure that
the HTTP session settings, such as Cookie maximum age, are the same for all Web modules.
Otherwise cookie behavior will be unpredictable, and will depend upon which application creates the
session. Note that this does not affect session data, which is maintained separately by Web module.

» Check the cookie flow between browser and server:
1. On the browser, enable "cookie prompt”. Hit the servlet and make sure cookie is being prompted.
2. On the server, enable SessionManager trace. for the HTTP session manager
component, by using the trace specification "com.ibm.ws.webcontainer.httpsession.*=all=enabled”.
After trace is enabled, exercise your session-using servlet or jsp, then follow the instructions for
dumping and browsing the trace output .
Access the session servlet from the browser.
The browser will prompt for the cookie; note the jsessionid.
Reload the servlet, note down the cookie if a new cookie is sent.
Check the session trace and look for the session id and trace the request by the thread. Verify that
the session is stable across Web requests:
— Look for getliHttpsession(...) which is start of session request.
— Look for releaseSesson(..) which is end of servlet request.
» If you are using URL rewriting instead of cookies:

— Ensure there are no static HTML pages on your application’s navigation path.

— Ensure that your servlets and JSP files are implementing URL rewriting correctly. For details and an
example see the Session tracking options section in the Developing and deploying applications PDF
book.

* If you are using SSL as your session tracking mechanism:

— Ensure that you have SSL enabled on your IBM HTTP Server or iPlanet HTTP server.

— Review the Session tracking options section in the Developing and deploying applications PDF
book..

+ If you are in a clustered (multiple node) environment, ensure that you have [session persistence]
enabled.

ook w

HTTP Sessions are not persistent

If your HTTP sessions are not persistent, that is session data is lost when the application server restarts or
is not shared across the cluster:
* Check the data source.
» Check the session manager’s persistence settings properties:
— If you intend to take advantage of session persistence, verify that Persistence is set to Database.
— Persistence could also be set to Memory-to-Memory Replication.
— If you are using Database-based persistence:
- Check the JNDI name of the data source specified correctly on SessionManager.
- Specify correct userid and password for accessing the database.

Note that these settings have to be checked against the properties of an existing data source in
the administrative console. The session manager does not automatically create a session
database for you.

- The data source should be non-JTA, for example, non XA enabled.

- Check the for appropriate database error messages.

- With DB2, for row sizes other than 4k make sure specified row size matches the DB2 page size.
Make sure tablespace name is specified correctly.

Session is shared across multiple browsers on same client machine

This behavior is browser-dependent. It varies between browser vendors, and also may change according
to whether a browser is launched as a new process or as a subprocess of an existing browser session (for
example by hitting Ctl-N on Windows).

The Cookie maximum age property of the session manager also affects this behavior, if cookies are used
as the session-tracking mechanism. If the maximum age is set to some positive value, all browser
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instances share the cookies, which are persisted to file on the client for the specified maximum age time.

Session is not getting invalidated immediately after specified session timeout
interval

The SessionManager invalidation process thread runs every x seconds to invalidate any invalid sessions,
where x is determined based on the session timeout interval specified in the session manager properties.
For the default value of 30 minutes , x is around 300 seconds. In this case, it could take up to 5 minutes
(300 seconds) beyond the timeout threshold of 30 minutes for a particular session to become invalidated.

Unwanted sessions are being created by JavaServer Pages

As required by the JavaServer Pages (JSP) specification, JSP pages by default perform a
request.getSession(true), so that a session is